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Chapter 1 | ntroduction

Air pollution in the United States results from the emission of a wide variety of manmade and
natural pollutants such as volatile organic compounds (VOC) , nitrogen oxides (NO,), air toxics,
and particulate matter (PM). Under the Clean Air Act, the U.S. Environmental Protection
Agency (EPA) is given specific responsibilities to reduce the emissions of pollutants from a
range of sources in order to provide clean and healthy air in the United States.

Generally speaking, the EPA classifies anthropogenic (manmade) emissions into three broad
categories, mobile, stationary (point), and area sources. Mobile source emissions are further
disaggregated into on-road (e.g., cars, trucks, and motorcycles) and nonroad emission categories.
Because of the significant contribution of nonroad emission sources to the total mobile source
emission inventory, it has become critical over the past several years for the EPA to provide state
and local pollution control agencies with the ability to easily create and project accurate,
reproducible inventories of nonroad emissions to satisfy the specific requirements of the Clean
Air Act Amendments of 1990.

Nonroad emissions result from the use of fuel in a diverse collection of vehicles and equipment,
including vehicles and equipment in the following categories:

» recreational vehicles, such as all-terrain vehicles and off-road motorcycles;

* logging equipment, such as chain saws;

» agricultural equipment, such as tractors;

» construction equipment, such as graders and back hoes;

* industrial equipment, such as fork lifts and sweepers;

» residential and commercial lawn and garden equipment, such as leaf and snow blowers;
» recreational and commercial marine vessels, such as power boats and oil tankers;

* locomotive equipment, such as train engines; and

 aircraft, such as jets and prop planes.

With the exception of aircraft, all categories of nonroad vehicles and equipment were
unregulated by the EPA prior to the mid-1990s.

In a report issued by the EPA in 1991%, the agency reported that nonroad vehicles and equipment
were a significant source of VOC, NO, , and PM emissions. The report showed that in some

lEPA, Nonroad Engine and Vehicle Emission Sudy, EPA-21A-2001, November 1991.
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areas of the country, nonroad emissions contributed to as much as a third of the total mobile
source NO, and VOC inventory and over two-thirds of the mobile source PM inventory.

To assist states and local regulatory agencies in the creation of accurate nonroad emission
inventories, the EPA has developed a nonroad emissions model which covers all areas of the
nation. This document describes the 2002 limited release version of the model.

OVERVIEW OF THE EPA NONROAD EMISSIONS MODEL
Equipment Types

This version of the nonroad emissions model predicts emissions for all nonroad equipment
categories listed above with the exception of commercial marine, locomotive, and aircraft
emissions. The model includes more than 80 basic and 260 specific types of nonroad equipment,
and further stratifies equipment types by horsepower rating. Fuel types include gasoline, diesel,
compressed natural gas (CNG), and liquefied petroleum gas (LPG).

Pollutants Reported

The NONROAD model estimates emissions for six exhaust pollutants: hydrocarbons (HC), NOy,
carbon monoxide (CO), carbon dioxide (CO,), sulfur oxides (SO,), and PM. The user selects
among five different types for reporting HC — as total hydrocarbons (THC), total organic gases
(TOG), non-methane organic gases (NMOG), non-methane hydrocarbons (NMHC), or volatile
organic compounds (VOC). Particulate matter can be reported as PM of 10 or less (PM,,) or
PM of 2.5u or less (PM,.). The model also estimates emissions of non-exhaust HC for several
modes — diurnal, refueling spillage, vapor displacement, hot soak, running loss, tank
permeation, hose permeation, and crankcase emissions. All emissions are reported as short tons
(i.e., 2000 Ibs).

Geographic and Temporal Coverage

In each run of the model, the user selects what geographic area(s) are to be included. At the
broadest level, the model estimates national total emissions. More commonly users will specify
emissions by state, or for one or more counties within a state. At the most detailed level, the user
can estimate sub-county emissions; however, this is an advanced feature and the user must
supply sub-county input data. Thus the model is capable of estimating emissions for
nonattainment areas which may consist of multiple counties or sub-counties in one or more
states.

EPA NONROAD Emissions Model User’s Guide 1-2
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The NONROAD model can estimate current year emissions for the specified geographic area as
well as project future year emissions and backcast past year emissions for calendar years 1970
through 2050. In estimating future year projections and in backcasting, the model includes
growth and scrappage rates for equipment in addition to a variety of control program options.
The model can calculate emissions for a variety of time periods — an entire year, one of four
seasons, or any particular month. Emissions for the period selected are estimated either for the
total period or for a typical day (weekday or weekend) in that period.

Model Components

As shown in Figure 1-1, the NONROAD model consists of three separate components: a
graphical user interface written in Visual Basic, the core model written in Fortran, and a
reporting utility written in Microsoft ACCESS.

The primary purpose of the user interface is to provide the user with an easy method to specify
the options for a model run. With simple Windows-type screens and pull-down menus, the user
can quickly set up, execute, and view a modeling scenario. Once the model options are specified,
the user can then run the Fortran core model from within the interface, and then can move
directly to the reporting utility to view and summarize the modeling results.

The core model of NONROAD, written in Fortran, contains all of the algorithms used by the
model for calculating emissions estimates. The core model can be operated as a stand-alone
application; however, as a stand-alone application it requires some basic knowledge of the DOS
operating system. Also, note that while the user interface runs the core model for one specified
set of conditions, and there is no built-in capability to run multiple scenarios in a single model
run. However, multiple runs can be performed by creating and running a batch file in DOS or in
a DOS window in a Windows environment.

The reporting utility, written using Microsoft’s ACCESS database software, is used to create
standardized reports using output data generated in the core model. Like the graphical user
interface, the reporting utility is a fully operational Windows program, with pull-down menus,
designed as a separate module in order to take advantage of the many reporting and formatting
options available when using a database application. Although the reporting utility is written in
ACCESS, it is a stand-alone application, and you do not need to know how to use ACCESS to
generate reports.

EPA NONROAD Emissions Model User’s Guide 1-3
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The reporting utility provides the user with the following standard reports:

» Emission Totals by County

» Emission Totals by County and Fuel Type

» Emission Totals by Equipment Type

» Emission Totals by HP (Horsepower)

» Emission Totals by HP and Source Classification

» Emission Totals by HP and Equipment Type

» Emission Totals by SCC (source category code)

» Emission Totals by Source Classification

» Population and Fuel Consumption by HP and Source Classification
* Population and Fuel Consumption by SCC

For most reports, emissions can be reported for either all counties or for a single, user-specified
county and for all fuels or for a single user-specified fuel type. Reports that include emissions
estimates by equipment types or by SCC are separated by major source classification (e.g.,
agricultural, lawn and garden), with subtotals provided for each classification. For those reports,
equipment type descriptions are also included (e.g., “2-wheel tractors”, “pavers”, etc.). Where
appropriate, reports also include a grand total by pollutant.

In addition to generating and viewing standardized reports from single model runs, the reporting
utility provides the user the ability to compare the results of two separate model runs. The
current version of the reporting utility has standardized reports for comparing two model runs by

» Emission Totals by HP and Source Classification,
» Emission Totals by SCC,

» Emission Totals by Source Classification,

» Emission Totals by County,

» Emission Totals by HP,

» Emission Totals by Equipment Type,

» Emission Totals by HP and SCC,

* Population and Fuel Consumption by SCC,

For the emission totals comparisons, the report displays the results of the two model runs, and the
absolute and percent difference between the two model runs. For the population and fuel
comparisons, the report displays only the results of the two model runs side by side. The
comparison reports are useful, for example, to compare emissions from present and future year
projections, or to compare emissions with two different future year control programs.

Finally, the reporting utility provides the user with the following emission factor reports:

* Grams per Operating Hour by SCC

EPA NONROAD Emissions Model User’s Guide 1-5
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» Grams per Operating Hour by HP and SCC
» Grams per Day by SCC

* Grams per Day by HP and SCC

* Grams per HP-Hour by SCC

* Grams per HP-Hour by HP and SCC

Both the reports that include emission factor estimates by SCC and by HP and SCC are separated
by fuel type, major source classification, and SCC. The reports that include estimates by HP and
SCC display one more level of separation, breaking the information down to the horsepower
category level. The emission factor reports do not provide subtotals or grand totals for each
group of estimates. The HP-Hour reports are only provided for exhaust and crankcase pollutants.

Model Inputs

The NONROAD model estimates emissions for each specific type of nonroad equipment by
multiplying the following input data estimates:

» Equipment population for base year (or base year population grown to a future year),
distributed by age, power, fuel type, and application;

» Average load factor expressed as average fraction of available power ;
* Auvailable power in horsepower;

» Activity in hours of use per year; and

» Emission factor with deterioration and/or new standards.

The emissions are then temporally and geographically allocated using appropriate allocation
factors.

There are several input files that provide necessary information to calculate and allocate
emissions estimates. These input files correspond to the basic data needed to provide the
calculations: emission factors, base year equipment population, activity, load factor, average
lifetime, scrappage function, growth estimates, and geographic and temporal allocation. Default
values are provided for all input files. The user can replace the default data files when better
information becomes available, either from EPA for national defaults or from local sources for
locality-specific data. The input files are also modifiable to test control strategies.

EPA NONROAD Emissions Model User’s Guide 1-6
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Output Options

Output from the core model is an ASCII file, which can be imported directly into the reporting
utility by simply specifying the file name. The reporting utility can then be used to generate the
standardized reports; users with ACCESS can generate their own reports or query the emissions
estimates and other output from the model. The ASCII file can also easily be imported into an
Excel or Lotus spreadsheet for those users who prefer spreadsheet applications, or wish to
generate graphs of model output. In addition, the reporting utility has a feature that allows users
to easily output an Excel file of data in a tabulated report; Excel can then be used to graph the
tabled results.

Lastly, the user also has the option to generate an Emission Pre-Processor System 2 (EPS-2)
input file. EPS-2 is a program, available on EPA’s Web site or bulletin board, that can take the
county-level output from the NONROAD core model and create gridded emissions files ready for
input to the Urban Airshed Model (UAM), a photochemical grid model.

TECHNICAL DOCUMENTATION

Technical documentation of the default model inputs may be found at the EPA's Office of
Transportation and Air Quality (OTAQ) web site for nonroad modeling:

http://www.epa.gov/otag/nonrdmdl.htm

If you obtained the model from a CD-ROM rather than downloading it from the web site, the
technical documents are included on the CD-ROM.

As of the release date for this version of the model, the following technical documents are
available:
» Temperature Corrections for Nonroad Exhaust Emissions (NR-001c)
» Conversion Factors for Hydrocarbon Emission Components (NR-002c)
» Exhaust Emission Effects of Fuel Sulfur and Oxygen on Gasoline Nonroad Engines
(NR-003c)
» Seasonal and Monthly Activity Allocation Fractions for Nonroad Engine Emissions
Modeling (NR-004c)
* Median Life, Annual Activity, and Load Factor Values for Nonroad Engine Emissions
Modeling (NR-005c)
* Nonroad Engine Population Estimates (NR-006d)
» Calculation of Age Distributions in the Nonroad Model — Growth and Scrappage
(NR-007c)

EPA NONROAD Emissions Model User’s Guide 1-7
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» Nonroad Engine Growth Estimates (NR-008c)

» Exhaust and Crankcase Emission Factors for Nonroad Engine Modeling —
Compression-Ignition (NR-009c)

» Exhaust and Crankcase Emission Factors for Nonroad Engine Modeling —
Spark-Ignition (NR-010e)

» Spark-Ignition Engine Emission Deterioration Factors for the Draft NONROAD2004
Emissions Model (NR-011Db)

» Nonroad Evaporative Emission Rates (NR-012c)

* Refueling Emissions for Nonroad Engine Modeling (NR-013b)

» Geographic Allocation of Nonroad Engine Population Data to the State and County Level
(NR-014d)

* Weekday and Weekend Day Temporal Allocation of Activity in the Draft
NONROAD2004 Model (NR-015a)

Any additional technical documents will be posted on the web site when they are completed.
Also currently available on the web site are numerous review documents, papers, and
presentation materials.

For answers to specific questions on the NONROAD model and model inputs, or to make
comments or suggestions, email the nonroad inventory model team at:

nonroad@epa.gov

FUTURE MODEL UPDATES

The EPA NONROAD modeling team is very interested in receiving comments on this version of
the model and suggestions for future model revisions and enhancements. E-mail your comments
and suggestions to the team at nonroad@epa.gov

All updates to the model will be announced on and available from the OTAQ nonroad modeling
web site.

TO STAY INFORMED

For the latest news on the NONROAD inventory model, subscribe to EPA-MOBILENEWS.
EPA will use this listserver as the primary means of communication on the NONROAD model to
distribute technical memos for review, to answer commonly asked questions, and to announce
future model updates. The list is also used for EPA's other mobile source inventory models, so if
you use the MOBILE series of models, you may already be a subscriber.
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To subscribe to the EPA-MOBILENEWS listserver, send a blank email to:

join-EPA-MOBILENEWS@lists.epa.gov

Your email address will then be added to the list of subscribers and a confirmation message will
be sent to your email address. Whenever EPA posts a message to the listserver, a copy of that
message will be sent to all subscribers. You can remove yourself from the list by sending a blank
email to:

leave-EPA-MOBILENEWS@lists.epa.gov

CONVENTIONSUSED IN THE USER’S GUIDE

The following conventions are used in this User's Guide:

“Click” when used in reference to commands means to carry out the command by
clicking it with the left button on the mouse or using keyboard equivalents -- for example,
the Enter key used in place of the Enter command.

“Enter OK” means to click the OK button with the mouse or press the Enter key to carry
out the action.

A dialog radio-button option is enabled when its button contains a black dot. The
absence of a black dot means the option is disabled.

Key strokes are printed in bold and bracketed. For example <R> means to press the R
key on the keyboard.

Carrying out commands or procedures with keys frequently involves pressing two or
more keys together. For example, <Alt-F> means to hold down the Alt key while
simultaneously pressing F.

“Arrow keys” or “Cursor keys” are collective terms for the Up, Down, Left, and Right
arrow keys.

A selection from a Windows menu bar is illustrated by bold type and the full name of the
pull-down menu. For example, Reports from the Reporting Utility menu bar. To
demonstrate the selection of an item in a pull-down menu both the main menu selection
and the submenu selection are in bold type connected with a “»”. For example, Reports

EPA NONROAD Emissions Model User’s Guide 1-9
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» Emission Totalsby SCC, indicates you should pull-down the Reports submenu and
select the Emission Totals by SCC report.

» Files names are italicized. For example, the default option file provided with the
NONROAD model is template.opt.

Both the Graphical User Interface and the Reporting Utility are standard Windows applications.
They use pull-down menus, dialog boxes, and message boxes. This document assumes that an
individual setting up and running the NONROAD model has experience in a Windows
environment. If you find yourself bogged down in either the graphical user interface or the
reporting utility perhaps you would benefit from one of the many books available that discuss in
great detail the Windows environment.

A very brief summary of pull-down menus follows using the example Reports » Emission
Totals by SCC from the Reporting Utility:

You can activate the Reports submenu using the mouse or with keyboard strokes. With the
mouse, you move the mouse pointer over Reports and click with the left mouse button. This
displays the reports submenu list. To select an item from the pull-down list click on the item
with the left mouse button. You can also click on the Reports menu and then drag the mouse
to the item of interest (Emission Totals by SCC) while holding down the left mouse button.
When you release the button the item is selected.

Alternatively, using the keyboard you can activate the Reports submenu by typing <Alt-R>,
where R is the underlined character of the menu selection (usually the first character of the
word if there are no conflicts). You can also use the arrow keys to move to a different menu
selection or within the submenu list. To select a pull-down menu option type the underlined
letter in the item name. For the above example, <S> will select the Emissions Totals by SCC
report.

EPA NONROAD Emissions Model User’s Guide 1-10
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ORGANIZATION OF THE USER’S GUIDE

To assist you in the set-up and operation of the nonroad emissions model, this document guides
you in the process of installing the model, provides information on system requirements to
operate the model, and provides detailed information on each component of the model. In
addition, a chapter is provided to assist you on more advanced topics.

Note: For reference, each chapter begins with a “Quick Start” section that summarizes the steps
explained in the chapter. The chapters then continue with a more detailed guide to the
model. As the detailed descriptions include some important notes on the proper use of
the model, we recommend that you read the chapters completely before using the model
for any official purposes.

The user’s guide is organized in the following manner:

Chapter 2 - Getting Started: This chapter provides information on model hardware and
software requirements. In addition, instructions are provided on installing the model on the
your compulter.

Chapter 3 - Graphical User Interface: This chapter discusses the graphical user interface
in detail, and how to specify and change model inputs for most model runs.

Chapter 4- The Core Model: This chapter describes how to edit options using a text editor
and how to run the core model. Step by step examples are provided.

Chapter 5 - Reporting Utility: This chapter describes the reporting utility and provides you
with information on how to import data from a model run and generate standardized reports.

Chapter 6 - Advanced Topics - This chapter provides detailed information to assist more
advanced users of the model. This detailed information includes:

» adescription of the core model inputs;

» adescription of required and optional input file packets;

» how to incorporate local data by editing input tables;

* how to perform additional model runs by editing input tables;

» adescription of core model output options, such as the generation of EPS-2 input files
and the creation of spreadsheet files; and

* how to model more advanced scenarios.

Chapter 7 - Trouble Shooting - This chapter describes possible solutions to troubles you
may have running the model.
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Several appendices are included that document FIPS and SCC codes used by the NONROAD
model and provide examples of reporting utility standardized reports.
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Chapter 2 Getting Started

In this chapter of the User’s Guide, the following topics are discussed:
» the minimum system requirements for installing and running the model; and

» the steps involved in installing the NONROAD model on your computer.

Note: Please see the README file for installation instructions. The latest version of the model
may not have the setup.exe installation utility described below, in which case you must

carefully follow the step-by-step installation instructions referred to in the README file.

QUICK START

The process of installing the NONROAD model on your computer may be quite simple using the
installation utility provided, which works for Windows 98, 2000, NT, and XP. It is named
setup.exe, and it is included on the NONROAD CD-ROM or can be downloaded from the
nonroad modeling web site. In addition, the CD includes electronic copies of this NONROAD
User’s Guide, all currently available technical reports, and the source code for the FORTRAN
core model.

In brief, the steps involved in installing and setting up the NONROAD model are as follows (in
this example drive D is used for the CD drive and you should substitute the appropriate letter for
the CD drive on your system):

1. Insert the NONROAD CD-ROM in drive D.
Windows 95, 98, 2000, NT, XP: Start » Run and then type d:\setup.exe

2. The NONROAD model installation program will prompt you for information as
required during the installation process. Once you have supplied the necessary
information, the program will install the NONROAD model on your computer. When
the process is complete, a message box will appear indicating that the installation was
completed successfully.
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SYSTEM REQUIREMENTS FOR RUNNING THE NONROAD MODEL

The following are the minimum system requirements for running the NONROAD model:

* Processor 486

* RAM 8 megabytes

* Drive CD-ROM (or access by network)

* Operating System Windows 98, NT, or XP (core model only needs DOS)
* Mouse

It is recommended that you have at least 200 megabytes of free disk space for installation and
operation of the NONROAD model. Besides the files to be installed, disk space will also be
needed for the output files generated when running the model. The installed files consist of
approximately 20 megabytes for the core model and data files, 4 megabytes for the graphical user
interface, 10 megabytes for the reporting utility and multi-year postprocessors, and for users
without Microsoft Access 2000 or later already installed, the stand-alone Microsoft Access
runtime package is installed for the Reporting Utility, requiring an additional 50-100 megabytes.

INSTALLING THE NONROAD MODEL
To install the NONROAD model, follow these steps:

1. Insert the NONROAD CD-ROM in drive D (substitute the appropriate letter for the
CD drive on your system).

2. Begin the installation procedure.

Windows 98, 2000, NT, XP: Specify Start » Run and enter d:\setup.exe.
Specify OK.

3. During the installation process, a number of dialog screens will appear that request
information from you to assist in installing and setting up the program. Once you
have provided all required information, the installation program will set-up a
directory on your computer and copy the necessary files to that directory.

4. The installation program will create a program group on your computer called
Nonroad. This program group will contain an icon for each component of the model -
- the graphical user interface, the core model, and the reporting utility. For
information on the operation of each of these components, see Chapter 3 (graphical
user interface), Chapter 4 (core model), and Chapter 5 (reporting utility).
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Attaching the Reporting Utility Databases

When the NONROAD maodel is installed, a subdirectory called Reports is created. Within this
subdirectory are two databases, Nrdata.mdb and Reports.mdb, required to run the reporting
utility. To operate the reporting utility, Reports.mdb must "know" the path of NRdata.mdb in
order to properly connect to it. This connection is done automatically the first time the Reporting
Utility is opened.

If the Reporting Utility cannot find Nrdata.mdb (for example, the file was moved to another
directory) then a message is displayed. You must attach the tables in order to successfully
generate reports. Refer to the section in Chapter 5 titled Attaching the Reporting Utility
Databases.

REINSTALLING THE NONROAD MODEL

The NONROAD model can be completely reinstalled on your computer by following the normal
steps outlined above. During reinstallation, the program will search for a current installation of
the program. If any current NONROAD files are found, the program will ask you whether you
want to overwrite the files. Indicate Yesor No.
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Chapter 3 Graphical User Interface

In this chapter of the user’s guide, the following topics are discussed after the Quick Start
description:

a general description of the graphical user interface,
moving around in the user interface,

creating an option file and specifying model parameters,
running and viewing a model scenario, and

some advanced options.

QUICK START

The process of setting up an option file that contains a scenario that you are interested in
modeling, and running and viewing the modeling results, is quite simple with the graphical user
interface. Each of the steps involved is discussed in detail in this chapter. In summary, the steps
involved in setting up, running, and viewing a modeling scenario are as follows:

1. Start the Graphical User Interface using the icon created when the EPA NONROAD

Emissions Model was installed on your computer. (For more information, see General
Description below.)

Define the parameters that you are interested in modeling. When you first run the
interface, the modeling parameters are contained in the default option file
TEMPLATE.OPT which is automatically read by the interface. Select Scenario on
the main menu. A submenu will appear that contains the various options that you can
specify. These options include the title of your model run, fuel specifications, the
period of time and geographical region over which you want to estimate emissions,
and the source categories that you want to model. (For more information, see the
section below on Creating an Option File.)

Save the modified option file, File » Save (or Save As). (For more information, see
the section below on Creating an Option File.) If you do not save the option file with
the name you want, it will be saved automatically with its currren thame when you
choose Model » Run in the next step.
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4. Submit your option file to the core model to run, Model » Run. Once the run has
been completed, a message will appear in a DOS screen notifying you that the run
was successful. (For more information, see the section below on Running and
Viewing a Modeling Scenario.)

5. To view the results of this model run, specify Model » Reports. This will move you
to the reporting utility. (For more information, see the section below on Running and
Viewing a Modeling Scenario.)

6. Exit the interface when you are finished with File » Exit. (For more information,
see the section below Exiting the Graphical User Interface.)

GENERAL DESCRIPTION

The NONROAD user interface provides you with an easy method for designing the nonroad
emissions simulations that you are interested in modeling. In addition, the interface provides you
with an easy means for accessing the reporting utility to view the results of your modeling run.
With simple Windows-type screens and pull-down menus, you can quickly set up, execute, and
view a modeling scenario without any computer programming experience.

When the NONROAD emissions model is installed on your computer, an icon for each
component of the model is created. While this allows you to access each component of the
model individually, through the interface you can operate most of the functions of the EPA
NONROAD Emissions Model -- from the creation of a scenario, to the running of the core
model, to the development of reports -- without exiting one program and executing another.

Note: In this chapter of the user’s guide, information is provided to assist you in setting up an
emissions scenario to model using the default data provided in the model. If you are
interested in modifying the data files to reflect alternatives to the default data, please see
Chapter 6 on Advanced Topics.
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MOVING AROUND IN THE GRAPHICAL USER INTERFACE

Begin the Graphical User Interface denoted by the icon displayed in Figure 3-1. If your
computer operates with Windows 95 or above, the icon can be found in a program group

called Nonroad Model accessed from the Start menu. If you are operating with Figure 3-1:

Windows 3.1, the icon can be found through Program Manager. Graphical User
Interface icon.

When launched, the main menu screen of the interface appears (Figure 3-2). The title

bar of the screen displays the NONROAD name followed by the currently opened option file in

parentheses. The default is template.opt. Below the title bar is the main menu bar, followed by

the EPA banner, and the model run title, message file name, and output file name which are

extracted from the opened option file.

F1US EPA NONROAD MODEL (template.opt)

File Scenarioc Model Advanced options Help

i
-

U.S. Environmental Protection Agency
Nonroad Emissions Model

Simulation Hun Title
Current Message File :template.msg
Current Output Data File : template.out

Figure 3-2: Initial graphical user interface screen

From this screen you can access submenus that make up the graphical interface module, as listed
at the top of the window in the menu bar:

e File - open an existing option file, save a modified option file with the old or a new
name, or exit the interface.
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» Scenario - define the various parameters that you want in your modeling run.
» Model - run the core model and access the reporting utility.

» Advanced Options - select your own data files to replace the default files provided
with the model and to specify optional output.

» Batch - this option is unavailable. Multiple runs must be done manually.
» Help - general information is provided on the version and status of the model.

Once a main menu item is selected, a list of submenu items will be displayed. The following
shows the list of submenu items for each of the main menu choices:

File Open
Save
Save As
Exit

Scenario Options
Period
Region
Sources

Model Run
Reports

Advanced Options  Geographical Allocation
Temporal Allocation
Growth
Equip. Population
Phase In
Emission Factors
Deterioration Factors
Activity
U.S. Counties FIPS
Optional Output

Help Help
About
Current
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In most instances, after selecting a submenu item a form is displayed for user inputs or selections.
When an input error occurs, an appropriate message (dialog box) is displayed. If a dialog box
appears, specify OK, make the corrections needed and continue.

CREATING AN OPTION FILE

The first step involved in operating the EPA NONROAD Emissions Model is to setup an option
file which defines the parameters that you are interested in modeling. Once this file has been set
up, it can be submitted directly to the core model from the interface, and then following the
model run the estimated emissions output can be imported into the reporting utility and standard
reports generated.

An option file (*.opt) contains all of the parameters that specify your modeling run. This file is
opened, read, and updated from the interface. To more easily explain the process of setting up an
option file, the following example is provided:

You have been given an assignment to estimate the total emissions from
all lawn and garden equipment in Travis County (Austin), Texas. You
areinterested in estimating these emissions for the summertime of 1998.

Throughout this chapter, we will refer to the above example.
Opening and Naming an Option File

When you first run the interface, the default option file TEMPLATE.OPT is automatically opened
and the file name is displayed on the title bar of the main screen. Also displayed in the main
menu screen is the run title, the message file name, and the output file name extracted from the
currently opened option file. You can modify the default option file to define a modeling scenario
of interest. Alternatively, if you want to use or modify a different option file (*.opt) that you
have previously created, follow these steps:

1. From the Main Menu, select File » Open.

2. An open file dialog box appears that requests you to select a new option file. Specify
the option file you are interested in using. This loads the option file into the interface
and updates the main screen.

Before beginning to modify the scenario options in the option file, you should save the option file
with a different name to prevent yourself from accidentally overwriting data in a previously
created option file or in TEMPLATE.OPT. To do this, select File » Save As and indicate the
new file name. For our example, you would specify the file TRAVISOPT. The main menu
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screen title bar is updated with the new file name. In addition, when you specify a new file name
the message file and output file names are set to the same name as the specified option file with
the file name extensions .msg and .out respectively. For our example, you see the files
TRAVISMSG and TRAVISOUT.

Note: The name of the option file must be no longer than eight characters as a result of DOS
conventions. It is recommended that the extension .OPT be used for all option files.

If the message file specified in the opened option file exists then the button “View Message File”
will appear in the middle of the main menu window. Click on this button to open Windows
Notepad and review the indicated message file.

Defining a Report Title

The interface allows you to easily title your model run. This title will be used on any reports you
might generate for this particular scenario.

To provide a descriptive title for your model run, follow these steps:

1. From the main menu select Scenario » Options.

Title 1

|Lawn and Garden Equiprment

Title 2

|Tn‘:wis County Summertime

Fuel BvF for gas m Mirirnum ternp [F) Ir

Ox=pgen weight 2 W b axirnurn bemp [F] Ir

Gas Sulfur % m Loverage ternp [F) I?

Diesel Sulfur % |p.330  Stagell Contral % fpp
Marine Diesel Sulfur & |—

CHGALPG Sulfur % ||]_|]|]3

i {+
| oK | Cancel |

Figure 3-3: Options screen
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2. Update the Options screen (Figure 3-3). When the Options screen first appears, it will
contain the title and any options previously defined for this option file. Specify a
descriptive title for your scenario in the field below Title 1. If you want to add a
subtitle, you can do so in the field below Title 2.

Note: The two title lines of your modeling run must be no longer than 80 characters each. In
addition, the titles should not include single or double quotation marks (i.e., “ or *), or
periods.

3. Specify Done or OK to return to the main menu.

Defining Fuel Specifications, Ambient Temperatures, and Stage 11 Control Effectiveness

Nonroad emissions result from the combustion, evaporation, and spillage of fuel in equipment
and vehicles designed primarily for off-road use. The emissions that come from nonroad
equipment and vehicles are dependent, in part, on the composition of the fuel used. Similarly,
the ambient temperature will also affect the emissions from nonroad sources. Finally,
implemented controls act to decrease emissions. As a result, it is important to define the
composition of the fuel, the ambient temperature for the period of time that you are interested in
modeling, and the effectiveness of any existing controls.

The minimum temperature that you define for your modeling scenario is the average low for the
time period selected. For example, when modeling a typical summer day, the minimum
temperature should be the average low temperature in Fahrenheit for the summer season.
Moreover, when modeling an entire year, the minimum temperature should be the average daily
low for the year and not the lowest temperature ever recorded. Other modeling parameters, such
as RVP, sulfur, and oxygen content, depend on local fuel characteristics. Data for an area should
be available from the state or local air agency.

Stage Il controls are designed to reduce emissions during refueling due to vapor displacement.
They are generally mounted on the pumps at gasoline stations. With regards to nonroad
equipment, their benefits only apply to equipment that are refueled directly via the pumps (rather
than with portable containers). Where present, the effectiveness of this control is also affected by
the design of the filler opening of the equipment.

Note: EPA currently has no data on the effectiveness of Stage Il for nonroad equipment.

The value should be left at 0% unless local data exist on which a value can be based.
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To specify fuel characteristics, temperature, and Stage 1l control effectiveness, follow these
steps:

1. From the main menu select Scenario » Options.

2. Modify the required parameters. For our example, indicate the gasoline specifications
and ambient temperatures that will be in effect in Travis County during the summer of
1998. Next, identify whether the modeling region is at high or low altitude'. High
should be specified where the average altitude is greater than 5000 feet; this is
consistent with the MOBILE program.

3. Specify Done or OK to return to the main menu.

The acceptable range of values for each of the fuel specification and ambient temperature
options are as follows:

Parameter Minimum Maximum
Fuel RVP (psi) 6 16
Oxygen (wt.%) 0 5
Fuel Sulfur (wt %) 0 0.5
Temperature (F) -40 120
Stage Il control 0 100
effectiveness (%)

‘ Note: The percent effectiveness value must be followed by a decimal point. I

Defining the Modeling Period

The modeling period is simply the period of time for which you want to estimate emissions. To
define the modeling period, follow these steps:

1. From the main menu select Scenario » Period.

1 Altitude adjustment is not in this version of the model. Hence, this selection is currently disabled in the user
interface.
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Figure 3-4: Period screen

2. Indicate the modeling period of interest in the displayed screen (Figure 3-4).

The interface makes it easy to define the modeling period through a series of select
buttons. The following options are available to you:

. Episode Year - You can define any year between 1970 and 2050 that you
are interested in modeling.

. Growth Year - You can define any year between 1970 and 2050 to
forecast or backcast engine populations. If this is left blank, the Episode
Year will be used.

. Tech Year - You can define any year between 1970 and 2050 as the
maximum technology year. If this is left blank, the Episode Year will be
used. Note that if a year is entered, it cannot be greater than the Episode
Year.

. Period - You can define the modeling period as annual, monthly, or
seasonal.
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. Month - If you select the modeling period to be monthly, the list of
months will become active and you can select the appropriate month of the
year.

. Season - If you select the modeling period to be seasonal, the list of

seasons will become active and you can select the appropriate season of
the year. Seasons are defined as follows in the model:

Winter: Jan/Feb/Dec
Spring: Mar/Apr/May
Summer: Jun/Jul/Aug
Autumn: Sep/Oct/Nov
. Type - For any period that you select, you can estimate the emissions as
the total for a 24-hour period (typical day) within the period or for the total
period.
. Day - If you select the type to be a typical day, days will become active

and you can select a weekday or weekend day.

Note: While the model allows you to define any model year from 1970 to 2050, it actually
forecasts and backcasts based on data from 1990-2002. For this reason, its estimates
become less accurate as you move further into the past or the future.

Since we are interested in estimating the total emissions during the summertime of
1998 in our example, specify Seasonal (under Period), Summer (under Season),
Period Total (under Type), and type in 1998 in the year field.

3. Specify Done or OK to return to the main menu.
Defining the Modeling Region
The interface makes it relatively easy to define the geographical region -- from one county to
multiple counties to an entire state or the nation -- that you are interested in modeling. To do

this, follow these steps:

1. Specify Scenario » Region. The Region screen will appear (Figure 3-5).
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Figure 3-5: Region screen.

2. The first step in defining the modeling region is to remove any regions that have been
specified in a previous scenario that are not applicable to the current scenario. To do
this, highlight the regions in the Current selection list and click on Del.

3. Specify aregion. Several options are available, the methods for selecting them are as
follows:

» 50 States - This option selects all 50 states, you will obtain the state totals for all
50 states individually. When selected, the “Current selection” list is cleared, as no
individual states or counties need be specified.

Tip:  Since selecting 50 States as a region clears the current selection list this is a quick and
easy way to delete all previously specified states or counties before starting a new region
definition.

» State - This option allows you to select any one, or multiple, of the 50 states.
When a state is selected, the model will compute total emissions for the entire
state, but will not allocate emissions among counties in the state. Specify State
(under region), scroll through the list of states or type the first letter to jump in the
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list. Once found, highlight the state and then Add. The state will appear in the
current selection field.

County - This option allows you to select one or more counties. To select an
individual county, specify County (under region) and highlight the state of
interest. When you highlight the state a list of counties for that state will be
displayed. Move through the list of counties until you find the one that you want,
highlight the county, and then Add. The county name and state abbreviation are
written to the Current selection list.

To specify all counties within a state, indicate County (under region), highlight the
state of interest, and then Add. The Current selection list will display the state
name (e.g., Michigan) with “All of ...” (e.g., “All of Michigan”). The core model
will compute emission estimates for every county, individually, in the named
state.

Note: To create a modeling region that is larger than a single state or county, continue to add
new regions to the list of currently selected regions by repeating the process for selecting
states or counties. For example, if a metropolitan area covered four counties, simply

select the first county and then each additional county one at a time.

US Total - This option allows you to estimate national total emissions, no state
detail is generated. When selected, the “Current selection” list is cleared, as no
individual states or counties need be specified.

Note: The NONROAD model also allows you to define a sub-county region. However, this
option requires that you provide a significant amount of data beyond that furnished with
the model. For information on how to input this additional data, please see Chapter 6,

Advanced Topics.

For our example scenario, indicate County (under Region), highlight Texas from the
list of states, highlight Travis from the list of counties, and Add.

5. Specify Done or OK to return to the main menu.

Defining Source Categories

The EPA NONROAD Emissions Model allows you to estimate emissions from many different
types of equipment and vehicles. Each source category in the NONROAD model is uniquely
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identified with a source classification code (SCC), which is a ten-digit number. The first two
digits, 22, represent mobile sources. For most categories, the next two digits represent the
engine or fuel type (60, 65, 67, 68, and 70, represent 2-stroke gasoline, 4-stroke gasoline, LPG,
CNG, and diesel respectively). The next three digits represent the segment type (for example,
recreational or construction). And the last three digits represent the specific kind of equipment
(for example, golf carts or snowmobiles). Refer to Appendix B for a complete list of
NONROAD SCCs.

When selecting source categories to process in a NONROAD simulation you can specify ‘global’
source category codes instead of each individual SCC. For example, instead of listing all lawn
and garden equipment types individually, when you specify Add segment the SCCs are listed
with the last three digits (equipment type) as zero. It is implied that all equipment types within
that segment will be processed.

To define the source categories that you want to model, follow these steps:

1. From the main menu specify Scenario » Sources. The Sources screen will appear
(Figure 3-6).

The following options are available:
» Active - Choose either ‘Selected sources’ to specify a subset of sources to model or
‘All Sources’ which will model all SCCs with valid equipment population data. If
‘All Sources’ is selected then the ability to select specific SCCs is removed (i.e. the
Add buttons become deactivated).
* Fuel - Choose between “All Fuels’, ‘Diesel’, or ‘SI’ (spark ignition engines).

* Segment - Choose one of the segments listed.

» List of selected sources - Each selected SCC and a brief description is displayed in
the lower portion of the window.

* Add Segment - The ‘global’ SCCs which represent the specified segment and fuel
type will be added to the list of selected SCCs.
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Figure 3-6: Sources screen

* Add Equipment - The individual SCCs which represent every type of equipment
within a segment will be added to the list of selected SCCs. This allows you to select
a subset of equipment types within a segment, by then removing the individual
equipment types that you do not want.

¢  OK - Return to the main menu.

* Remove Selection - This will remove any highlighted SCCs from the list of selected
sources.

2. Similar to defining a region, you must first remove any source segments or equipment
that you do not want to model. Highlight the segments and/or equipment in the list of
selected sources and specify Remove Selection. Multiple sources may be highlighted
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by using the <Shift> or <Control> keys. The <Delete> key may also be used to
remove the highlighted sources from the list of selected sources.

3. Select the fuel type. For our example scenario we are interested in all lawn and
garden equipment so we will specify All fuels.

4. Select the segment type. For our example, we are interested in all lawn and garden
equipment and select Lawn & Garden.

5. Specify Add Segment to add a list of ‘global’ SCCs for the specified segment/fuel to
the current list of selected sources. Alternatively, if you are interested in specific
equipment within a source segment then Add Equipment. Every type of equipment
that falls under the specified segment/fuel type will appear in the list of selected
sources. Highlight any equipment that you do not want to model, and remove them
from the selection list (see 2 above).

Note: If you are interested in estimating emissions from more than one segment or fuel type,
add the first segment/fuel type and then continue adding segment/fuel types as desired.

6. When you have finished defining sources, specify OK to return to the main menu.

Saving an Option File

Once you have created an option file by defining all of the parameters that you want, you should
save this file. To do this, follow these steps:

1. From the main menu File > Save.

Note: The option file is saved automatically when you specify Model » Run, but it is good
practice to save it manually using File » Save as... to be sure the version you want is
saved with your desired filename.

RUNNING AND VIEWING A MODELING SCENARIO

Once you have set up an option file, the interface allows you to easily submit the option file to
the core model to run. Similarly, the interface allows you to access the reporting utility to view
the results of your run and prepare printed reports.
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To submit an option file to the core model, follow these steps:

1.

2.

From the Main Menu, specify File »Open.

Specify the option file you want to model in the open file dialog box. This loads the
option file into the interface and the file name is displayed on the main menu title bar.
If the option file is already loaded, you can skip steps 1 and 2.

From the main menu, specify Model » Run (Figure 3-7).

Flus EPA NONRDAD MODEL (travis.opt)

File Scenario BEbBEN Advanced opkions Help

Run with travis, opk
Reports

€. U.S. Environmental Protection Agency

Nonroad Emissions Model

Yiews Mezzage File

Simulation Run Title : LAWN AND GARDEN EQUIPMENT
Current Message File :travis.msg 12080 bytes 5/29/2005 3:41:16 PM
Current Qutput Data File : travis.out 53595 bytes 5292005 3:41:16 PM

Figure 3-7: Model submenu screen

4. A DOS window will appear. After the run has been completed, a message will appear

5.

notifying you that the run was successful.

If the DOS window disappears after the core model completes and you wish to view

the DOS screen, then you need to change the default ‘close on exit' in your Windows

application. In Windows 95 or above, right click on the nonroad.exe file name, select
Properties, select the Program tab, and disable the 'Close on exit' box. You will then

need to manually close the DOS window when the core model completes.

To return to the interface, press <Enter>.
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6. Itis important to review the output message file produced by the core model. In
addition to any warning or error messages that are generated during execution, the
message file will indicate all of the parameters specified in the option file and all of
the input files used in processing. These should be reviewed in order to verify that the
simulation performed was what you intended. Specify View Message File from the
main menu in order to open Windows Notepad and examine the message file.

7. If you are interested in modeling several scenarios prior to viewing and printing a
report, repeat the above steps for each of your option files. Be sure to use a different
option filename for each scenario, or else the later model runs will overwrite the
output files from the previous runs.

Note: The core model runs in DOS under a Windows environment which allows you to
multitask activities while the model is running. However, multitasking may lengthen the
amount of time it takes for the model to run, depending on the capability of your
computer (speed and memory). If this is a problem, you should consider closing all other
applications prior to running the model.

To access the reporting utility, follow these steps:

1. From the main menu, specify Model » Reports. Refer to Chapter 5 for a complete
description of the Reporting Utility.

ADVANCED OPTIONS

The Advanced Options menu allows you to specify your own data files to replace the default files
provided with the NONROAD model and to specify certain alternate output file formats. Each
submenu selection allows you to specify a different file to use. In some cases, more than one file
may be applicable to a selection.

An optional output available from the core model, via the graphic interface, is the Emissions
Processor System (EPS) AMS format. This output is generated only if a filename is provided for
that format. Another optional output available only from the reporting utility is the NEI Input
Format (NIF), which can be used to generate inputs for EPA's National Emissions Inventory
(NEI). NIF output is covered in Chapter 5.
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Depending on your desired modeling region you may need to change the default Geographic
Allocation and Equipment Population file names. These files are provided by state to reduce the
size of the files.

EXAMPLE OF CHANGING GEOGRAPHIC ALLOCATION

The Geographic Allocation selection allows you to identify the allocation look-up table (the
default is “allocate.xrf”) and allocation data files that you want to use. The allocation look-up
table is an assignment of equipment type to an allocation indicator (e.g., construction equipment
assigned to employees in the construction industry). The allocation files contain the actual
estimates of indicator values (e.g., the actual number of employees in the construction industry
by county and year).

To change the look-up table or allocation data files, follow these steps:

1. From the main menu, select Advanced options »Geographic Allocation. The
Geographic Allocation screen is displayed (Figure 3-8).

Geographic Allocation

Allocation Files

Add__. Replace Delete

IC:ANDNROADADATANALLDCATEAUS _FARMS_ALO

CANOMROADADATANAL LOCATENIS _AIRTR.ALD P
C:ANOMROADADATANALLOCATENIS _COALALD

CANONROADSDATANLLOCATENUS CONST.ALD
CANONROADNDATAMLLOCATEWS FARMS ALD
C:ANOMROADADATANALLOCATENIS _GOLF.ALO b/

Allazation Loakup table
|E:"|.NI]H ROADADATAMALLOCATEMVALLOCATE XRF

1].4 Change Look up Cancel

Figure 3-8: Geographic Allocation screen
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2. The first step in defining the geographic allocation data files is to remove any
previous data files. Highlight the current files and Delete one at a time.

3. Click Add to specify a new list of allocation files. An open file dialog box appears
that requests you to select a new allocation file. Locate the directory where the
allocation files are saved (when installed: \nonroad\data\allocate) and specify the data
file that you want. Repeat this until all necessary files have been added.

4. To change a specific allocation file, select that file from the list. Then enter the path
and name of the new file in the text box directly above the list. Click Replace.

Note: The specification of modeling region under the Scenario menu automatically selects the
appropriate default allocation and population data files. Thus any changes made to these
via the Advanced Options menu will be un-done if you access the Scenario » Region

screen.

5. Specify Change Look up to change the allocation look-up table. Again, an open file
dialog box appears that requests you to select a new allocation file (this time with the
extension .xrf). Locate the directory where the allocation files are saved and specify
the data file that you want.

6. Specify Done or OK to return to the main menu.

EXITING THE GRAPHICAL USER INTERFACE
To exit the interface, follow these steps:

1. From the main menu, specify File » EXxit.
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Chapter 4 Core Model

In this chapter of the user’s guide, the following topics are discussed:
» ageneral description of the core model,
» the process of modifying an option file and

* running the core model.

QUICK START

The process of modifying an option file and running the core model using data provided in the
NONROAD model is straightforward. In summary, the steps involved in running the core model
with existing data are as follows:

1. Modify the core model input option file. To modify an option file, either use the
graphical user interface as discussed in Chapter 3 or a text editor, such as Microsoft’s
Notepad or WordPad, to access the *.opt file that you are interested in changing.
Alternatively, you can edit the file through DOS. (For more information, see the
section below on Creating an Option File.)

2. Once you have an option file defining the scenario that you are interested in modeling,
you can run the scenario from the graphical user interface as discussed in Chapter 3,
or from DOS by typing “nonroad (the name of your option file).opt” from the nonroad
directory. (For more information, see the section below on Running the Core Model.)

3. After the model has finished, a message will appear in a DOS window notifying you
of the successful completion of the run or of any errors that have occurred.
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GENERAL DESCRIPTION

The core NONROAD model contains all of the algorithms used by the model for calculating
emissions estimates. The model includes standard data files and tables that allow you to easily
estimate the emissions from a wide variety of nonroad equipment and vehicles for any region of
the country. The information used by the core model for estimating emissions, including user-
specified options, data files, and data tables, are input through an option file.

The core model can be operated as a stand-alone application; however, as a stand-alone
application it requires some basic knowledge of the DOS operating system. In addition, in order
to create/modify an input option file you must be familiar with the use of a text editor. If you
prefer you can easily modify the input option file and access the core model from the GUI
(Graphical User Interface), which is described in detail in Chapter 3.

When the NONROAD model is installed on your computer, a directory for the model is created.
The standard installation creates the NONROAD directory on the c drive; i.e. c:\Nonroad. The
core model is executed with the file NONROAD.EXE.

Note: In this chapter of the user’s guide, information is provided to assist you in setting up an
emissions scenario and running the model using the default data provided in the model.
If you are interested in modifying the data files to reflect alternatives to the default data,
please see Chapter 6 on Advanced Topics.

For more technical information on the core model, please refer to the technical support
documents, or the core model source code.

CREATING AN OPTION FILE

Before running the core model, you must define the scenario you are interested in modeling by
creating an option file. All model input files and scenario specific parameters are specified in the
input option file. The information contained in each option file is separated into “packets” based
on common information. For example, all data items related to the period of time for which you
are interested in estimating emissions is grouped in a single packet, as are data files related to the
population of equipment for a modeling region. You can quickly set up an option file specifying
the parameters that are applicable to your modeling scenario using default data.

You can view and modify an option file using a text editor such as Microsoft’s Notepad or
WordPad or by using the DOS command edit. When viewing an option file through a text editor,
the keyword that identifies a packet is surrounded by forward slashes (*“/””) and can appear in
upper case, lower case, or mixed case. For example, the packet identifier for all of the data files
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related to the population of equipment is /POP FILES/. To designate the end, or terminator, of a
packet, the keyword END is used, also surrounded by forward slashes (i.e., /END/).

One convenient aspect resulting from the use of a packet input structure is that packets can
appear in any order in an option file. Furthermore, any type of notes or descriptions that aid in
describing the packet can be placed between the individual packets. When executed, the core
model searches for packet identifiers and reads the data between the identifier and the packet
terminator. All other lines in the file are ignored. The file TEMPLATE.OPT is provided with the
NONROAD model and contains a complete description of the packet parameters and formats.

In a fashion similar to that followed in Chapter 3, the following example is provided to more
easily explain the process of creating and setting up an option file:

You have been given an assignment to estimate the total emissions from
all lawn and garden equipment in Travis County (Austin), Texas. You
areinterested in estimating these emissions for the summertime of 1998.

This example will be referred to throughout this chapter.
To create an option file using a text editor, follow these steps:

1. Start the text editor of your choice. Notepad and WordPad are possibilities.
Note: The use of a word processor such as WordPerfect or Microsoft Word is not
recommended unless you are experienced in dealing with ASCII files in those
applications.

2. Open the option file of interest.
Note: If this is the first option file that you are creating, use TEMPLATE.OPT. The
template.opt file, installed with the model, is initially located in the \nonroad
directory. If you have previously created an option file, you can select any *.opt file
for modification.

3. Save the opened option file with a new name in order to prevent the accidental loss of
data resulting from overwriting an existing file. For our example, save the
template.opt file as travis.opt. Figure 4-1 shows a portion of the file template.opt.
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This is the options file for the NONROAD program.

The data is sperated into "packets" bases on common
information. Each packet is specified by an
identifier and a terminator. Any notes or descriptions
can be placed between the data packets.

PERIOD PACKET

This is the packet that defines the period for

which emissions are to be estimated. The order of the
records matter. The selection of certain parameters
will cause some of the record that follow to be ignored.
The order of the records is as follows:

1 - Char 10 - Period type for this simulation.
Valid responses are: ANNUAL, SEASONAL, and MONTHLY
2 - Char 10 - Type of inventory produced.
Valid responses are: TYPICAL DAY and PERIOD TOTAL
- Integer - year of episode (4 digit year)
- Char 10 - Season of year
Valid responses are: WINTER, SPRING, SUMMER, and AUTUMN
5 - Char 10 - Month of episode (use complete name of month)
6 - Char 10 - Type of day
Valid responses are: WEEKDAY and WEEKEND
7 - Integer - Year of growth calculation (4 digit year)
8 - Integer - Year of technology selection (4 digit year)

Valid responses are: (blank) or 4 digit year (must not be
greater than Year of episode)

/PERIOD/

Period type : Annual
Summation type : Period Total
Year of episode : 1996

Season of year
Month of year :
Weekday or weekend :
Year of growth calc:
Year of tech sel
/END/

Figure 4-1: Portion of the TEMPLATE.OPT file.

4. Modify the option file. For our modeling example, we want to modify travis.opt by
specifying the parameters required to estimate summertime emissions in 1998 from
lawn and garden engines in Travis County, Texas.

For a simple modeling run, using the data provided with the model, five packets of information
will most frequently be modified. These five packets are the /RUNFILES/, /OPTIONS/,
/PERIOD/, /IREGION/, and /SOURCE CATEGORY/ packets which are described in the
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following sections. In addition, the /POP FILES/ and /ALLOC FILES/ packets will be modified
if the region is changed to another state.

M odifying /RUNFILES/

In the /RUNFILES/ packet, some of the data files read by the model are defined. The first 20
characters of each line contains the keyword(s) which identify the kind of file specified. For our
simple example, we are only interested in changing the name of the message file and the output
data file. In Figure 4-2, the message and output data files have been changed (travis.*).

This is the packet that lists the names of output files
and some of the input data files read by the model. If
a drive:\path\ is not given, the location of the
NONROAD.EXE file itself is assumed. You will probably
want to change the names of the Output and Message files
to match that of the OPTion file, e.g., MICH-97.0PT,
MICH-97.0UT, MICH-97.MSG, and if used MICH-97.AMS.

/RUNFILES/

ALLOC XREF :c:\nonroad\datalallocate\allocate.xrf
ACTIVITY :c:\nonroad\data\activity\activity.dat
EXH TECHNOLOGY :c:\nonroad\data\tech\tech-exh.dat

EVP TECHNOLOGY :c:\nonroad\data\tech\tech-evp.dat
SEASONALITY :c:\nonroad\data\season\season.dat
REGIONS :c:\nonroad\data\season\season.dat
MESSAGE :c:\nonroad\outputs\travis.msg

OUTPUT DATA :c:\nonroad\outputs\travis.out

EPS2 AMS 8

US COUNTIES FIPS :c:\nonroad\data\allocate\fips.dat
RETROFIT 8

/END/

Figure 4-2: TRAVISOPT /RUNFILES/ packet (A).

Note: The core model creates two output files. The first is a message file (*.msg) that can be
read with a text editor or through DOS and identifies relevant information on the model
run such as time and date of the run, files processed, and any error or warnings which
occurred during the run. The second is a data file (*.out) that can be opened and viewed
in the reporting utility. It is important to choose new names for any output files, unless
you want to overwrite prior outputs of the same name.

In addition, the core model can optionally create two by-model-year data files. See the
/MODELYEAR OUT/ section below for more information.

To do this, follow these steps:
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1. Locate the /RUNFILES/ packet in travis.opt.

2. Move to the “ Messagefile’. Type in the name that you want to call the new message
file (in our example travis.msg).

3. Move to the “ Output data file”. Type in the name that you want to call the new
output file (in our example, travis.out).

Modifying /M ODELYEAR OUT/

The core model can create two additional output files, defined in the optional /MODELYEAR
OUT/ packet. These files further break down the data in the standard output file, by model year
and technology type. The by-model-year data is separated into two files, one for exhaust
emissions and one for evaporative emissions. One or both files or the entire packet may be
omitted from the option file. If included, the packet appears as follows, where the first 20
characters of each line contains the keywords which identify the kind of file specified.

/MODELYEAR OUT/

EXHAUST BMY OUT :c:\nonroad\outputs\travis.bmx
EVAP BMY OUT :c:\nonroad\outputs\travis.bmv
/END/

Figure 4-3: TRAVISOPT /RUNFILES/ packet (B).

To modify the /MODELYEAR OUT/ packet, follow these steps:
1. Locate the /MODELYEAR OUT/ packet.

2 Move to the "Exhaust bmy out file". Type in the name that you want to call the new
exhaust by-model-year file (in our example travis.bmx).

3. Move to the "Evap bmy out file". Type in the name that you want to call the new
evaporative by-model-year file (in our example travis.omv).

Modifying /OPTIONY

The options packet, /OPTIONS/, defines some of the parameters that make episode-specific
emission factor adjustments. These options include fuel specifications that will be in effect
during the modeling period and ambient temperatures that are typical during the same period. In
addition, you can define the title that describes your modeling scenario and which will appear on
your model reports.
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The order of the records is fixed. The order is as follows:

- Char 80: First title on reports

- Char 80: Second title on reports

- Real 10: Fuel RVP of gasoline for this simulation

- Real 10: Oxygen weight percent of gasoline for simulation
Real 10: Weight percent sulfur for gasoline

- Real 10: Weight percent sulfur for diesel

- Real 10: Weight percent sulfur for marine diesel

- Real 10: Weight percent sulfur for LPG/CNG

- Real 10: Minimum daily temperature (deg. F)

10 - Real 10: Maximum daily temperature (deg. F)

11 - Real 10: Representative average daily temperature (deg. F)
12 - Char 10: UNUSED. Flag to determine if region is high altitude (LOW or HIGH)

O©ooO~NO Ol WN P
1

The acceptable range of values for each of the fuel specification and ambient temperature options
are as follows:

Fuel RVP 6to 16

Oxygen (wt.%) 0to5

Fuel Sulfur (%) 0t0 0.5

Temperature (°F) -40 t0 120

Altitude* Low or High (Specify high where average

altitude > 5000 ft)

*High altitude adjustments are not included in this version of the model.

The minimum temperature that you define for your modeling scenario is the average low for the
time period selected. For example, when modeling a typical summer day, the minimum
temperature should be the average low temperature in Fahrenheit for the summer season.
Moreover, when modeling an entire year, the minimum temperature should be the average daily
low for the year and not the lowest temperature ever recorded. Other modeling parameters, such
as RVP, sulfur, and oxygen content, depend on local fuel characteristics. Data for an area should
be available from the state or local air agency.

Note: If a daily temperature and RVP input data file is specified in the /DAILY FILES/ packet,
then the RVP and temperature inputs in the /OPTIONS/ packet are ignored. See Chapter
6, Advanced Topics, for more information on the /DAILY FILES/ packet.

To modify the options packet, follow these steps:
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1. Locate the /OPTIONS/ packet.

2. Locate Titlel. Type in a description of your scenario. If you are interested in adding
a subtitle, type that on the line Title 2. If you do not want a title to appear on your
report, leave these fields blank.

3. For the remaining information in the /OPTIONS/ packet, change any existing
information that is relevant for your run. Figure 4-4 shows the /OPTIONS/ packet
with modifications for our model example.

1 - Char 80 - First title on reports

2 - Char 80 - Second title on reports

3 - Real 10 - Fuel RVP of gasoline for this simulation

4 - Real 10 - Oxygen weight percent of gasoline for simulation

5 - Real 10 - Percent sulfur for gasoline

6 - Real 10 - Percent sulfur for diesel

7 - Real 10 - Percent sulfur for LPG/CNG

8 - Real 10 - Minimum daily temperature (deg. F)

9 - Real 10 - maximum daily temperature (deg. F)

10 - Real 10 - Representative average daily temperature (deg. F)

11 - Char 10 - Flag to determine if region is high altitude
Valid responses are: HIGH and LOW

12 - Char 10 - Flag to determine if RFG adjustments are made

Valid responses are: YES and NO

/OPTIONS/
Title 1 : Lawn and Garden Equipment
Title 2 : Travis County, Summertime 1998

.0
.0
Gas sulfur % .034

Fuel RVP for gas 9
0
0
Diesel sulfur % : 0.33
0
0
6

o

Oxygen Weight %

Marine Dsl sulf % .33
CNG/LPG sulfur % .003
Minimum temper. (F):
Maximum temper. (F): 84
Average temper. (F): 75
Altitude of region : LOW
/END/

Figure 4-4: Modified /OPTIONS/ packet.

Modifying /PERIOD/

The packet /PERIOD/ defines the period of time for which emissions are to be estimated. The
valid responses for the /PERIOD/ packet are as follows:
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Period type Annual, seasonal, or monthly

Summation Type Typical day or period total

Year of Episode A four-digit year between 1970 and 2050

Season of year Winter, spring, summer, autumn

Month of year Complete month name

Weekday or Weekend Weekday or Weekend

Year of Growth Calc A four-digit year between 1970 and 2050 (may be
left blank)

Year of Tech Sel A four-digit year between 1970 and 2050 (may be

left blank. If a year is entered, it must not be greater
than the Episode year)

The season is ignored if the period type is not seasonal. Similarly, the month is ignored if the
period type is not monthly. Also, weekday/weekend is ignored if summation type is period total.

To modify the /PERIOD/ packet, follow these steps:
1. Locate the /PERIOD/ packet.

2. Modify the information that is appropriate for your scenario. Figure 4-5 shows the
/PERIOD/ packet with the changes required for our example.

1 - Char 10 - Period type for this simulation.
Valid responses are: ANNUAL, SEASONAL, and MONTHLY
2 - Char 10 - Type of inventory produced.
Valid responses are: TYPICAL DAY and PERIOD TOTAL
3 - Integer - Year of episode (4 digit year)
- Char 10 - Season of year
Valid responses are: WINTER, SPRING, SUMMER, and AUTUMN
5 - Char 10 - Month of episode (use complete name of month)
6 - Char 10 - Type of day
Valid responses are: WEEKDAY and WEEKEND
7 - Integer - Year of growth calculation (4 digit year)
8 - Integer - Year of technology selection (4 digit year)
Valid responses are: (blank) or 4 digit year (must not be
greater than Year of episode)
/PERIOD/
Period type : seasonal
Summation type : Period Total
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Year of episode : 1998
Season of year : Summer
Month of year 8
Weekday or weekend :

Year of growth calc:

Year of tech sel

/END/

Figure 4-5: Modified /PERIOD/ packet.

Modifying /REGION/

The packet /REGION/ defines the geographic region that you are interested in modeling. In the
NONROAD model, regions are defined by using two types of parameters. The first specifies the
type of region. The acceptable responses for the region level are US TOTAL, 50 STATE,
STATE, COUNTY, and SUBCOUNTY. The second type of parameter identifies the region
codes or FIPS codes to be modeled. You can specify a global FIPS code to indicate an entire
group of counties or states. For example, by entering “06000" as the FIPS code, you are
specifying all of the counties in the State of California. Similarly a FIPS code of “00000"
indicates all states in the United States. Examples of some FIPS codes used in the model are
listed in Appendix A. Beginning with NONROAD2005 the full set of FIPS codes used by the
model exists as an input data file (fips.dat) in the DATA\ALLOCATE folder.

The following table shows how the model’s definition of the modeling region depends on the
combination of the level and FIPS code(s) specified:

Level FIPS Code

US TOTAL The “FIPS code” is ignored and national estimates are
calculated. This run is substantially faster than 50 STATE since
no state detail or allocation is required.

50 STATE The “FIPS code” is ignored and state-level estimates are
calculated for all 50 states, Washington D.C., Puerto Rico, and
the U.S. Virgin Islands.

STATE If a list of specific state FIPS codes is supplied [e.g., 06000 (for
California) and 48000 (for Texas)], state-wide emissions for the
defined states are produced.

COUNTY If the global code for a state is specified (e.g., 06000), county-
level estimates are calculated for all counties within the state. If
a list of specific county FIPS codes is supplied, county-level
estimates for just those counties will be produced.
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SUBCOUNTY  To estimate subcounty emissions, the codes must be a
combination of a single county FIPS code and a subcounty code.
For example, if you were interested in modeling the Northwest
portion of Washtenaw County in Michigan, you would combine
the FIPS code for the county (26161) with a subcounty code
(NW) to form the code 26161NW. Estimates for the sub-county
level will be calculated. If this option is specified, appropriate
data for subcounty resolution must also be supplied in the data
files. Refer to the section on Modifying Inputs for Subcounty
Runs in Chapter 6.

To modify the /REGION/ packet, follow these steps:
1. Locate the /REGION/ packet.

2. Remove, add, or change any existing information that is not relevant for your
scenario. For our example, the FIPS code for Travis County, Texas is 48453 (48
designates the State of Texas; 453 is the code for Travis County). Figure 4-6 shows
the /REGIONY/ packet with the changes required for our example.

US TOTAL - Nothing needs to be specified. The FIPS
code 00000 is used automatically.

50STATE - Nothing needs to be specified. The FIPS
code 00000 is used automatically.

STATE - state FIPS codes

COUNTY - state or county FIPS codes. State FIPS
code means include all counties in the
state.

SUBCOUNTY - county FIPS code and subregion code.

/REGION/

Region Level : COUNTY

Figure 4-6: Modified /REGION/ packet.
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M odifying /SOURCE CATEGORY/

The packet /'SOURCE CATEGORY!/ tells the model which source classification codes (SCCs)
are to be processed. This is an optional packet. If the /SOURCE CATEGORY/ packet is
omitted, all SCCs are processed. If you would like to model only a subset of equipment types
then include the packet and your preferred list of SCCs. Running the model with only the desired
equipment types can reduce model run time and help focus reports on data of particular interest.

Tip:  Some packets in the core model, such as /SOURCE CATEGORY/, are optional and can
be removed from processing by simply removing the initial slash “/”” character, or by
placing any non-blank character in the first column of the line containing the packet
identifier. For example, if you wanted to “comment out” the /SOURCE CATEGORY/
packet, the first column of the packet could look like this: ,/SOURCE CATEGORY/ with
the comma (,) as the non-blank character.

Each source category in the NONROAD maodel is uniquely identified with a source category
code (SCC), which is a ten-digit number. The first two digits, 22, represent mobile sources. For
most categories, the next two digits represent the engine or fuel type (60, 65, 67, 68, and 70,
represent 2-stroke gasoline, 4-stroke gasoline, LPG, CNG, and diesel respectively). The next
three digits represent the segment type (for example, recreational or construction). And the last
three digits represent the specific kind of equipment (for example, golf carts or snowmobiles).
For our example, the SCCs for lawn and garden equipment are 22xx004000, where xx = 60, 65,
67, 68, and 70, ‘004’ signifies lawn and garden, and ‘000" indicates all types of equipment in the
lawn and garden category. The SCC 2265000000 refers to all 4-stroke gasoline sources. Refer
to Appendix B for a complete list of NONROAD SCCs.

To modify the /'SOURCE CATEGORY/ packet, follow these steps.
1. Locate the /SOURCE CATEGORY/ packet.

2. Remove or change any existing information that is not relevant for your scenario
(Figure 4-7).
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SOURCE CATEGORY PACKET

This packet is used to tell the model which source
categories are to be processed. It is optional.
If used, only those source categories list will
appear in the output data file. If the packet is
not found, the model will process all source
categories in the population files.

/SOURCE CATEGORY/

:2260004010
:2265004010
:2267004010
:2268004010
:2270004010

Figure 4-7: Modified /SOURCE CATEGORY/ packet.

Modifying the /POP FILES and /ALLOC FILES/ Packet

In the NONROAD model, there are several packets found in an option file that list the names of
files that contain data used by the model to estimate emissions. To make these data files more
manageable, some of the data is separated into files by state. In most cases, these files do not
require any modifications if you are running the model with the default data provided.

When you modify the /REGION/ packet, specifying a different or additional state to model, then
two types of data files may be affected by this modification. These two types of files are the
population data files and the allocation data files, which are located in the /POP FILES/ packet
and the /ALLOC FILES/ packet, respectively. The /POP FILES/ packet defines the equipment
population files read by the model. You can identify any number of files for a run; typically each
file represents one state. The /ALLOC FILES/ packet defines the spatial allocation files read by
the model. These files contain the surrogate indicators typically used to allocate from the state-
level to county-level. These files are separated by state and by type of allocation indicator.

Whenever you create an option file for a region outside of the originally defined area, you must
change the state identification code of the population and allocation data files to the new state, or
U.S. total.
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To modify the /POP FILES/ packet, follow these steps.
1. Locate the /POP FILES/ packet .

2. Check to see that the population data files contain the name of the state that you are
interested in modeling. If not, modify the name of the population file to identify the
state you want. For our example, the population file should be changed to the file for
the state of Texas, “C:\NONROAD\DATA\POP\TX.POP”, as shown in Figure 4-8.
(Since we are only interested in a county in one state in our example, only the
population file for that state is required. If you were interested in multiple states, the
population files for each state would be required.)

| Note: Population data files are named using the two character state abbreviation. .

This is the packet that defines the equipment population
files read by the model.
/POP FILES/

:c:\nonroad\data\pop\tx.pop

/END/

Figure 4-8: Modified /POP FILES/ packet.

To modify the /ALLOC FILES/ packet, follow these steps:
1. Locate the /ALLOC FILES/ packet.

2. Asyou can see in Figure 4-9, in addition to being separated by state, the allocation data
files are further stratified by a series of allocation factors. Once you locate /ALLOC
FILES/, check to see that the allocation data files contain the two-character
abbreviation of the state that you are interested in modeling. If not, modify the name
of the allocation data files to identify the state you want. For our example, the files
containing the allocation data should be changed to identify the state of Texas.
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This is the packet that defines the spatial

allocation files read by the model.

/ALLOC FILES/

RV Park employees
Golf Course estab.
Air Transportation
Contruction value
Havested cropland
Wholesale establis.:
Family housing
Logging empl.
Landscape empl.
Manufacturing empl.:
0il & gas employees:
Census population
Resid. snowblower
Comm. snowblower

:\nonroad\data\allocate\tx const

Snowmobile
Outboard water
Inboard water
Coal mining empl.
Locomotive NOx
/END/

(T 0 T 0 T T @ T @ N T @ TR0 T'e N0 T 0 T'e NN N 0 0 e BN e e}

Figure 4-9: Modified /ALLOC FILES/ packet.

To modify the /STAGE 11/ packet, follow these steps:

1. Locate the /STAGE Il / packet.

:\nonroad\data\allocate\tx rvprk.
:\nonroad\data\allocate\tx golf.alo
:\nonroad\data\allocate\tx airtr.
.alo
:\nonroad\data\allocate\tx farms.
:\nonroad\data\allocate\tx holsl.
:\nonroad\data\allocate\tx house.
:\nonroad\data\allocate\tx loggn.
:\nonroad\data\allocate\tx lscap.
:\nonroad\data\allocate\tx mnfg.alo
:\nonroad\data\allocate\tx oil.alo
:\nonroad\data\allocate\tx pop.alo
:\nonroad\data\allocate\tx sbr.alo
:\nonroad\data\allocate\tx sbc.alo
:\nonroad\data\allocate\tx snowm.
:\nonroad\data\allocate\tx wob.alo
:\nonroad\data\allocate\tx wib.alo
:\nonroad\data\allocate\tx coal.alo
:\nonroad\data\allocate\tx rail.alo

alo

alo

alo
alo
alo
alo
alo

alo

2. Once you locate /STAGE 11/, check to see that the percentage reduction in refueling

emissions under Stage Il control reflects that of the area you are interested in

modeling. If the area does not have Stage Il control at the fuel pump, the effectiveness

should be zero. Otherwise, enter a control effectiveness between 0.0 and 100.0

percent.

Note: A decimal point must be used after the percent effectiveness. I

Note: EPA currently has no data on the effectiveness of Stage Il for nonroad equipment. The
value should be left at 0.0% unless local data exist on which a value can be based.
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Saving an Option File

After you have completed the modification of an option file to reflect the scenario that you are
interested in modeling, save the file and exit the text editor.

RUNNING THE CORE MODEL

After you have created an option file that defines the scenarios you are interested in modeling, the
process of running the core model is quite simple. In Chapter 3, the steps necessary to run the
core model through the graphical user interface were described. In this chapter, the steps required
to run the core model through a DOS window are described.

To run the core model through a DOS window, follow these steps:
1. Opena DOS window.
2. Change to the Nonroad directory.

3. Type “nonroad (the name of your option file).opt” to run the core model. For
example, if you were interested in running the example option file travis.opt, type
“nonroad travis.opt”.

4. The model will now run with your option file. The first step that the model goes
through is an initialization. During this step, the core model is reading in the option
and data files and checking to ensure that all data files required to complete the run
are available. After the model has initialized, it will begin the process of calculating
emissions estimates based on the parameters that you set. A line on the screen will
inform you of the progress of your run. When the run has finished, a message will
appear indicating that the run was successfully completed (Figure 4-10).

Note: Most of the errors that may occur during the running of a scenario will occur during the
initialization stage. If an error occurs, a message will appear on the screen notifying you
of the error. Make the appropriate correction and rerun the model.
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= EPA NONROAD Model

Microsoft Windows XP [Version 5.1.26801
(C> Copyright 1985-2801 Microsoft Corp.

C = “NOMROAD>NONROAD.exe TRAVIS.OPT
Initializing...Done
Processing...108:x

Completion of EPA's NONROAD Emissions Model, Core Model Uer 2885, May 2005

There were 5 warnings. Review message file.
Program Completed
Press Enter to Continue.

C:\NOMROAD>_

Figure 4-10: DOS window showing successful model run.

5. Review the mesage file associated with this run. Either type “ edit outputs\(the name

of your file).msg” or you can open the message file through a Windows text editor.

Error Stop Feature

When an error occurs in the core model, an informative message is displayed in the window and
written to the output message file, and the program stops. In addition to error checking, a number
of conditions are checked that will produce a warning message. Warning messages are meant to

inform you that a condition exists which you may want to review and correct. An example is
“WARNING: Monthly seasonality factors do not add to 1. Renormalizing...” If you have

included new seasonality data and thought it should sum to one, then this message would indicate
either a data format problem or a typo. There are conditions which could produce many warning
messages and still run to completion. In order to avoid this situation, the model will stop if 50 of

the same kind of warning message is generated.
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Chapter 5 Reporting Utility

In this chapter of the user’s guide, the following topics are discussed:

a general description of the NONROAD model Reporting Utility,
how to import core model outputs,

the different report types,

how to generate and view reports, and

how to compact databases, and how to repair corrupted databases.

QUICK START

Each step involved in the creation of NONROAD model reports is explained in this chapter.
However, to quickly create reports and view core model output data, follow these simple steps.

1. Start the reporting utility from the Reports icon created when the NONROAD model

was installed on your computer, or by selecting Model » Reports from the graphical
user interface main menu. (For more information, see General Description below.)

Import the core model output file that you are interested in viewing by selecting Data
» Import Data from the main menu of the reporting utility. (For more information,
see Importing Core Model Output below.)

Select the report type. From the main menu select Reports » “report name”. Once
you have selected the report that you want, specify the report options. (For more
information, see Report Types and Generating Reports below.)

You can print the displayed report by selecting File » Print. (For more information,
see Viewing a Report in Print Preview below.)
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GENERAL DESCRIPTION

The reporting utility is used to create standardized reports using output data generated in the core
model. Like the graphical user interface, the reporting utility is a fully operational Windows
program designed as a separate module in order to take advantage of the many reporting and
formatting options available when using a database application. Although the reporting utility is
written in Microsoft Access database software, you do not need to know how to use Access to
generate reports. Microsoft Access 2000 allows users operating Windows 3.1 and Windows 95
and above to run the reporting module. If you do not have Access 2000 (i.e., if you do not have
any version of Access installed on your computer or you are using a higher version of Access,
such as XP or 2003, for other database applications), the reporting utility will operate as a
standalone application.

Warning: If you are using a version of Access that is higher than 2000, such as XP or 2003, do
not convert the reporting utility from Access 2000 to the higher version. The two
versions may be significantly different and may require major rewriting of the
reporting utility modules. If you want to use a version of Access that is higher than
2000 on the NONROAD reporting utility tables then make a copy of nrdata.mdb and
convert/import the copied database into the higher version of Access. This will

preserve the reporting utility integrity and allow you the power to create custom

reports.

When the NONROAD model is installed on your computer, an icon for the reporting utility is
created. To start the reporting utility, double click on the reporting utility icon. Alternatively,
selecting Model » Reports while running the graphical user interface will also start the
reporting utility.

THE REPORTING UTILITY MENUS

Figure 5-1 shows the initial screen when the reporting utility is executed. From this screen you
can access the pull down menus that make up the reporting utility.

» File - setup and preview a window for printing, print a window, and exit the database.

* Reports - select a standard report for viewing emission inventory, equipment
population, or fuel consumption data.

o Compare - select a report for comparing the results of two separate modeling runs.
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» Emission Factors - select a report for viewing gram/hp-hr or gram/hour data.

» Data - import data, remove a simulation from the database, and re-attach files.

NOMNROAD Reporting Utility, Version 2005

File Reports Compare Emission Fackors Data

Nonroad Emissions Model
! .l -
i '

If you have just run the core model and want to view te
results, go to the Data menu, and choose Import Run.

If you have already imported core model output data and
want to generate reports, go to the Report menu and choose
areport type.

r IDDm'tdlspIaythese instructions again OK

Form viow C [ [ mw [ 4
Figure 5-1: Initial report utility screen.

Once a main menu item is selected, a list of submenu items will be displayed. The following
shows the list of submenu items for each of the main menu choices:

File Print Setup...
Print Preview
Print...
Exit

Reports  Emissions Totals by County
Emissions Totals by County and Fuel Type
Emissions Totals by Equipment Type
Emissions Totals by Horsepower
Emissions Totals by HP and Source Classification
Emissions Totals by HP and Equipment Type
Emissions Totals by SCC
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Emissions Totals by Source Classification
Population and Fuel Consumption by HP and Source Classification
Population and Fuel Consumption by SCC

Compare Compare Two Model Runs by HP and Source Classification
Compare Two Model Runs by Pop and Fuel
Compare Two Model Runs by SCC
Compare Two Model Runs by Source Classification
Compare Two Model Runs by County
Compare Two Model Runs by Horsepower
Compare Two Model Runs by Equipment Type
Compare Two Model Runs by HP and SCC

Emission Grams per Operating Hour by SCC
Factors ~ Grams per Operating Hour by HP and SCC
Grams per Day by SCC
Grams per Day by HP and SCC
Grams per HP-Hour by SCC
Grams per HP-Hour by HP and SCC

Data Import Data
Remove Run
Re-Attach Tables
Export NIF File

Each submenu item opens a window where you must provide additional information. When an
input error occurs, an appropriate message (dialog box) is displayed. Make the corrections
needed, and continue.

IMPORT, DELETE, RE-ATTACH, AND EXPORT NIF

The reporting utility has been designed to run cohesively with the graphical user interface and the
core model to simplify the use of the NONROAD model; if you operate the model with the
default inputs provided, the process of running a simulation and generating reports is
straightforward.

Importing Core Model Output
In order to generate model summary reports, the reporting utility must import the output from the

core model. As discussed in Chapters 3 and 4, the core model output file (*.out) will have the
name you assigned to it.
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Follow these steps to import a core model output data file:
1. From the Main Menu, select Data » Import Data.
2. Specify the core model output file in the open file dialog box.
3. Ascreen will appear requesting you to enter the new database table name (Figure 5-
2). Type in the appropriate name of the database table. The database table name that

you enter is the name that the reporting utility will recognize for all further processing
of the data.

Tip:  The reporting utility allows you to name the database table using up to 30 characters. The
name you give the database table can be the same as the output data file (but without the
.extension since a period is not a valid table name character in Access, nor is the
apostrophe). However, because the core model was developed in Fortran, the name of the
output file without extension is no longer than eight characters as a result of DOS
conventions. Thus, to help in differentiating one core model run from others, it is

recommended that a more descriptive name be used.

(=119
| Import Core Model Data:

¢:\nonroadioutputsitravis.out

Enter the new database table name:

Figure 5-2: Import core model data screen.

4. After you have entered a name, Import the data. The bottom of the window will
display a line indicating the percent completion of the import. This process may take
several minutes or longer depending on the size of the database that you are
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processing and the speed of your computer. When the import is complete, a message
box will appear indicating that the process is done. Enter OK.

Note: If you enter a name that is invalid (e.g., contains punctuation marks or has already been
used), a message will appear notifying you of the problem and return you to the table
name field. If this happens, simply rename the table and Import again.

5. Following the data import and message screen you will be requested to specify
another core model output file in the open file dialog box (Step 2). You can repeat
steps 2 - 4 and continue to import core model output files. When you are finished
importing files select Cancel in the open file dialogue box to return to the main menu.

Removing a Run

When an imported database table is no longer of use it can be deleted. This should only be done
with the reporting utility submenu option Remove Run. In addition to deleting the table, the
reporting utility removes records from tables it uses for processing.

Warning: Simulation tables should never be deleted in the NRdata database except through
Data » Remove Run in the reporting utility.

Follow these steps to delete an imported database table:

1. From the Main Menu, select Data » Remove Run.

2. A screen appears allowing you to indicate which table you want to delete. Select the
table name from the available list or type the table name in the field. When you type
the table name it will automatically be expanded to match a name in the list.

3. Specify Remove. When the table has been successfully deleted a message box will
appear indicating that the process is done. Enter OK.

4. Repeat steps 2 and 3 until all database tables you want to delete have been removed.
Until you return to the main menu, the list of table names may show “#Deleted” for
those tables which you have deleted.

5. Specify Done. The message, “Access 2000 and later will automatically compact
NRdata.mdb upon exiting the Reporting Utility when simulations have been
removed.” is displayed. Enter OK.
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Attaching the Reporting Utility Databases

When the NONROAD maodel is installed, a subdirectory called Reports is created. Within this
subdirectory are two databases required to run the reporting utility. These databases and the
information contained in each are as follows:

* NRdata.mdb - This database contains the example data supplied with the model and
any core model output data you import.

* Reports.mdb - This database contains the reporting utility code and requisite data
tables (such as the SCC table and FIPs county code).

Warning: The NRdata and Reports databases are essential to run the reporting utility. In
addition, there are two tables in the NRdata database called Table Headers and Table

Counties that also are essential to the operation of the reporting utility. These

databases and tables should never be deleted.

To operate the reporting utility, Reports.mdb must have the path of NRdata.mdb in order to
properly connect to it. The first time the reporting utility is started a screen will be displayed
with the message “Attaching Tables...”. When the Nrdata tables have been successfully attached
to the Reports database a message box will appear indicating that the operation is complete.

If you move the database tables to a new directory you will have to connect Nrdata.mdb to the
Reports database. Follow these steps:

1. Select Data » Re-Attach Tables.

2. If the databases reside in the same subdirectory as the reporting utility, a message box
will appear indicating that tables were successfully attached. Enter OK. If
NRdata.mdb resides in a different directory than Reports.mdb, an open file dialog box
will appear. Locate the directory where the NRdata.mdb database resides. When
NRdata.mdb is attached, a message box will appear indicating that the operation is
done.

Exporting a NIF Database

In addition to providing various reports to allow analysis of run data, the reporting utility also
makes available the ability to export National Emission Inventory Input Format (NIF) data. NIF
is the format most widely used by state and local agencies to transfer data to the EPA's National
Emission Inventory (NEI).
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Follow these steps to export a NIF database from one of the run tables:
1. From the Main Menu, select Data » Export NIF File.
2. Specify the simulation table in the screen that appears (Figure 5-3), after clicking on

the down arrow. This will be the table name that was entered when the simulation run
was imported.

Export NIF |:| |E| El

EpotSimalation: || |

Figure 5-3: Select simulation screen.

3. Ascreen will appear requesting you to enter supplementary information (Figure 5-4).
Enter the contact information, period specification, and comments. Some of the
information is mandatory, and the screen will prompt for any missing information.

B Export to NIF 3.0

Cortaceoson f| WO ganzaontane || ]
Contaeptore || [ fTeeghone Nuber Tyge | ]
Fctonepagess ]
Ehctonc Adsess e |

it Toge [ Conter o [Tl Cae [l

Total for Summer Season, 1998
Start Date (yyyymmdd): 19980601 End Date (yyyymmdd): 195980831
Period Type Epizode Year: 1998

Figure 5-4: Supplementary information screen.
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4. After you have entered the supplementary information, Export the data. Specify the
output NIF database in the save file dialog. The database name must end in ".mdb"
and must not exist yet.

STANDARD REPORT TYPES

The reporting utility provides you with a set of standard reports. With the exception of the first
report listed below, Emissions Totals by County, each of the reports displays the report data total
for either all states or counties, or for a single user-specified state or county. In addition, each of
the emissions reports displays emissions for either every fuel type or for a single, user-specified
fuel type. A summary of each of these reports is as follows:

Emissions Totals by County - This report lists emissions by pollutant and county.

Emission Totals by County and Fuel Type - This report lists emissions by pollutant, fuel
type, and county.

Note: If the output file generated in the core model contains data for multiple counties in a state,
the Emission Totals by County and Emission Totals by County and Fuel Type reports will
be reported for all of these counties. If you want a separate report for each county, then
the core model must be run for each individual county. Once the core model has been run,
you must import the output files and run the Emission Totals by County or Emission

Totals by County and Fuel Type report using each “county’ database table.

Emission Totals by Equipment Type - This report lists emissions by pollutant for each
equipment type. It is separated by major source classification (e.g., agricultural, lawn &
garden, etc.) with subtotals provided for each classification. Equipment type descriptions
are also included (e.g., “2-wheel tractors”, “asphalt pavers”, etc.). The report includes a
grand total by pollutant.

Emissions Totals by Horsepower - This report lists emissions by pollutant and
horsepower ranges. The report includes totals across all horsepower ratings by pollutant.

Emissions Totals by HP and Source Classification - This report lists emissions by
pollutant for each Source Classification segment and horsepower range. The report is
separated by major equipment classification and subtotals are provided. The report
includes a grand total by pollutant.

Emission Totals by HP and Equipment Type - This report lists emissions by pollutant
for each equipment type and horsepower range. It is separated by major source segment
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(e.g., agricultural, lawn & garden, etc.) with subtotals provided for each segment.
Equipment type descriptions are also included (e.g., “2-wheel tractors”, “asphalt pavers”,
etc.), as are the horsepower ranges within the equipment type. The report includes a
grand total by pollutant.

Emissions Totals by SCC - This report lists emissions by pollutant for each SCC code.
The report is separated by major equipment classification and subtotals are provided. In
addition to the SCC code, the equipment description and engine type is provided. The
report includes a grand total by pollutant.

Emissions Totals by Source Classification - This report just lists emissions by pollutant
for each major equipment segment (e.g., agricultural, lawn & garden, etc.). The report
includes a grand total by pollutant.

Population and Fuel Consumption by HP and Source Classification - This report lists
equipment population and fuel consumption for each fuel type, major source segment
(e.g., agricultural, lawn & garden, etc.), and horsepower range. The report is separated by
fuel type and major equipment segment, and subtotals are provided. The report includes
a grand total of population.

Population and Fuel Consumption by SCC - This report lists equipment population and
fuel consumption for each SCC code. The report is separated by fuel type and major
equipment classification, and subtotals are provided. In addition to the SCC code, the
equipment description and engine type are provided. The report includes a grand total of
population.

Note: CNG is a gaseous fuel, and its fuel consumption is reported in gallons at standard
temperature and pressure. This can be misleading if this very large number is viewed
together with the fuel consumption of the other (liquid) fuels.

USER SPECIFICATIONS

To provide flexibility in designing a report, the reporting utility offers several report options.
When you select a report type, a window appears requesting specific inputs and your choice of
display options. Figure 5-5, used by most of the different report types, sets all of the report
options available. The other window used to set report options contains a subset of these
options.
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Note: Because there are different types of hydrocarbon and particulate matter emissions, the
reporting utility is designed to allow you to identify the type of reporting units that you
want. For hydrocarbon emissions, the core model calculates and outputs these emissions
as THC (total hydrocarbon). The reporting utility has the capability to report
hydrocarbons as THC, TOG (total organic gas), NMOG (non-methane organic gas),
NMHC (non-methane hydrocarbon), or VOC (volatile organic compounds). THC is
converted to the other designations by applying appropriate factors.

For particulate matter, the core model calculates and outputs these emissions as PM,,.
The reporting utility allows you to report particulates as PM,, (particulate size of 10
microns or less), or PM, . (particulate size of 2.5 microns or less). PM,, is converted to
PM., . by applying an appropriate factor.

Report:
Emission Totals by SCC

Select the HC

Select Run to use:

I

Decimal places to use:
Selectthe PM size

P10

Report all states/counties? | H

Fh25

T Decmiscestouser
e

—
—
— e |

Report one statelcounty:

Pollutants to report:

I

Fuel Type:

Figure 5-5: User specified report options screen

A brief description of the report options is provided in the table below.

EPA NONROAD Emissions Model User’s Guide 5-11



December 2005

User-Specified
Report Option

Description

Database table to use

Decimal places to use

Report all states/counties?

Report one state/county

Pollutants to report

Fuel Type

Select the HC

Enter the table name that you want to use for the report
(this is the name you gave the database table when you
imported the file into the reporting utility as described
previously in Importing Core Model Output). Select the
table name from the available drop-down list or type the
table name in the field. When you type the table name it
will automatically be expanded to match a name in the list.

The default is two decimal places for most reports. You
can specify a number between 0 and 5.

If you want to report emissions for all states or counties
included in the core model output file, click in this field to
specify yes. If you select all, the next report option (Report
one state/county) is removed from the window.

Select a state or county from the drop-down list or type the
name of the state/county directly into the field. When you
type the state/county name it will automatically be
expanded to match a name in the list.

The “pollutants to report” option allows you to select a
grouping of pollutants to report. Designate the group of
pollutants to report from the list of pollutant choices and
descriptions. Depending on your selection, the “Select the
HC” field and/or the “Select the PM size” field may be
removed from the window. For example, by choosing all
PM, it is no longer necessary to specify a hydrocarbon type
or a particulate matter size.

This option allows you to report all fuels or to specify a
single fuel to report. The options are All fuels, CNG,
Diesel, Gasoline, and LPG. All equipment types which
have lumped fuels (HP < 25) are reported as gasoline.

When you select a group of pollutants that include
hydrocarbon emissions, you need to specify the
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hydrocarbon species that you want to report. Select the
hydrocarbon to report (i.e, THC, TOG, NMOG, NMHC,
VOC).

Select the PM When you select a group of pollutants that include
particulate emissions (with the exception of All PM) , you
need to specify the particulate size cutoff that you want to
report. Select the size of particulates to report (i.e., PM,,,
or PM, ).

Note: Total hydrocarbons is also reported when reporting non-exhaust hydrocarbon emissions.
This occurs for the pollutant groups: All Pollutants, Non-Exhaust, and All HC.

If a single fuel is reported, other than diesel, it is important to remember that all sources
with HP < 25 have been lumped into one category and will be reported as gasoline.

GENERATING REPORTS

Note: All emissions are reported as short tons (i.e., 2000 Ibs).

Once you have imported the necessary output files from the core model, reports can easily be
generated with the reporting utility. When a report is generated, a window opens and the report
is displayed in a Print Preview window.

Running a Report
To run a report, follow these steps:

1. From the Main Menu, select Reports » “Report Name”

2. Enter the report options. A message box is displayed when an error is detected
informing you of the problem encountered. Make the necessary changes and
continue.

3. After all required options have been specified, select Run. If a required field is left
blank or an incorrect entry has been made, a message box will be displayed. You

must correct the detected error and attempt to Run again. Once the report has been
generated, it will appear in a window.
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4. To return to the main menu without running the report select Cancel.

Tip:  User specified report options will remain in the window until closed (Cancel). If you
want to run more than one report which uses the same options window then leave the
report options window open and select another report from the Reports submenu. The
report title will be changed in the options window. Specify RUN. The same options
(database table, decimal places, pollutants, etc.) will be used for the report. This can save
you a lot of selecting/specifying report options.

Viewing a Report in Print Preview

For easier viewing maximize the report window. As you move the cursor across the report, it
changes from an arrow icon to a magnifying glass icon. To alternately zoom in or out of the
report, click the mouse while the cursor is on the report.

To view a specific portion of the report:
1. Locate the desired section of the report in Zoom Out mode.
2. Zoom In to the area of interest for detailed viewing.

3. To page up or down through a multipage report, press <PgUp> or <PgDn> while in
the Zoom Out mode. In either the Zoom In or Zoom Out modes, clicking on the
arrows in the lower left corner of the report window or typing the page number at the
bottom of the Print Preview window and pressing <Enter> will also move you to the
desired page.

To provide a consistent look for all reports, the report title area for each standard report in the
reporting utility is similar in design (Figure 5-6). The first two lines identify the report name and
attributes which include the user-specified fuel type, report units, and the state/county
specification. Following these lines are the user title lines which come from the core model
output file (originally from the OPTions file). The next line, also coming from the core model
output file, designates the period of emissions estimates. The final line of the report title area

indicates the date and time that the core model run was generated and the date that the report was
created.
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Emission Totals by SCC and Pollutant

All Fuels Tons/Season Travis County
Lawn and Garden Equiptment

Travis County ummertime (Travis 1998)

Total for Summer Season, 19%3

Date of Model Eun: May 29 16:37: 19 2005 Today's Date: 5/2%/2005

Figure 5-6: Report title area.

The Reporting Utility menu bar has only one option, File, when viewing a report. A displayed
report can be printed by selecting File » Print. By selecting File » Print Setup you can also
modify the print setup to adjust the margins, the page orientation, and the printer selection This

may be necessary if you have pagination problems printing a report (primarily due to different
printer font sizes).

Note: The abbreviation NA (not available) is printed in a report for entries of missing data. If a
column of data contains one or more NA entries, then the subtotals and totals for that
column will also be listed as NA.

Also, only sources with nonzero emissions are shown in a report. For example, if the
core model output file was generated for only lawn and garden source categories, then

only lawn and garden SCC codes with nonzero emissions for at least one pollutant will be
reported.

Warning: If the format of the value to be displayed in a report column exceeds the column
width then the value will be wrapped to the following line. For example,

123,456.789 might be written as 123,456.7
89

This should only occur when you have specified more than the default number of

decimal places to display. You can avoid this problem by specifying fewer decimal
places to display and rerunning the report.

Appendix C contains examples of all standard reports for a core model run of Washtenaw
County, Michigan emissions.
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Exporting to Excel

An option to export the line item report data to an Excel spreadsheet is available by selecting File
» Export to Excel. When selected, a dialogue box is opened to specify the Excel output file
name. After the name is specified it is displayed in a window where you can select Export
Report to create the file. When completed a message is displayed.

The spreadsheet file will contain the line item information from the report with appropriate
column headings. It will not contain subtotals, grand totals, or report title information. The
spreadsheet will have columns for all species and modes even though for example, you selected
to report only exhaust particulate matter. In addition, there are fields labeled “Missing species”
which are used by the reporting utility for totaling purposes. The numerous additional columns
can be deleted in Excel if you do not want or need them.
COMPARING MODEL RUNS
In addition to allowing you to generate and view reports from single model runs, the reporting
utility provides you with the ability to compare the results of two separate model runs. When
you select Compare from the reporting utility main menu the comparison reports include:

» Compare Two Model Runs by HP and Source Classification

» Compare Two Model Runs by Pop and Fuel

» Compare Two Model Runs by SCC

» Compare Two Model Runs by Source Classification

» Compare Two Model Runs by County

» Compare Two Model Runs by Horsepower

» Compare Two Model Runs by Equipment Type

» Compare Two Model Runs by HP and SCC
When comparing two runs, the report only shows the records that the two runs have in common.
For example, it you select a report that lists information by SCC, only that information pertaining
to SCCs that the two model runs have in common will be shown in the comparison report.

Similarly, if you are interested in comparing two model runs by horsepower and source
classification, you will get horsepower ranges within source classifications that the two runs have
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in common. If there are no common records between the two runs, you will get a message that
there is nothing to report.

In order to reasonably compare values between two model runs the simulations must contain the
same units. Since emissions are always output as short tons the period type must be the same
between the two simulations. For example, a tons/year simulation compared to a tons/season
will cause an informative message to be displayed and request you to select different tables to
compare.

For the comparison reports by HP and Source Classification, SCC, Source Classification,
County, Horsepower, Equipment Type, and HP and SCC, the report displays the results of model
run 1, model run 2, the difference between model run 2 and model run 1, and the percent
difference for a single user-specified pollutant. For the Pop and Fuel comparison report, the
report displays only the results of model run 1 and model run 2 side by side.
To compare the results of two separate model runs, follow these steps:

1. From the Main Menu, select Compare » “Report Name”

FEX
Report: Select the HC

Compare Two Model Runs by SCC

1st Run to use:

2nd Run to use: Select the PM size

*

. Reportt
| CompareTwoModelRusbyScC |
| fstRuntouse:
-
| ndRuntouse:
-

W

Decimal places to use:

|
|

Pollutants to report:

Figure 5-7: Report options for comparing two model runs.

2. Enter the report options. For the comparison reports Compare Two Model Runs by
HP and Source Classification, Compare Two Model Runs by SCC, Compare Two
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Model Runs by Source Classification, Compare Two Model Runs by County,
Compare Two Model Runs by Hor sepower, Compare Two Model Runs by Equipment
Type, and Compare Two Model Runs by HP and SCC, the report options are shown in
Figure 5-7. For the comparison report Compare Two Model Runs by Pop and Fuel,
the report options are shown in Figure 5-8. A message box is displayed when an error
is detected informing you of the problem encountered. Make the necessary changes
and continue.

(=19

Report:

Compare Two Model Runs by Pop and Fuel

1st Run to use:

2nd Run to use:

Decimal places to use:

Figure 5-8: Report options for comparing two model runs by population and fuel.

3. After all required options have been specified, select Run. If a required field is left
blank or an incorrect entry has been made, a message box will be displayed. You
must correct the detected error and attempt to Run again. Once the report has been
generated, it will appear in a window.

4. To return to the main menu without running the comparison, select Cancel.
Refer to the previous section on Viewing a Report in Print Preview for a discussion of viewing

and printing the generated report. Examples of all comparison reports are provided in
Appendix D.
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EMISSION FACTOR REPORT TYPES

In addition to the standard and comparison reports, the reporting utility provides you with a set of
emission factor reports. Each of the reports displays emission factor data for all fuels for all states
or counties in the simulation run table. Reports in g/hr or g/day report on all exhaust and
evaporative pollutants, whereas reports in g/hp-hr only report on exhaust pollutants. There are no
subtotals or grand totals in the emission factor reports. A summary of each of these reports
follows:

Note: If the output file generated in the core model contains data for multiple counties in a state
the emission factor reports will be reported for all of these counties. If you want a
separate emission factor report for each county, then the core model must be run for each

individual county. Once the core model has been run, you must import the output files

and run the emission factor report using each ‘county’ database table.

Grams per Operating Hour by SCC - This report lists emission factors in g/hr for each
SCC code. The report is separated by fuel type and major equipment classification. In
addition to the SCC code, the equipment description and engine type are provided.

Grams per Operating Hour by HP and SCC - This report lists emission factors in g/hr
for each SCC code and horsepower category. The report is separated by fuel type, major
equipment classification, SCC, and HP. In addition to the SCC code, the equipment
description and engine type are provided.

Note: Even though most diurnal, hot soak, permeation, and refueling emissions occur when the
engine is not running, the Grams per Operating Hour report calculates these emissions by
dividing the total tons of emissions by total operating hours.

Grams per Day by SCC - This report lists emission factors in g/day for each SCC code.
The report is separated by fuel type and major equipment classification. In addition to the
SCC code, the equipment description and engine type are provided.

Grams per Day by HP and SCC - This report lists emission factors in g/day for each
SCC code and horsepower category. The report is separated by fuel type, major
equipment classification, SCC, and HP. In addition to the SCC code, the equipment
description and engine type are provided.

Grams per HP-Hour by SCC - This report lists emission factors in g/hp-hr for each SCC
code. The report is separated by fuel type and major equipment classification. In
addition to the SCC code, the equipment description and engine type are provided.

EPA NONROAD Emissions Model User’s Guide 5-19



December 2005

Grams per HP-Hour by HP and SCC - This report lists emission factors in g/hp-hr for
each SCC code and horsepower category. The report is separated by fuel type, major
equipment classification, SCC, and HP. In addition to the SCC code, the equipment
description and engine type are provided.

To run an emission factor report, follow these steps:
1. From the Main Menu, select Emission Factors » Report Name.

2. Enter the report options. All emission factor reports have the same options, as shown
in figure 5.9. These options are a subset of the options described in the "USER
SPECIFICATIONS" section above. A message box is displayed when an error is
detected informing you of the problem encountered. Make the necessary changes and
continue.

3. After all required options have been specified, select Run. Once the report has been
generated, it will appear in a window.

4. To return to the main menu without running the emission factor report, select Cancel.

Refer to the previous section on Viewing a Report in Print Preview for a discussion of viewing
and printing the generated report. Examples of all emission factor reports are provided in
Appendix E.

COMPACTING DATABASES

If a database contains many large tables, it may slow the operation of the reporting utility and
take up substantial space on the hard drive. This is particularly true if you remove large
simulations. Prior versions of NONROAD included a separate utility to compact the database
after removing simulations, but in NONROAD2005 this compacting function occurs
automatically.
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Chapter 6 Advanced Topics

In this chapter of the user’s guide the following topics are discussed:
» adescription of how data are grouped for use in estimating emissions,
» adescription of the option file packets,
» adescription of all input data files,
» information on how to incorporate local data by editing data files, and

e steps involved in running multiple model runs in a batch file.

INTRODUCTION

The NONROAD model includes default data files and report tables that allow you to easily
estimate the emissions from a wide variety of nonroad equipment and vehicles for any region of
the country. As discussed in Chapters 3 and 4, you can quickly set up an option file specifying
the parameters that are applicable to your modeling scenario using default data.

The NONROAD model was also designed, however, to provide you with the flexibility to create
emissions estimates based on locally specific data that may be available to you. For example,
you may have developed more up-to-date information for equipment populations in a particular
region than the default data available in the model. Similarly, you might want to estimate the
emissions for a particular category of nonroad equipment at a subcounty regional level. The
steps involved in modifying the default data input files and tables are provided in this chapter of
the User’s Guide. In addition, an example is provided for modifying inputs for subcounty runs.

While editing input files lets you adapt the model to specific local conditions, it also lets you
change the model in ways that lead to invalid results. In particular, the interdependency between
some inputs means that changes can affect outputs in surprising ways. The NONROAD maodel is
designed to warn you about the most obvious input errors, but avoiding more subtle, but serious,
errors requires understanding how the core model works.

You must be certain that any added data records are uniquely identified. Results will be
unpredictable if there are multiple records with matching key fields that have different data
values. For example, the file that contains monthly adjustment factors used to calculate the
fraction of annual activity in a given month is identified by a regional and a SCC code. If you
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add a record to this file with the same regional and SCC code as an existing record, with
differences in the monthly distributions, then the output may not be what you intend. Searches
are performed differently depending on the data file and processing routine. Do not assume that
the first record matching the key fields will be used. Some searches stop at the first match,
others find the last match, and still others sort the data before searching and the order of input
data records is no longer significant.

Note: The notes in this chapter offer guidance, but EPA’s technical support documents provide
more detail. A list of the NONROAD technical support documents can be found in the
Technical Documentation section of Chapter 1. If you have questions, e-mail EPA

nonroad modeling staff at nonroad@epa.gov

Warning: While editing input files lets you adapt the model to specific local conditions, there is
the possibility of changing the model in ways that lead to invalid results. An

understanding of data relationships is recommended before changes are made to the

data files.

HOW DATA ARE GROUPED IN THE NONROAD MODEL

As discussed briefly in Chapter 4, information used by the NONROAD model for estimating
emissions, including user-specified options and data files are input into the core model through
an option file. The information contained in each option file is separated into “packets” based on
common information. For example, all data files related to the population of equipment for a
modeling region is grouped in a single packet, as is information related to the period of time for
which you are interested in estimating emissions.

When viewing an option file through a text editor, the keyword that identifies a packet is
surrounded by forward slashes (“/”) and can appear in upper case, lower case, or mixed case. For
example, the packet identifier for all of the data files related to the population of equipment is
/POP FILES/. To designate the end, or terminator, of a packet, the keyword END is used, also
surrounded by forward slashes (i.e., /END/). The /RUNFILES/, /POP FILES/, and /GROWTH
FILES/ packets in an option file can be seen in Figure 6-1.
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/RUNFILES/
ALLOC XREF
ACTIVITY

EXH TECHNOLOGY
EVP TECHNOLOGY
SEASONALITY
REGIONS
MESSAGE

OUTPUT DATA
EPS2 AMS

US COUNTIES FIPS
/END/

files read by the model.

read by the model.

/GROWTH FILES/

/END/

This is the packet that lists the names of output files
and some of the input data files read by the model.

:\nonroad\data\allocate\allocate.xrf
:\nonroad\data\activity\activity.dat
:\nonroad\data\tech\tech-exh.dat
:\nonroad\data\tech\tech-evp.dat
:\nonroad\data\season\season.dat
:\nonroad\data\season\season.dat
:\nonroad\outputs\travis.msg
:\nonroad\outputs\travis.out
:\nonroad\outputs\travis.ams
:\nonroad\data\allocate\fips.dat

This is the packet that defines the equipment population

This is the packet that defines the growth files

National defaults :c:\nonroad\data\growth\nation.grw

Figure 6-1: Option file showing packet identifiers and terminators.

The following packets make up the NONROAD model option file:

Packet Identifier Required Description
/PERIOD/ Yes Period of time to model
/OPTIONS/ Yes Run title, fuel specs, temperatures
/REGION/ Yes Region to model
/RUNFILES/ Yes A set of input and output file names
/SOURCE CATEGORY/ No Source categories to process
/POP FILES/ Yes Equipment population file names
/GROWTH FILES/ Yes Projection/backcast data file names
IALLOC FILES/ Yes Spatial allocation file names
/[EMFAC FILES/ Yes Emission factors file names
/IDETERIORATE FILES/ No Deterioration factors file names
/MODEL YEAR OUT/ No By-model-year output file names
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Packet Identifier Required Description
/PERIOD/ Yes Period of time to model
/PM BASE SULFUR/ No Diesel sulfur content corresponding to base
emission factors
ISTAGE 11/ No Percent reduction due to Stage Il control
/DAILY FILES/ No Daily temperature and fuel RVP file name

If a packet is required by the core model to estimate emissions and is not found during a run then
an error message will appear and the program will stop. Each line within an option file packet
begins with a 20 character label. In most cases, the core model does not read these first 20
characters as they exist simply for the purpose of identifying the information provided. For
example, the line in the /OPTIONS/ packet that indicates minimum temperature ignores the
‘Minimum temper. (F):” label. A few packets use these first 20 characters to specify a keyword
which identifies the type of data file. For example, the /RUNFILES/ packet identifies the output
message file with the keyword ‘Message’.

One convenient aspect resulting from the use of a packet input structure is that packets can
appear in any order in an option file. Furthermore, any type of notes or descriptions that aid in
describing the packet can be placed between the individual packets. When executed, the core
model searches for packet identifiers and reads the data between the identifier and the packet
terminator. All other lines in the file are ignored. The file, template.opt, provided with the
NONROAD model contains a complete description of each packet including format
requirements.

INPUT DATA PACKETS AND DATA FILES

As indicated above, all data input packets with the exception of that containing source category
data and deterioration factor files are required for the model to estimate emissions from nonroad
sources. In many of these packets, data are supplied in a series of input data files. In other
packets, information relevant to any scenario you are interested in modeling is supplied through
user-specified options.

Note: To assist in better understanding the format of information in data files, it is suggested
that you open each data file through a text editor as you read the information in this
chapter. The data files are in a subdirectory called Data under the Nonroad directory.
Each of the data files provided with the NONROAD model follows the ‘packet’ structure
of the input option file. All files contain descriptive information including format
specifications.
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Review of Previously Described Packets

Some of the NONROAD model input packets from the options file have already been discussed
in Chapters 3 and 4. They are briefly reviewed here for completeness. Please refer to the
previous chapters for a more complete discussion of the /OPTIONS/, /REGIONS/, /PERIOD/,
and /SOURCE CATEGORY/ packets.

The /OPTIONS/ packet defines several of the user-specified options that make up a modeling
scenario. /OPTIONS/ include descriptive titles, fuel specifications that will be in effect during
the modeling period, and typical ambient temperatures for the period. The order of the records in
this packet are fixed.

The period packet, identified as /PERIOD/, defines the period of time that you are interested in
modeling. The order of the records in this packet are fixed. Furthermore, the selection of certain
parameters will cause some of the records in /PERIOD/ to be ignored.

The /REGION/ packet, defines the region that you are interested in modeling. Regions are
defined using two types of parameters. The first specifies the type of region and the second the
region codes to be included.

The source category packet, identified as /SOURCE CATEGORY/, is used to identify which
source categories are to be processed. This is an optional packet; if you do not specify a list of
SCC codes, the model will calculate emissions estimates based on all equipment in the
population files.

Runfiles Packet

The runfiles packet, identified as /RUNFILES/, defines input data file types required by the
model and output files created (see previously referenced Figure 6-1). These data file types
contain information that is universal to all regions and emissions species. Each file type is
identified by a keyword(s) which appears in columns 1 to 20 of the /RUNFILES/ packet. The
names for these file types may appear in any order within the packet but each must be preceded
by a valid keyword.

Keywords Input | Output | Required Description
ACTIVITY v v Defines equipment use per year
ALLOC XREF v v Allocation indicator lookup table
REGIONS v v Geographic region definitions
SEASONALITY v v Temporal adjustment data
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Keywords Input | Output | Required Description

EXH TECHNOLOGY v v Exhaust & crankcase technology
distributions

EVP TECHNOLOGY v v Evaporative technology distributions
MESSAGE v v Output message file

OUTPUT DATA v v Emission estimates (for RU)

EPS2 AMS v Emission estimates (EPS2 format)
US COUNTIES FIPS v County list with FIPS codes

Each of the input data files contained in the /RUNFILES/ packet, along with their format, are
described below.

ACTIVITY

The file identified by the keyword ACTIVITY, contains the activity data for the core
model. Activity.dat is the data file provided with the NONROAD model and these
default values are described in the EPA documentation report NR-005c¢. The activity is
defined as how often a piece of equipment is used in a year. This file also contains other
information about the equipment, such as average load factor. Global SCC codes can be
used to indicate entire groups of equipment types. A sample of the text of the activity file
shown is shown below to illustrate the look of the input file.

—————————————————————————————————————————— Region HPmn HPmx LFac NoUse Units Hours/Yr AgeAd]j
/ACTIVITY/

2260002006 2-Stroke Tampers/Rammers 0 9999 0.55 Hrs/Yr 160 DEFAULT
2260002009 2-Stroke Plate Compactors 0 9999 0.55 Hrs/Yr 166 DEFAULT

The load factor (“LFac”) and annual usage (“Hours/Yr) are both directly used to calculate the
exhaust emissions.

In addition to providing the input data by SCC, they can be specified by region and power level.
The default NONROAD files use the same estimates for all regions and power levels.

If alternative data exists, it can be used either by modifying the entire file or including separate
estimates in the same file as the default national estimates using the Region Code, which is a
code defined in the temporal allocation file (“season.dat”).

The activity can be a function of the power level for a given piece of equipment. For instance, a
survey method produced alternative annual activity (“Hours/Yr”) for large (>25 hp) diesel
construction equipment for Houston, so the alternative activity can be used along with the default
information for the smaller equipment as shown in the example below.
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—————————————————————————————————————————— Region HPmn HPmx LFac NoUse Units Hours/Yr AgeAdj
/ACTIVITY/

2270002003 Diesel Pavers 0 9999 0.59 Hrs/Yr 821 DEFAULT
2270002003 Diesel Pavers SW 0 25 0.59 Hrs/Yr 821 DEFAULT
2270002003 Diesel Pavers SW 25 9999 0.59 Hrs/Yr 719 DEFAULT

The exhaust emissions estimates are directly related to the load factor and activity (hours/year),
so a change in those inputs will proportionately affect the emissions calculated. Also, because the
load factor and activity (hours/year) are used to determine the life of the equipment in years, the
age distribution is affected by modifying these estimates. For instance, if activity and load factor
are reduced, then the equipment will be expected to last longer in years, so the age distribution
shifts to older equipment.

The format for this data is as follows:

Packet Identifier: /ACTIVITY/

Column Description
Line: 1-10 Equipment code (SCC)
12-51 Equipment description (not used)
52 - 56 Region code (refer to description of
REGIONS section below)
57 - 76 (not used. was technology type)
77 -81 Minimum horsepower
82 - 86 Maximum horsepower
87-91 Load factor
92 - 96 (not used)
97 - 106 Activity level units (Hrs/Yr)
107 - 116 Activity level
117 - 126 Identifier for age adjustment curve
(DEFAUL T=no adjustment)

Warning: The EPA does not recommend changing the activity files. This is because the
activity, equipment population, load factor, and average life are all linked and changes
can have surprising results. For details, see EPA’s technical documents or talk to

EPA nonroad modeling staff.

ALLOC XREF

The file identified by the keyword ALLOC XREF is the allocation indicator lookup table
used by the core model. Allocate.xrf is the data file provided with the NONROAD
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model. These data are used to allocate equipment type populations from one regional
level to another. For each SCC in the file, the code is cross referenced to a list of
indicator codes and their associated coefficients. The model will retrieve the indicator
data identified by the indicator codes and calculate a linear combination. Global SCC
codes can be used to indicate entire groups of equipment types.

To calculate the allocation factors, the model first calculates a linear combination of
allocation indicator values. The linear combinations are defined in this file. For instance,
if an SCC were discovered to be a function of two codes, then the indicator could be a
combination of the two codes (e.g., RVP and POP) as shown below for a given county,
and the calculation would be as follows. (This is a hypothetical example only and not an
accurate reflection of in-use allocation.)

Indicator = 0.6 * (County RVP)/(State RVP) + 0.4 * (County POP)/(State POP)
County equipment population = Indicator * State equipment population

In the example below, the allocate cross reference file was modified for recreational
vehicle use to reproduce the hypothetical example above.

Current Version

/ALLOC XREF/
2260001000 1.0
2260001000 RVP

/ALLOC XREF/
2260001000 0.6 0.4
2260001000 RVP POP

The indicator codes are arbitrary. The codes in this file are:
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AIR
MIN
CON

FRM
GC
COM
HOU
LOG
LSC
MFG
OIL

POP
RVP
SBC
SBR
SNM
WIB
WOB

RR

Number of employees in air transportation
Underground coal production tons

Dollars spent on construction adjusted for the relative
geographic costs of construction materials
Harvested cropland

Number of golf courses and country clubs

Number of wholesale establishments

Number of single and double (duplex) family homes
Number of employees in logging

Number of employees in landscaping services
Number of employees in manufacturing

Number of employees in oil & gas extraction, and
drilling oil & gas wells

Human population

Number of recreational vehicle parks and campgrounds
Relative number of commercial snowblowers
Relative number of residential snowblowers
Snowmobiles: State-level registration, snowfall and
inverse human population for county level
Recreational marine state fuel consumption, county
water surface area - Inboard

Recreational marine state fuel consumption, county
water surface area - Outboard

Locomotive NOX - allocates rail maintenance
equipment

The format for this data is as follows:

Packet Identifier: /ALLOC XREF/

Column Description
Linel: 1-10 Equipment code (SCC)
11-20 Coefficient for indicator 1
21-30 Coefficient for indicator 2
31-40 Coefficient for indicator 3
Line2:1-10 Equipment code (must match the code in Line 1)
11-20 Indicator code of indicator 1
21-30 Indicator code of indicator 2
31-40 Indicator code of indicator 3
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Note: If you add additional indicator codes and factors to the allocate.xrf file, you must also add
corresponding data files. For example, if you add forest land as an allocation factor for
recreational vehicles, you must provide the model with data files on forest land per
county. Refer to the section Allocation Files Packet. Furthermore, the input option file

must list the appropriate data file names.

REGIONS

The file identified by the keyword REGIONS, defines the states/counties in each
geographic region. Season.dat is the data file provided with the NONROAD model.
The region packet within the season file associates the region definition with the FIPS
code for a State or County as shown in the example below. New regions can be defined
here, but inputs for the monthly allocation (described below) must be described for any
new region defined here.

/REGIONS/
SW Southwest 48000 Texas
us National 00000 Nation

Identification by the region code is arbitrary (SE for Southeast or SW for Southwest) but
the FIPS code must be a valid state or county FIPS code. If a state code is supplied, all
counties in that state are included in the indicated region, unless overridden by a county-
specific record.

Warning: Changing the region does not change altitude or temperatures, but it does change
which activity factor is applied and the allocation of activity throughout the year. If
you define a new region, you must add the new region to the season.dat file; and if

applying a region specific activity, you must also add it to the activity.dat file.

The format for this data is as follows:

Packet Identifier: /REGIONS/

Column Description
Line: 1-5 User-defined region code
6 - 45 Region description (not used)
46 - 50 State or county FIPS code
51-70 State or county name (not used)
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SEASONALITY

The file identified by the keyword SEASONALITY, contains the seasonality (temporal
adjustment data) used by the core model. Season.dat is the data file provided with the
NONROAD model. Two specific types of information are contained in this file, each
identified by a different packet keyword, other than the /REGIONS/ packet that may also
be in this file.

The first, identified by the packet identifier MONTHLY/, provides the monthly
adjustment factors used by the model to calculate the fraction of annual activity occurring
in the given month. When modeling a season, the factors from each month spanned by
the period are summed by the model. Seasons are defined as follows in the model:

Winter:  Jan/Feb/Dec
Spring:  Mar/Apr/May
Summer: Jun/Jul/Aug
Autumn: Sept/Oct/Nov

The second packet, identified as /DAILY/, provides the day-of-the-week adjustments.
The first of the two values on each line of this packet is the fraction of weekly activity in
a typical (average) weekday day. This represents activity occurring on any single day,
Monday - Friday. The second Daily value is the fraction of weekly activity occurring on
a typical single weekend day — Saturday or Sunday.

If no monthly or daily data for an equipment type is found in season.dat, a warning
message is written to the output message file and the model default values will be used
for temporal allocation. The default values represent an equal distribution of temporal
activity throughout each month of the year. If you change the monthly allocations, you
should check to make sure the allocations sum to one. Likewise, the weekend and
weekday allocations should sum to one for an entire week (i.e. 1 =5 x weekday fraction +
2 x weekend day fraction).

The format for the monthly data is as follows:
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Packet Identifier: /IMONTHLY/

Column Description

Line: 1-5 Subregion code (blank = match all)
7-16 SCC code (global codes are acceptable)
18-51 Equipment description (not used)
52 - 61 Fraction of annual activity in January
62 -71 Fraction of annual activity in February
72-81 Fraction of annual activity in March
82-91 Fraction of annual activity in April
92-101 Fraction of annual activity in May
102 - 111 Fraction of annual activity in June
112 - 121 Fraction of annual activity in July
122 - 131 Fraction of annual activity in August
132 - 141 Fraction of annual activity in September
142 - 151 Fraction of annual activity in October
152 - 161 Fraction of annual activity in November
162 -171 Fraction of annual activity in December

The format for the day-of-the-week data is as follows:

Packet Identifier: /DAILY/

Column Description
Line: 1-5 Subregion code (blank = match all)
7-16 SCC code (global codes are acceptable)
18-51 Equipment description (not used)
52 - 61 Fraction of weekly activity in typical weekday day
62-71 Fraction of weekly activity in typical weekend day
EXH TECHNOLOGY

The file identified by the keywords EXH TECHNOLOGY, defines the exhaust

technology type distributions for the core model. Tech-exh.dat is the default exhaust
technology data file provided with the NONROAD model. The technology types are

specified by SCC and horsepowe

entire groups of equipment types. Each data record in these files is separated into two

r range. Global SCC codes can be used to indicate

lines. The first line has the identification information and a list of up to 15 technology
types which make up the specified equipment population. The second line identifies the
year and the fraction of that year's sales in each technology type. Multiple second lines
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may be provided if data is available for different model years as shown in the example
below. From the “tech-exh.dat” input file (up to 15 tech types may be defined).

SCCodes HPminHPmax Techl Tech2 Tech3 Tech4 (more>)
Year Fract Fract Fract Fract
ITECH FRAC/

2270000000 7509999 Base TO T1 T2

1900 1.000 0.000 0.000 0.000
1988 0.000 1.000 0.000 0.000
2000 0.000 0.000 1.000 0.000
2006 0.000 0.000 0.200 0.800
2007 0.000 0.000 0.100 0.900
2013 0.000 0.000 0.000 1.000

The fractions of sales by technology type for each year should sum to 1. If the sum
differs from 1.0 by more than +/- 0.002 then the fractions are normalized and a warning
message is generated and displayed. The model will use the distribution beginning with
the specified model year, until a new distribution is provided.

The NONROAD model uses the tech types primarily to determine phase-in of emissions
standards. The tech type defines which zero-hour (brand new) exhaust emission factor
(derived from the emission factor files described below) and deterioration rate are used by
the model when processing each model year of each equipment type. In the example
above, diesel engines (SCC 227000000) of power levels between 750 and 9999
horsepower can potentially be one of 4 tech types (Base, TO, T1, T2). Older engines
(starting with the 1900 model year) were exclusively the ‘Base’ tech type while new
engines were produced with tech type ‘TO’ beginning with the 1988 model year. The first
emission standard, Tier 1 (tech type ‘T1’) for all diesel equipment types began with the
2000 model year. However, the Tier 2 standard is phased-in starting with the 2006 model
year where only 80% (0.800 entry) of the new engines are expected to be Tier 2 (tech type
“T2’) with the remainder still Tier 1.

The tech types in NONROAD have meanings that relate to the type of engine and which

emission standard applies to that engine. Other tech types may appear in the default input
files but have zero entries, so are not currently used. The representative tech types are as
follows:
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Descriptions for representative tech types.

Tech Type Description

G2H3 Gasoline 2-stroke handheld Class 3

G2H31 Gasoline 2-stroke handheld Class 3 meeting Phase 1 Standards

G2H3C1 Gasoline 2-stroke handheld Class 3 meeting Phase 1 Standards with a catalyst

G2H32 Gasoline 2-stroke handheld Class 3 meeting Phase 2 Standards

G2H3C2 Gasoline 2-stroke handheld Class 3 meeting Phase 2 Standards with a catalyst

G2H4 Gasoline 2-stroke handheld Class 4

G2H41 Gasoline 2-stroke handheld Class 4 meeting Phase 1 Standards

G2H4C1 Gasoline 2-stroke handheld Class 4 meeting Phase 1 Standards with a catalyst

G4H41 Gasoline 4-stroke handheld Class 4 meeting Phase 1 Standards

G2H42 Gasoline 2-stroke handheld Class 4 meeting Phase 2 Standards

G2H4C2 Gasoline 2-stroke handheld Class 4 meeting Phase 2 Standards with a catalyst

G4H42 Gasoline 4-stroke handheld Class 4 meeting Phase 2 Standards

G2H5 Gasoline 2-stroke handheld Class 5

G2H51 Gasoline 2-stroke handheld Class 5 meeting Phase 1 Standards

G2H5C1 Gasoline 2-stroke handheld Class 5 meeting Phase 1 Standards with a catalyst

G2H52 Gasoline 2-stroke handheld Class 5 meeting Phase 2 Standards

G2H5C2 Gasoline 2-stroke handheld Class 5 meeting Phase 2 Standards with a catalyst

G2N1 Gasoline 2-stroke nonhandheld Class 1

G4AN1S Gasoline 4-stroke nonhandheld Class 1 side-valve carburetor

G4N10 Gasoline 4-stroke nonhandheld Class 1 overhead-valve carburetor

G2N1 Gasoline 2-stroke nonhandheld Class 1

G4N1Ss1 Gasoline 4-stroke nonhandheld Class 1 side-valve carburetor meeting Phase 1 Standards

G4N101  Gasoline 4-stroke nonhandheld Class 1 overhead-valve carburetor meeting Phase 1 Standards

G4N1SC1 Gasoline 4-stroke nonhandheld Class 1 side-valve carburetor meeting Phase 1 Standards with a catalyst

G4N1S2 Gasoline 4-stroke nonhandheld Class 1 side-valve carburetor meeting Phase 2 Standards

G4N102  Gasoline 4-stroke nonhandheld Class 1 overhead-valve carburetor meeting Phase 2 Standards

G2N2 Gasoline 2-stroke nonhandheld Class 2

G4AN2S Gasoline 4-stroke nonhandheld Class 2 side-valve carburetor

G4N20 Gasoline 4-stroke nonhandheld Class 2 overhead-valve carburetor

G4N2S1 Gasoline 4-stroke nonhandheld Class 2 side-valve carburetor meeting Phase 1 Standards

G4N201  Gasoline 4-stroke nonhandheld Class 2 overhead-valve carburetor meeting Phase 1 Standards

G4N2S2 Gasoline 4-stroke nonhandheld Class 2 side-valve carburetor meeting Phase 2 Standards

G4N202  Gasoline 4-stroke nonhandheld Class 2 overhead-valve carburetor meeting Phase 2 Standards

G2GT25  Gasoline 2-stroke greater than 25 horsepower

G4GT25  Gasoline 4-stroke greater than 25 horsepower

GAGT251  Gasoline 4-stroke greater than 25 horsepower meeting Tier 1 Standards

G4AGT252  Gasoline 4-stroke greater than 25 horsepower meeting Tier 2 Standards

R12S Gasoline Recreational 2-stroke

* R12SP Gasoline Recreational 2-stroke ("P" = Pump Fueled, unused as a separate tech type)

R12S1 Gasoline Recreational 2-stroke meeting Tier 1 Standards

R12S1P Gasoline Recreational 2-stroke meeting Tier 1 Standards ("P" = Pump Fueled, unused as a separate tech
type)

R12S2 Gasoline Recreational 2-stroke meeting Tier 2 Standards

*R12S2P  Gasoline Recreational 2-stroke meeting Tier 2 Standards ("P" = Pump Fueled, unused as a separate tech
type)

R14S Gasoline Recreational 4-stroke

* R14SP Gasoline Recreational 4-stroke ("P" = Pump Fueled, unused as a separate tech type)

R14S1 Gasoline Recreational 4-stroke meeting Tier 1 Standards
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Tech Type Description

*R14S1P  Gasoline Recreational 4-stroke meeting Tier 1 Standards ("P" = Pump Fueled, unused as a separate tech
type)

R14S2 Gasoline Recreational 4-stroke meeting Tier 2 Standards

*R14S2P  Gasoline Recreational 4-stroke meeting Tier 2 Standards ("P" = Pump Fueled, unused as a separate tech
type)

*R14S2C  Gasoline Recreational 4-stroke meeting Tier 2 Standards ("C" = Catalyst, unused as a separate tech type)

* R14S2CP Gasoline Recreational 4-stroke meeting Tier 2 Standards ("C" = Catalyst, "P" = Pump Fueled, unused
as a separate tech type)

LGT25 LPG greater than 25 horsepower

LGT251 LPG greater than 25 horsepower meeting Tier 1 Standards

LGT252 LPG greater than 25 horsepower meeting Tier 2 Standards

NGT25 CNG greater than 25 horsepower

NGT251 CNG greater than 25 horsepower meeting Tier 1 Standards

NGT252 CNG greater than 25 horsepower meeting Tier 2 Standards

Base Early (pre-1988) uncontrolled diesel engines

TO Late model (1988+) uncontrolled diesel engines

Tl Diesel engine meeting Tier 1 Standards

T2 Diesel engine meeting Tier 2 Standards

T3 Diesel land-based engine meeting Tier 3 Standards

T3B Diesel land-based engine meeting Tier 3 Standards for 75-100 hp engines

T4A Diesel land-based engine meeting transitional Tier 4 Standards for engines under 50 hp

T4B Diesel land-based engine meeting transitional Tier 4 Standards for engines under 25 hp

T4 Diesel land-based engine meeting full Tier 4 PM Standards

*T4AN1 Unused

T4N Diesel land-based engine meeting full Tier 4 PM & NOx Standards

T2M Diesel recreational marine engine meeting "Tier 2" Standards for over 50 hp engines

MO2C 2-stroke gasoline Outboard Carbureted

MO2I 2-stroke gasoline Outboard with Indirect injection

MO2D 2-stroke gasoline Outboard with Direct injection

MO4C 4-stroke gasoline Outboard Carbureted

MO4I 4-stroke gasoline Outboard with Indirect injection

MO4D 4-stroke gasoline Outboard with Direct injection

MP2C 2-stroke gasoline Personal Watercraft Carbureted

MP2I 2-stroke gasoline Personal Watercraft with Indirect injection

MP2D 2-stroke gasoline Personal Watercraft with Direct injection

MP4C 4-stroke gasoline Personal Watercraft Carbureted

MP4lI 4-stroke gasoline Personal Watercraft with Indirect injection

MP4D 4-stroke gasoline Personal Watercraft with Direct injection

MS4C 4-stroke gasoline Sterndrive/Inboard Carbureted

MS4D 4-stroke gasoline Sterndrive/Inboard with Direct Injection

* These technology types are not currently used in NONROAD, but exist in various input files
for certain diagnostic/developmental tests that have been done.

New tech types may be defined for any SCC as long as the emission factors and
deterioration rates are also provided for those new tech types. In many cases above, EPA
has estimated what tech type of engines will be used for future year standards so the tech
type descriptions and relative sales fractions may change as manufacturers introduce
engines meeting the emission standards.
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Note: Proposed regulations are estimated to reduce the number of 2-stroke engines sold in the
future in favor of 4-stroke engines. Therefore, spark ignition engines less than or equal
to 25 horsepower are lumped into one SCC category, eliminating the SCC distinction

between 2- and 4-stroke gasoline, LPG, and CNG engines.

The format for the data in this file is as follows:

Packet Identifier: /TECH FRAC/

Column Description
Linel: 6-15 SCC code (globals can be used)
21-25 Minimum horsepower range
26 - 30 Maximum horsepower range
35-? List of tech type codes (each in field of 10
characters)
Line2+: 1-5 Model Year
35-? Fractions of each tech type (each in field of 10
characters)

Warning: The technology type data are generally used with the emission factor data to model
changes in control strategies. While users may wish to change the technology type
data to experiment with various phase-in strategies, they should use the default

values for official submittals to EPA.

EVP TECHNOLOGY

The file identified by the keywords EVAP TECHNOLOGY, defines the evaporative
technology type distributions for the core model. Tech-evp.dat is the evaporative
technology data file provided with the NONROAD model. The technology types are
specified by SCC and horsepower range. Global SCC codes can be used to indicate
entire groups of equipment types. The data in these files is separated into two lines. The
first line has the identification information and a list of up to 15 technology types which
make up the specified equipment population. The second line identifies the year and the
fraction of population in each technology type. Multiple second lines may be provided if
data is available for different years as shown in the example below. From the “tech-
evp.dat” input file (up to 15 tech types may be defined).

EPA NONROAD Emissions Model User’s Guide 6-16



December 2005

Year

/TECH FRAC/

SCCodes HPminHPmax Techl Tech2 Tech3 Tech4 (more>)
Fract Fract Fract Fract
2260000000 25 9999 E0O0000000 E0O0010000 E10010010
1.000 0.000 0.000
0.000 1.000 0.000
0.000 0.000 1.000

The fractions of sales by technology type for each model year should sum to 1. If the sum
differs from 1.0 by more than +/- 0.002 then the fractions are normalized and a warning
message is generated and displayed. The model will use the distribution beginning with
the specified model year, until a new distribution is provided.

The NONROAD model uses the tech types primarily to determine phase-in of emissions
standards. The tech type defines which zero-hour (brand new) evaporative emission factor
(derived from the emission factor files described below) and which evaporative
deterioration rate are used by the model when processing each model year of each
equipment type. In the example above, 2-stroke gasoline engines (SCC 2260000000),
except rail and marine, of power levels between 25 and 9999 horsepower can potentially
be one of 3 tech types (E00000000, E00010000, E10010010). Older engines (starting
with the 1900 model year) were exclusively the “E00000000’ tech type while new engines
were produced with tech type ‘E00010000’ beginning with the 2004 model year, and type
‘E10010010’ beginning with the 2007 model year.

Evaporative tech type codes are different than exhaust tech type codes. Each digit in the
evaporative tech type code represents a different species of emission, and the value of the
digit represents the control level for that species within the tech type.

Key to Tech Group

Char/Digit _Description

O~NO A WNPRFM

Evap Tech Group

Diurnal

Tank Permeation

Hose Permeation (applies to non-rec-marine hose and 3 rec-marine hoses)
Hot Soak

Refueling Vapor Displacement

Refueling Spillage

Running Loss

(unused)

12345678
E0000000O
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Key to Tech Group Values

Value Description

0 Base

1 Control Level 1

2 Control Level 2

N Control Level N (maximum 9)

New tech types may be defined for any SCC as long as the emission factors and
deterioration rates are also provided for those new tech types. In many cases above, EPA
has estimated how much of each evaporative tech type will be used for future year
standards, so the tech type descriptions and relative sales fractions may change as
manufacturers introduce engines meeting the emission standards.

The format for the data in this file is as follows:

Packet Identifier: /EVAP TECH FRAC/

Column Description
Line1: 6-15 SCC code (globals can be used)
21-25 Minimum horsepower range
26 - 30 Maximum horsepower range

35-? List of tech type codes (each in field of 10
characters)
Line2+: 1-5 Model Year
35-? Fractions of each tech type (each in field of 10
characters)

US COUNTIES FIPS

The file entered here (default is fips.dat) contains a list of counties available to the model,
including the five digit FIPS code, an optional start year, an optional end year, and the
county name. Start and end years are only for counties that either come into existence
(e.g., by splitting one county into two separate counties) or cease to exist (e.g., an urban
area that had been treated separately from its surrounding county, changing its municipal
designation to be treated as part of that county.

The format for the data in this file is as follows:
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Packet Identifier: /FIPS/

Column Description
1-5 FIPS code (all individual 5-digit county codes)
6 (blank, unused)
7-10 Start year (4-digit. Blank means all past years)
11 (blank, unused)
12-15 End year (4-digit. Blank means all future years)
16 (blank, unused)
17 - 66 County name

Population Files Packet

The population files packet, identified as /POP FILES/, lists all of the files containing equipment
population data. The data in these files ultimately determines which equipment types will be
processed in the core model. If population estimates for a given equipment type are included in
any of these files, and you do not exclude the equipment from processing by user-specified
options (i.e., with the /SOURCE CATEGORY/ packet in the option file), the model will use all
of these population estimates to calculate emissions. The entire equipment population file will
be processed and estimated emissions written to the output data file, unless you specify a subset
of equipment types.

For convenience and ease of data management, the population data have been disaggregated into
separate files by state and a file for national totals. The /POP FILES/ packet in an option file was
shown earlier in Figure 6-1.

The *.pop files, one for each state, contain the equipment population estimates for the
NONROAD model. The “*” refers to the two character state abbreviation (us for the national
total file). These data drive the rest of the model in terms of which equipment types will be
processed. If multiple years of population are provided, the model uses the closest year which
comes before the episode year. The model's growth function is used to grow this base year
equipment population to the episode year. Population estimates for an entire state may be
allocated to county level (refer to the Allocation Files Packet section below). The sum of all
county equipment populations within a state is equal to the state population value.

The input data are defined by the region (“FIPS” defining State or County) and year in which the
estimates are valid (“Year”), SCC, and by power level grouping (“HPmin” and “Hpmax”).
Subregion codes (“SUBR”)can be used to provide inputs for partial counties.
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The horsepower range (HP) is lower bound exclusive and upper bound inclusive. For example, a
range identified by a minimum HP of 3 and a maximum HP of 6 is the range 3 < HP < 6.
The acceptable ranges are:

Otol 2510 40 300 to 600

1to3 40t0 50 600 to 750

3to6 50to 75 750 to 1000

6to 11 75 to 100 1000 to 1200

11to 16 100 to 175 1200 to 2000

16 to 25 175 to 300 2000 to 3000
Greater than 3000

The average of the horsepower range is used frequently in NONROAD model calculations. The
option to specify a single weighted average horsepower is provided in the population file format.
If the weighted average horsepower field is blank then the midpoint is computed from the
specified range.

Note: To account for the shift that has been occurring from 2-stroke to 4-stroke spark ignition
engines, while maintaining a single growth rate for a given type of equipment, spark
ignition engines have been grouped into single SCCs with 2-stroke, 4-stroke, CNG and
LPG engines in separate technology groups. Therefore, some SCCs are missing from the
population file while others have the combined populations for all spark ignition engines.

When modifying the equipment populations with local information, usually available is the total
population of the equipment type, or populations within a power range. The NONROAD model
needs the equipment population distributed by power level, so the revised information must be
mapped into each power level range. The most widely used method for this mapping procedure is
to distribute the revised population according to the default national distribution by power level
range.

EPA has designed an Excel spreadsheet that allows manipulation of the population files allowing
the user to save a text file that can be used in NONROAD. With the Excel file, a column of data
can replace the default data more easily than using a text editor. This file makes the redistribution
method described above straight-forward.

The population file also provides the median life estimates (“Life”) and directs the model to the
type of scrappage function (“ScrapFlag”) to determine the age distribution for each SCC and
power level grouping. The scrappage function is defined in the growth file (named
“Nation.grw”).
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A change in the “Life” estimate will proportionally affect the median life in years. If the median
life in years is known, then the life in hours at full load needs to be modified and can be
calculated using the equation below.

Median Life (hours at full load) = Median life (years) * (A * LF)

where
LF = Load Factor (fraction of available power) (from Activity File)
A = Activity (hrs/yr) (from Activity File)
Median Life = Median life in hours at full load (from Population File)

The median life in years is not the same value as the average age of equipment in use. The
median life is the typical age when the engine is scrapped, while the average age of equipment
in-use depends upon the historic sales and the rate of scrappage. Typically the average age of
equipment in-use is lower than the median life of the equipment.

The format for this data is as follows:

Packet Identifier: /POPULATION/

Column Description
1-5 FIPS code
7-11 Subregion code (used for subcounty estimates)
13-16 Year of population estimates

18 - 27 SCC code (no globals accepted)
29 - 68 Equipment description (ignored)

70-74 Minimum horsepower (lower bound of single range;
ranges must match those internal to the model)
76 - 80 Maximum horsepower (upper bound of single range)

82 - 86 Weighted average horsepower (optional)
88 - 92 Median expected life (in hours of use at full load)

93-102 Flag for scrappage distribution curve (DEFAULT =
standard curve)

106 - 122 | Population estimate
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Warning: EPA does not recommend changing the equipment population files without making
other corresponding input changes. This is because the activity, equipment
population, load factor, and average life are all linked, and incomplete changes can

lead to inconsistent results. For details, see EPA’s technical documents or talk to

EPA nonroad modeling staff.

Growth Files Packet

The growth files packet, identified as /GROWTH FILES/, lists the names of all of the files
containing future year projection or backcasting data (see previously referenced Figure 6-1). The
growth data provided with the NONROAD model is in a single file called “nation.grw” and is
separated into data packets. Similar to population files, growth data can be placed in separate
files, such as by state or county, to simplify data management.

The packets that make up the growth files are:

Packet Identifier Required Description

/INDICATORS/ v Cross reference between SCC and growth
indicator code.

/IGROWTHY/ v Growth values by FIPS, indicator code, and
year.

ISCRAPPAGE/ v Default scrappage curve used for model year
distribution calculations.

/ALTERNATE SCRAPPAGE/ Alternate scrappage curve.

rNote: For more information concerning how NONROAD handles growth and scrappage,
consult Technical Reports NR-007b and NR-008c.

The /INDICATORS/ packet, provides a cross reference of equipment code (SCC) to growth
indicator. The indicator code is an arbitrary code that can identify an actual predicted value such
as human population or employment. The indicator codes may be defined by SCC (or SCC
grouping following the hierarchy), power level range, and technology type. However the default
values in the model only define codes applicable to all power and technology types for each
general category (construction, lawn and garden, etc.) as described in EPA’s NONROAD
documentation report NR-008c. Below is a sample of lines from the /INDICATORS/ packet.
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FIPS Ind SCCodes HPminHPmax Tech
/INDICATORS/

00000 010 2267008000 0 9999 ALL
00000 010 2268008000 0 9999 ALL
00000 011 2270008000 0 9999 ALL

The indicator codes found in the nation.grw file are:

Description (not used)

LPG Airport Service Equipment
CNG Airport Service Equipment
Diesel Airport Service Egquipment

010 -- Airport Service - Total
011 -- Airport Service - Diesel
012 -- Airport Service - Gasoline
013 -- Airport Service - LPG
014 -- Airport Service - CNG
020 -- Construction- Total

021 -- Construction - Diesel

022 -- Construction - Gasoline
023 -- Construction - LPG

024 -- Construction - CNG

030 -- Farm - Total

031 -- Farm - Diesel

032 -- Farm - Gasoline

033 -- Farm - LPG

034 -- Farm - CNG

040 -- Industrial - Total

041 -- Industrial - Diesel

042 -- Industrial - Gasoline

043 -- Industrial - LPG

044 -- Industrial - CNG

050 -- Lawn & Garden -Total
051 -- Lawn & Garden - Diesel
052 -- Lawn & Garden - Gasoline
053 -- Lawn & Garden - LPG
054 -- Lawn & Garden - CNG
060 -- Light Commercial - Total
061 -- Light Commercial - Diesel
062 -- Light Commercial - Gasoline

063 -- Light Commercial - LPG

064 -- Light Commercial - CNG

070 -- Logging - Total

071 -- Logging - Diesel

072 -- Logging - Gasoline

073 -- Logging - LPG

074 -- Logging - CNG

080 -- Railway - Total

081 -- Railway - Diesel

082 -- Railway - Gasoline

083 -- Railway - LPG

084 -- Railway - CNG

090 -- Recreational - Total

091 -- Recreational - Diesel

092 -- Recreational - Gasoline

093 -- Recreational - LPG

094 -- Recreational - CNG

095 -- Recreational - 2sATV

096 -- Recreational - 4sATV

097 -- Recreational - Offroad MC

098 -- Recreational - Snowmobile

099 -- Rec Marine - PWC (backcast to ~zero in 1970;
=092 for 1996 and after)

100 -- Qil Field - Total

101 -- Qil Field - Diesel

102 -- Oil Field - Gasoline

103 -- Qil Field - LPG

104 -- Qil Field - CNG

The format for this data is as follows:
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Packet Identifier: /INDICATOR/

Column Description
1-5 State/county code (FIPS)
7-10 Indicator code (arbitrary alphanumeric code)
12-21 Equipment code (SCC)
23 - 27 Minimum HP of range
28 - 32 Maximum HP of range
34 -43 Technology type

The /IGROWTH/ packet contains the estimated values used to compute growth factors for each of
the indicator codes. The /GROWTHY/ data packet specifies an estimated value by state/county
code (FIPS), a growth indicator code, and year. The model will use the estimated values from
the year(s) closest to the base year (the year of the input equipment population estimate) and the
year(s) closest to the projection year (the specified growth year), interpolating as needed. It then
calculates an annual growth factor based on the increase in the estimated values. The growth
may be defined by State or County through the FIPS code. At least two years need to be
provided to indicate a growth rate, but more may be included to provide for a variable rate over
certain periods as shown in the example below.

FIPS SUBR Year Code Indicator Value
/GROWTH/

00000 1996 010 1000
00000 1996 011 1000
00000 2000 010 1240
00000 2000 011 1277
00000 2005 010 1553
00000 2005 011 1622

The data is easily modified by editing the text file. The growth rate is determined from the ratio
of indicator values in one year compared to another, so the choice of value for the base year
(1000 in the example above) is not restricted (except for zero). The indicator may be actual
estimates (e.g. number of employees) or any other kind of indicator as long as it is understood
that future years will be compared with the base year, so the units for the indicator must be
consistent.
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The resulting annual growth rate is applied to base year populations to obtain future-year
predictions (or prior year backcasting) of equipment populations. Global FIPS codes can be used
to provide estimated values for an entire state or even the entire country. The model will use the
most refined data; county-specific where it is available.

Caution: County-level growth inputs (if provided) are only used by the model when a specific
county is specified in the OPTions file. If a statewide county-level run is done, then
the statewide growth will be applied for every county, regardless of the county

specific growth inputs.

The format for this data is as follows:

Packet Identifier: /GROWTH/

Column Description
1-5 State/county code (FIPS)
6-10 Subregion code (blank = applies to all subregions
11-15 Year of estimate (4-digit year)
17-20 Indicator code (arbitrary alphanumeric code)
26 - 45 Estimated value

An additional packet that must appear in the growth files is the /'SCRAPPAGE/ packet. This
packet contains the definition of the default scrappage curve used for the model year distribution
calculations. All equipment types in which the scrappage flag in the population file is set to
DEFAULT will use this scrappage curve. The scrappage curve is the percentage of equipment
scrapped as a function of the fraction of useful life consumed. For example, the default
scrappage curve has 9 percent of equipment scrapped when the equipment has reached 45 percent
of its median expected life.

The format for this data is as follows:

Packet Identifier: /SCRAPPAGE/

Column Description
1-10 Fraction of median expected life already consumed
11-20 Percentage of equipment scrapped

An optional packet of the growth data file is the /ALTERNATE SCRAPPAGE/ packet. This
optional packet can be used to define scrappage curves that are used in place of the default
scrappage curve for selected equipment types. To apply the /ALTERNATE SCRAPPAGE/
curve to an equipment type, you must first modify the records of the population file for the
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selected equipment type by changing the scrappage flag from DEFAULT to some user-defined
name. The name can be any alpha-numeric string up to 10 characters in length (e.g., “chain saw”
or “motorcycle”). The next step is the creation of the /ALTERNATE SCRAPPAGE/ packet.
The packet is similar to the /SCRAPPAGE/ packet in form, but allows for multiple columns for
defining up to 10 alternate scrappage curves for various equipment groups. The first field is the
fraction of useful life consumed. The remaining columns, one for each alternate scrappage
curve, contain the percentage of units scrapped. Another significant difference between this
packet and the /SCRAPPAGE/ curve is that the first record is used to identify the name of the
scrappage curves. These names must match the name used to replace the DEFAULT value of the
scrappage flag in the population files. An example of an alternate scrappage curve is provided in
nation.grw. These data are not referenced in the NONROAD model population files, but simply
provided as an example of an alternate scrappage curve.

The format for this data is as follows:

Packet Identifier: /ALTERNATE SCRAPPAGE/

Column Description

Line 1: 1-10 not used
11-20 Name used to identify scrappage curve 1
21 -30 Name used to identify scrappage curve 2
x1-x0 up to 10 curves

Line 2+: 1-10 Fraction of median expected life already consumed
11-20 Percentage of equipment scrapped in scrappage curve 1
21 -30 Percentage of equipment scrapped in scrappage curve 2
x1 - x0 up to 10 curves

Allocation Files Packet

A list of spatial allocation files used by the core model is contained in the packet identified as
/ALLOC FILES/. Specifically, the data in this packet is used to allocate from state-level
equipment populations to county-level equipment populations. It could also be used to allocate
national-level equipment populations to state-level. Alternatively, you can include additional
data to allocate from county-level to subcounty-level ( an example of subcounty allocation
follows the description of the allocation file data format).

As seen in Figure 6-2, the /ALLOC FILES/ packet contains numerous data files; one for each of
the indicators found in the allocate.xrf file. Similar to the population files found in the /POP
FILES/ packet, the spatial allocation data files have been segregated into separate files by state
and by indicator type for convenience and ease of data management. The first 20 characters of
each line are ignored and contain a description of the file. These files contain surrogate
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indicators used by the model for allocating equipment populations from a larger region type to a

smaller region type (e.g., national-level to state-level or state-level to county-level).

Values for each indicator code are supplied both for the state total and for each county to
facilitate the calculation of allocation fractions for the state equipment population. Below is a

sample of the indicator values for one of the codes.

Column Format
1-3 Indicator code

6-10 FIPS code (can be global FIPS codes e.g.

11-15 Subregion code

21-40 Indicator wvalue

41+ optional description (unused)

/INDICATORS/

CON 48000 2003 45936058 TX

CON 48001 2003 37311 Anderson
CON 48003 2003 16290 Andrews

(blank means is entire nation,
16-20 Year of estimate or prediction

06000 = all of CA)
state or county)

/ALLOC FILES/
Air trans. empl.
Undergrnd coal prod:
Construction cost
Harvested acres
Golf course estab.
Wholesale estab.
Family housing
Logging employees
Landscaping empl.
Manufacturing empl.:
0il & gas employees:
Census population
RV Park establish.
Snowblowers comm.
Snowblowers res.
Snowmobiles

Rec marine inboard
Rec marine outboard:
Locomotive NOx
/END/

(T 0 T 0 T T @ T @ N T @ T @ Ho N0 T 0 To NN N 0 0 N0 N O 0}

This is the packet that defines the spatial
allocation files read by the model.

:\nonroad\data\allocate\tx airtr.alo
:\nonroad\data\allocate\tx coal.alo
:\nonroad\data\allocate\tx const.alo
:\nonroad\data\allocate\tx farms.alo
:\nonroad\data\allocate\tx golf.alo
:\nonroad\data\allocate\tx holsl.alo
:\nonroad\data\allocate\tx house.alo
:\nonroad\data\allocate\tx loggn.alo
:\nonroad\data\allocate\tx lscap.alo
:\nonroad\data\allocate\tx mnfg.alo
:\nonroad\data\allocate\tx oil.alo
:\nonroad\data\allocate\tx pop.alo
:\nonroad\data\allocate\tx rvprk.alo
:\nonroad\data\allocate\tx sbc.alo
:\nonroad\data\allocate\tx sbr.alo
:\nonroad\data\allocate\tx snowm.alo
:\nonroad\data\allocate\tx wib.alo
:\nonroad\data\allocate\tx wob.alo
:\nonroad\data\allocate\tx rail.alo

Figure 6-2: /ALLOC FILES/ packet.

The files provided with the NONROAD model are:
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Filename Indicator Description

* airtr.alo Number of employees in air transportation

* coal.alo Underground coal production tons

* const.alo Dollars spent on construction adjusted for the relative
geographic costs of construction materials

* farms.alo Harvested cropland

* golf.alo Number of golf courses and country clubs

* holsl.alo Number of wholesale establishments

* house.alo Number of single and double (duplex) family homes

* loggn.alo Number of employees in logging

* |scap.alo Number of employees in landscaping services

* mnfg.alo Number of employees in manufacturing

* oil.alo Number of employees in oil & gas extraction, and drilling
oil & gas wells

* pop.alo Human population

* rvprk.alo Number of recreational vehicle parks and campgrounds

* shc.alo Relative number of commercial snowblowers

* shr.alo Relative number of residential snowblowers

* snowm.alo Snowmobiles: State-level registration, snowfall and inverse
human population for county level

* wib.alo Recreational marine state fuel consumption, county water
surface area - Inboard

* wob.alo Recreational marine state fuel consumption, county water
surface area - Outboard

* rail.alo Locomotive NOXx - to allocate rail maintenance equipment

* Represents the two character state name abbreviation.
The format for these data is as follows:

Packet Identifier: /INDICATORS/

Column Description

1-3 Indicator code

6-10 FIPS code (can be global FIPS codes e.g. 06000 = all of CA)
11-15 Subregion code (blank means entire nation, state, or county)
16 - 20 Year of estimate or prediction
21-40 Indicator value
41 - 45 Blank (unused)

46 + Optional description (unused)
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Modifying Inputs for Subcounty Runs

The NONROAD model has the capability of estimating emissions at a subcounty level provided
that data for the subcounty level is supplied. To demonstrate how you can modify model inputs
to estimate emissions at a subcounty level, we will again use the example found in Chapters 3
and 4 with the following revision:

You have been given an assignment to estimate the total emissions from residential lawn
mowers with a horsepower range of 1 to 6 in the city of Austin, Texas for summertime,
1998.

In simple terms, the methodology that the model will use to calculate emissions from lawn
mowers with a horsepower range of 1 to 6 in Austin will be to first determine the number of lawn
mowers (1 to 6 HP range) in Travis County (where Austin resides) based on an allocation
indicator from the state-level to the county-level, and then in the Austin metropolitan area based
on an allocation indicator from the county-level to the subregion-level. The allocation indicator
that will be used for this example will be housing. Once the number of lawn mowers in Travis
County has been supplied (either through a separate model run or locally available data), the
model will then estimate the emissions from these sources in Austin (based on the ratio of the
allocation indicator value from county-level to subregion-level).

To modify the input files for this scenario, follow these steps:

1. Create a subregion code for the county which, together with the state/county code in
which the subcounty is contained, will be used to identify the data applied to the
subcounty. Since the Austin metropolitan area is within Travis County, Texas, a
region code could be identified as ‘48453Austn’ where 48453 is the FIPS code for
Travis County, Texas and “Austn’ is the subregion identifier for the Austin
metropolitan area. The subregion identifier can only be up to five characters in
length.

2. Estimate county-level equipment populations for each equipment type of interest.
The most straightforward method for determining this estimate is to have the
NONROAD model produce a county-level estimate using state-to-county allocation.
For our example, the model would be run with the regional inputs set to

Region level : COUNTY
FIPS code : 48453

and the /SOURCE CATEGORY/ packet modified to include Lawn and Garden
residential lawn mowers.
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res 2-stk mowers :2260004010
res 4-stk mowers :2265004010
res LPG mowers :2267004010
res CNG mowers :2268004010
res diesel mowers  :2270004010

Once the core model run is completed, use the reporting utility to generate a
Population and Fuel Consumption by HP and Source Classification report. This will
provide an estimate of the population of residential lawn mowers in Travis County.
Next, you must enter the county-level population data into the population files using
the FIPS code for the county where your subregion is located. For our example, the
population file for the state of Texas (nonroad\data\pop\TX.pop) would be modified
as shown in Figure 6-3 where:

48000 is the FIPS code for the state of Texas;

48453 is the FIPS code for Travis County;

1996 is the year of population estimates;

2265004010 is the SCC for 2-stroke residential lawn mowers (all engine types
have been lumped into this SCC);

1 and 3, and 3 and 6 are the minimum and maximum horsepower ranges,
respectively;

47.9 is the expected (median) life in number of hours at full load,;

DEFAULT is the flag for scrappage distribution curve with default representing
the standard curve; and

1737 (1<HP < 3) and 86314 (3<HP < 6) represent the population estimates.
2.55 and 4.1 are the average HP in the respective range (if blank model uses
midpoint)

48000
48000
48453
48453
48000
48000
48000
48000

1996... 1 3 255 479 DEFAULT 454428
1996... 3 6 41 479 DEFAULT 2258444.9
1996... 1 3 255 47.9 DEFAULT 1737.0
1996... 3 6 41 479 DEFAULT 86314.0
1996... 6 11 6.24 400 DEFAULT 744.6
1996... 1 3 255 268 DEFAULT 2165.3
1996... 3 6 41 268 DEFAULT 107612.6
1996... 6 11 6.24 400 DEFAULT 35.5

Figure 6-3: Modified TX.pop file with population estimates for 2-stroke residential lawn mowers in Travis
County (the SCC description, represented with three dots, has been removed from the display for
readability).

With the exception of the FIPS code and the population estimate fields, the additional
population county-level records will be identical to the corresponding state-level
population records.
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rNote: The county-level equipment populations can be defined in a file other than the (state
name).pop file. However, you must make sure that the name of this new file is listed in
the /POP FILES/ packet of the options file.

4. For each of the allocation indicators that are used, you must next estimate the value
of the indicator within the subcounty of interest. This value should be added to the

appropriate allocation file, using the county FIPS code and the subregion code as the
identifier.

For our example, the allocation indicator that we will use is housing of the Austin
metropolitan area which is estimated to be 112,970. To reflect this for our modeling
scenario, the /INDICATOR/ packet of the housing allocation file for the state of
Texas (nonroad\data\allocate\TX_house.alo) would be modified as shown in Figure

6-4.
HOU 48449 1997 7780  Titus County
HOU 48451 1997 30811 Tom Green County
HOU 48453 1997 191462 Travis County
HOU 48453Austn 1997 112970  Austin Metropolitan Area
HOU 48455 1997 4961  Trinity County
HOU 48457 1997 8420  Tyler County
HOU 48459 1997 10931  Upshur County
HOU 48461 1997 1470  Upton County
HOU 48463 1997 8261  Uvalde Coun

Figure 6-4: Modified TX_house.alo file showing housing of Austin.

5. Next, you must modify the /REGION/ packet of the options file to indicate a
subcounty run. Specify Subcounty for the region level and include the list of partial
counties by listing their FIPS code/subregion code pair. Figure 6-5 shows the
/IREGIONY/ packet modified for our example.
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The remaining records define the regions to be included.
The type of data which must be specified depends on the
region level.

US TOTAL - Nothing needs to be specified. The FIPS
code 00000 is used automatically.

S50STATE - Nothing needs to be specified. The FIPS
code 00000 is used automatically.

STATE - state FIPS codes

COUNTY - state or county FIPS codes. State FIPS
code means include all counties in the
state.

SUBCOUNTY - county FIPS code and subregion code.

/REGION/

Region Level : SUBCOUNTY

:48453Austn
/END/

Figure 6-5: Modified /REGION/ packet showing subcounty region.

rNote: Before running your subcounty modeling scenario, make sure that the /POP FILES/ and
/ALLOC FILES/ packets of the option file lists the file names of the data files containing
the newly created subcounty data.

6. Once you have completed steps 1 through 5 described above, create an options file
incorporating the modified packets that reflect the subregion data, save the file under
an appropriate name, and run the modeling scenario.

Emission Factors Files Packet

Simply put, emission factors are the rate at which emissions are produced for a particular
process. In the NONROAD model, the names of the emission factors files for a variety of
species and engine operating modes are contained in the packet identified as /EMFAC FILES/.
Similar to the /RUNFILES/ packet, each filename must be preceded by a keyword. The keyword
identifies the species or operating mode that is contained in the associated data file.
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Note: The EPA does not expect users to have local data on emission factors. If you know of a
study on emission factors that was not incorporated into the model inputs, please e-mail
the nonroad modeling team at nonroad@epa.gov

The valid species/modes (keywords) are as follow:

BSFC HOT SOAKS

THC EXHAUST RUNINGLOSS

CO EXHAUST TANK PERM

NOX EXHAUST NON-RM HOSE PERM
PM EXHAUST RM FILL NECK PERM
SPILLAGE RM SUPPLY/RETURN
DIURNAL RM VENT PERM
CRANKCASE

Note: SO, and CO, emissions are computed as a function of the BSFC factors and adjusted
exhaust hydrocarbons, therefore there is no emission factor file for these species. Vapor
displacement is computed as a function of fuel volume used, temperature, RVP, and
refueling mode (pump vs. container) so no emission factor file is required. Similarly, fuel
spillage is computed as a function of fuel volume used, tank size, and refueling mode.

As seen in Figure 6-6, these species/modes are contained in separate data files. The file names
can appear in any order in the packet and are identified by the keyword(s). If a species/mode is
not included in an option file, all data for that species/mode will be reported as missing. For
example, if there is no data file for PM emission factors, the PM field of the output data file will
contain all missing values. The exception is BSFC which is a required file.
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/EMFAC FILES/
BSFC

THC EXHAUST

CO EXHAUST

NOX EXHAUST

PM EXHAUST
SPILLAGE

DIURNAL

CRANKCASE

HOT SOAKS

RUNNING LOSS

TANK PERM

NON-RM HOSE PERM
RM FILL NECK PERM
RM SUPPLY/RETURN
RM VENT PERM
/END/

This is the packet that defines the emission factor
files read by the model.

:\nonroad\data\emsfac\bsfc.emf
:\nonroad\data\emsfac\exhthc.emf
:\nonroad\data\emsfac\exhco.emf
:\nonroad\data\emsfac\exhnox.emf
:\nonroad\data\emsfac\exhpm.emf
:\nonroad\data\emsfac\spillage.emf
:\nonroad\data\emsfac\evdiu.emf
:\nonroad\data\emsfac\crank.emf
:\nonroad\data\emsfac\evhotsk.emf
:\nonroad\data\emsfac\evrunls.emf
:\nonroad\data\emsfac\evtank.emf
:\nonroad\data\emsfac\evhose.emf
:\nonroad\data\emsfac\evneck.emf
:\nonroad\data\emsfac\evsupret .emf
:\nonroad\data\emsfac\evvent .emf

Q00000000000 aaanaan

Figure 6-6: [EMFAC FILES/ packet.

The spillage data file does not contain emission factors. It simply indicates if a source is a
gasoline pump or a portable container and provides the inputs for tank and hose materials and
dimensions. The equations for computing spillage and vapor displacement emissions differ for
portable containers and gasoline pumps. Therefore, if the spillage file is not included in the
option file then both spillage and vapor displacement emissions will be reported as missing.

Data Files in the /EMFAC FILES/ Packet

Data files provided with the NONROAD model include:

Filename Description

Bsfc.emf Brake specific fuel consumption factors

Crank.emf Emission factors data for crankcase emissions

Evdiu.emf Emission factors data for diurnal emissions

Evhose.emf Emission factors data for non-metal hose permeation THC for
non-rec-marine equipment

Evhotsk.emf Emission factors data for hot soak emissions

Evneck.emf Emission factors data for non-metal fill neck hose permeation THC for
rec-marine equipment

Evrunls.emf Emission factors data for running loss emissions

Evsupret.emf Emission factors data for non-metal supply/return hose permeation THC
for rec-marine equipment
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Filename Description

Evtank.emf Emission factors data for tank permeation THC

Evvent.emf Emission factors data for non-metal vent hose permeation THC for
rec-marine equipment

Exhco.emf Emission factors data for exhaust CO emissions

Exhnox.emf Emission factors data for exhaust NOx emissions

Exhpm.emf Emission factors data for exhaust PM emissions

Exhthc.emf Emission factors data for exhaust THC emissions

Spillage.emf Pump or container specification and tank sizes for gasoline equipment
types

The emission factors files provide the NONROAD model the zero-hour (brand new) engine
exhaust emissions rates and adjustments used to determine evaporative emissions. The emission
factors used in the model are described in EPA’s NONROAD documentation reports NR-009¢
for diesel and NR-010d for spark-ignition engines.

The exhaust emission factors files are adjusted for in-use emission rates within the NONROAD
model using the information provided by the deterioration input files. The emission factors are
defined by SCC, power level range, and tech type. The tech types must correspond to those
provided in the tech type files so that the sales fractions of the equipment are matched to an
emission factor.

Emission factor input file example (up to 10 tech types);

..........

2200000000 HpminHpmax techtyTl techtyT2 techtyT3 techtyp4 g/hp-hr NOx
1900 37.7 0 37.7 999.99
/EMSFAC/

2270002003 750 9999 Base TO T1 T2 g/hp-hr NOx
1900 10.058 8.296 5.568 3.936

The units of the emission factor and the type of pollutant modeled must be specified. All exhaust
emission factors currently are given in units of grams per horsepower-hour (g/hp-hr), but there is
an option to use grams per hour (g/hr) or grams per gallon (g/gallon) and the activity rates in the
activity file must be altered to match these units. The pollutants addressed by the exhaust
emission factor files may be THC, CO, NOx, or PM, and the file labeled BSFC.emf provides the
fuel consumption factors. (For the fuel consumption file no option is available for the units and
must be in units of pounds per horsepower-hour.) Crankcase emission factor inputs are just
multipliers that the model applies to the corresponding THC exhaust emissions.
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Note: An exception to the default input units is made for offroad motorcycles and ATVs.
Instead of g/hp-hr these emission factors are actually grams per mile, even though they
are listed as g/hp-hr. Corresponding deviations occur in the activity inputs (miles per
year instead of hours per year); load factor is set at 1.0 instead of an actual load factor;
and in the population file inputs the "Hp™ is set at 1.0, and the median life is actually

miles instead of hours at full load.

In calculating emissions using these files, the model will use the emission factor for the closest
year that is less than or equal to the current model year. The actual emission factors could have
been given specifically for the year in which they are valid, but EPA has chosen to incorporate
the phase-in of emission standards through the use of the tech types rather than in the emission
factor file because it is easier to incorporate phase-in and different deterioration rates using tech
types for new emission standards. In the example above, while the emission factor for Tier 2
diesel pavers is valid starting in the year 1900, the fraction of Tier 2 engines is nonzero only
when the technology type file shows the phase-in of this standard beginning with the 2006 model
year.

The diurnal emission factor input file supplies the NONROAD model with emission factor
multipliers. The core model contains coding to calculate uncontrolled diurnal vapor generation
based on input temperature swings (daily maximum minus minimum) and tank sizes. The
emission factor multipliers in the diurnal input file adjust those internally calcualted values to
account for thngs such as diffusion (vapor loss through an orifice at constant temperature),
decreased tank temperature swings in boat tanks due to water temperatures, and any emission
controls. Further details can be found in NONROAD technical report NR-012c, "Nonroad
Evaporateve Emission Rates.” The pollutant for diurnal emissions is, of course, THC but it still
must be specified.

2200000000 HPmn HPmx techtypl techtyp2... Units Pollutant
/EMSFAC/

2260000000 0 25 ALL Mult THC
1900 1.46

2260000000 25 9999 ALL Mult THC
1900 1.46

The format for the data in the BSFC and the emission factors files is as follows:
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Packet Identifier: /EMSFAC/

Column Description
Line 1: 6-15 | SCC code (globals can be used)
21 - 25 | Beginning of horsepower range
26 - 30 | End of horsepower range
35-44 | Technology type 1
x5 - x4 | Technology type 2 ... (repeating field)
X5 - x4 | Units
options: g/hr of equipment use
g/hp-hr of equipment use
g/gallon of fuel use
g/tank per day per gallon of tank volume
g/day per calendar day
mult

x5 - x4 | Pollutant
Line 2: 1-5 Year
35 - 44 | Emission factors for technology type 1
x5 - x4 [ Emission factors for technology type 2 ... (repeating)

rNote: The units field is ignored in the BSFC file; the units are Ibs of fuel/hp-hr. The units field
is 'MULT" in the crankcase and diurnal files where the emission factor is treated as a
multiplier.

The format for the data in the spillage data file is as follows:

Packet Identifier: /EMSFAC/

Column Description
Linel: 1-10 SCC code (globals can be used)
12 -51 Equipment name
54 - 62 Fill method (PUMP or CONTAINER)
64 - 67 Range indicator code (HP or TANK)
69 - 73 Beginning of horsepower range or tank volume range

74 -78 End of horsepower range or tank volume range (HP
ranges must match those internal to model)

79 - 88 Evaporative technology type
90 - 99 Units (GALLONS or GAL/HP)
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103 - 112 | Tank size estimate (either gallons or gal/hp)

113 -120 | Fraction of tank filled with fuel (for diurnal calcs)
121 - 130 | Tank metal fraction

131 - 140 | Non-rec-marine hose length (meters)

141 - 150 | Non-rec-marine hose diameter (meters)

151 - 160 | Non-rec-marine hose metal fraction

161 - 170 | Rec-marine fill neck hose length (meters)

171 -180 | Rec-marine fill neck hose diameter (meters)

181 - 190 | Rec-marine supply/return hose length (meters)
191 - 200 | Rec-marine supply/return hose diameter (meters)
201 - 210 | Rec-marine vent hose length (meters)

211 - 220 | Rec-marine vent hose diameter (meters)

221 - 230 | Hot soak starts per hour of operation

231 - 240 | Diurnal all non-rec marine/rec-marine portable plastic
(get 0.78 factor)

241 - 250 | Diurnal rec-marine installed plastic tank on trailer (get
50% temperature swing reduction)

251 - 260 | Diurnal rec-marine installed plastic tank in water (get
80% temperature swing reduction)

261 - 270 | Diurnal rec-marine installed metal tank on trailer (get
50% temperature swing reduction)

271 - 280 | Diurnal rec-marine installed metal tank in water (get
80% temperature swing reduction)

Deterioration Factors Files Packet

Generally speaking, as a piece of equipment or vehicle ages over time, the rate at which
pollutants are emitted increases. The data in the deterioration input files are used to adjust the
emission factors for in-use deterioration, and the data used in the default files is discussed in
EPA’s NONROAD documentation reports NR-009¢ and NR-011b. The names of the files which
contain the deterioration factors used by the core model to estimate this increase in emissions are
contained in a packet identified as /[ DETERIORATE FILES/ (Figure 6-7). Similar to the
/IEMFAC FILES/ packet, each filename must be preceded by a keyword. The valid
species/modes are the same as for the /EMFAC FILES/, with the exception that BSFC,
CRANKCASE, and SPILLAGE are not recognized.

EPA NONROAD Emissions Model User’s Guide 6-38



December 2005

This is the packet that defines the deterioration factors
files read by the model.

/DETERIORATE FILES/

NON-RM HOSE PERM
RM FILL NECK PERM
RM SUPPLY/RETURN
RM VENT PERM

/END/

:\nonroad\data\detfac\evhose.det
:\nonroad\data\detfac\evneck.det
:\nonroad\data\detfac\evsupret.det
:\nonroad\data\detfac\evvent.det

THC EXHAUST :c:\nonroad\data\detfac\exhthc.det
CO EXHAUST :c:\nonroad\data\detfac\exhco.det
NOX EXHAUST :c:\nonroad\data\detfac\exhnox.det
PM EXHAUST :c:\nonroad\data\detfac\exhpm.det
DIURNAL :c:\nonroad\data\detfac\evdiu.det
HOT SOAKS :c:\nonroad\data\detfac\evhotsk.det
RUNNING LOSS :c:\nonroad\data\detfac\evrunls.det
TANK PERM :c:\nonroad\data\detfac\evtank.det

8@

:c

:c

8@

Figure 6-7: IDETERIORATION FILES/ packet.

Note: The EPA does not expect users to have local data on deterioration factors. If you know of
a study on deterioration factors that was not incorporated into the model inputs, please e-
mail the nonroad modeling team at nonroad@epa.gov

Data Files in the /IDETERIORATE FILES/ Packet

The deterioration factors are specified by technology type. An “ALL” in the technology type
field indicates that the deterioration factors apply to all technology types. The values are actually
the coefficients of the deterioration equation

DF =1+ A x engine age®,
where A and b are provided in the file. The input file also provides a cap on the deterioration, to

prevent further deterioration past a certain relative age. A sample of the look and estimates in a
deterioration file is shown in the example below.
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Tech Type A coeff b coeff Age Cap Pollutant
/DETFAC/
Base 0.024 1.0 1.0 NOx
TO 0.024 1.0 1.0 NOx
T1 0.024 1.0 1.0 NOx
T2 0.009 1.0 1.0 NOx
T3 0.008 1.0 1.0 NOx
Data provided with the NONROAD model include:
Filename Description
Evdiu.det Deterioration factors data for diurnal emissions
Evhose.det Deterioration factors data for hose permeation for
non-rec-marine equipment
Evhotsk.det Deterioration factors data for hot soak emissions
Evneck.det Deterioration factors data for fill neck hose permeation for
rec-marine equipment
Evrunls.det Deterioration factors data for running loss emissions
Evsupret.det Deterioration factors data for supply/return hose permeation
for rec-marine equipment
Evtank.det Deterioration factors data for tank permeation
Evvent.det Deterioration factors data for vent hose permeation for
rec-marine equipment
Exhco.det Deterioration factors data for exhaust CO emissions
Exhnox.det Deterioration factors data for exhaust NOx emissions
Exhpm.det Deterioration factors data for exhaust PM emissions
Exhthc.det Deterioration factors data for exhaust THC emissions

The format for the data in deterioration factors files is as follows:
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Packet Identifier: /IDETFAC/

Column Description

1-10 Technology type

21 -30 A coefficient of equation

31-40 b coefficient of equation

41 -50 Emission Cap (in median life units)
51 -60 Pollutant

PM Base Sulfur Packet

The /PM BASE SULFUR/ packet contains diesel sulfur weight percents corresponding to the

input diesel PM emission factors for each diesel technology type. The default is 0.3300 (3300
ppm), but Tier 2 and later diesel emission factors are based on lower sulfur fuel. These values
are used by the model to adjust the calculated diesel PM emissions for in-use sulfur levels that
differ from these base sulfur levels. For the details of this adjustment refer to technical report

NR-009c, "Exhaust and Crankcase Emission Factors for Nonroad Engine Modeling --
Compression-Ignition.” As with the emission factor inputs, EPA does not expect users to have
local data, and users are not expected to change anything in this packet.

The format for this data is as follows:

Packet Identifier: /PM BASE SULFUR/

Column Description

1-10 Diesel technology type

11-20 [ Base sulfur wt percent; or '1.0' means no-adjustment
21 - 30 | Sulfate conversion rate

The default values contained in this packet are as follows:

T2
T3
T3B
T4A
T4B
T4
T4N

0.2000
0.2000
0.0500
0.0500
0.0015
0.0015
0.0015

/PM BASE SULFUR/

0.02247
0.02247
0.02247
0.02247
0.02247
0.30

0.30
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EDITING INPUT DATA PACKETS AND FILES

For an advanced user of the NONROAD model, the process of incorporating locally-derived data
into the core model is relatively straightforward. To make changes to the data files, simply use a
text editor such as Microsoft’s Notepad or WordPad, or the Edit command in DOS, to access the
data file. If a display font option is available, be sure to choose a mono-spaced font such as
courier to show the data in the proper columns. Once you have accessed the data file that you
want to change, type the revised data in the appropriate field. Once complete, save the modified
file under a new name to prevent the overwriting of default data.

rNote: When the NONROAD model is initially installed, all data files are in a subdirectory
called Data in the Nonroad directory.

There are two methods for indicating that you want to use new data files in an option file. The
first is through the Advanced Options menu in the graphical user interface which is described in
Chapter 3. The second is by modifying the appropriate packets in the option file through a text
editor.

MAKING MULTIPLE MODEL RUNS

Through a text editor or DOS, you can create a batch file that allows you to run the core model
with many different scenarios. This capability provides you with the flexibility of setting up and
running these scenarios when you have available computer time, such as in the evening. Figure
6-8 shows the batch file milg.bat (for Michigan lawn and garden run).

nonroad milg95.opt
nonroad milg96.opt

nonroad milg97.opt
nonroad milg98.opt

Figure 6-8: Batch file milg.bat.

A batch file can be easily created with a text editor. Open a text editor and simply type ““nonroad
(option file).opt™ on consecutive lines for each of the option files you want to run. Save the
batch file and close the editor. It is recommended that you name the file with a relevant name
and the extension .bat.

To run a batch file in DOS, type “(name of your batch file).bat”. From Windows 95 or above,
drag the mouse to the menu bar and Start » Run. Type the name of your batch file in the
dialog box and specify OK.

EPA NONROAD Emissions Model User’s Guide 6-42



December 2005

CALCULATION OF NONROAD RETROFIT INVENTORIES & BENEFITS

The recommended method to model the effects of nonroad engine retrofits is to use the National
Mobile Inventory Model (NMIM), since it can properly model a fleet specific retrofit program
where the exact number and model year of engines is known. However, some limited retrofit
modeling capability is now also available within NONROAD itself. This documentation refers
only to retrofit modeling within NONROAD.

There are two types of retrofit program calculations that are possible: (A) normal NONROAD
county or state fleetwide inventories, in which a specified fraction of certain categories of
engines (SCC and Hp range) are retrofitted, or (B) fleet specific inventories in which a specific
number of engines of a known fleet (SCC and Hp) are retrofitted. The specification of engine
categories in both cases includes SCC, Hp range, and optionally the Technology Type. For the
latter fleet specific calculation, NMIM should be used rather than NONROAD, since
NONROAD does not allow you to specify the model year; in this case NONROAD will simply
assign the same age distribution as in the fleetwide example. So if there is just one engine of a
given SCC and Hp in the fleet, its emissions would be calculated as if a small fraction of that
engine's emissions came from many different model years.

Retrofit Inputs

The user must create a retrofit input file containing the desired retrofit information. This is a
plain text file that includes the following parameters for each subset of engines being retrofitted
and each pollutant affected. These parameters must be entered in the columns specified — there
are no tabs or commas as delimiters. These data lines are preceded by a single line containing
the retrofit packet identifier "/RETROFIT/" (without quotes) and the line following the last data
line is the "/END/" end-of-packet identifier. Anything in the file outside of this packet is
ignored, and can be used for comments if desired.

The format of the data lines is as follows:

Column Type Description

1-4 integer Retrofit Year start (first calendar year when retrofits are done)
5 Blank

6-9 integer Retrofit Year end (last calendar year when retrofits are done)
10 Blank

11-14 | integer Model Year start (first model year that is receiving retrofit)
15 Blank

16 -19 | integer Model Year end (last model year that is receiving retrofit)
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20
21-30
31
32-41
42
43 - 47
48 - 52
31
54 -71

72
73-78
79
80 -89
90
91-95

96+

character
character

real
real

real

real
character

integer

Blank

SCC Code

Blank

Exhaust Technology Type (e.g., Base, TO, T1, T2, T2M or ALL)
Blank

Minimum HP (min < Hp <= max)

Maximum HP (min < Hp <= max)

Blank

Annual Fleetwide Retrofit Fraction (0.0 - 1.0),

or for fleet-specific case the actual Number Retrofitted (greater
than 1.0)

Blank

Retrofit Effectiveness. Range = 0.0 - 1.0 (zero is no benefit)
Blank

Exhaust Pollutant affected by retrofit (HC, CO, NOx, or PM)
Blank

Retrofit identifier (use same arbitrary number for different
pollutants being affected by same retrofit)

Optional description of the retrofit technology. Not read into
model.

The Technology Type does not need to be entered, but is available in case a user knows which
tech type within a mixed (phase-in) model year is appropriate for the retrofit. By default (i.e., if
the field is left blank, or if "ALL" is entered) NONROAD will apply the retrofit effects to the
entire model year inventory for that SCC, Hp bin, and model year (sum of all tech types for that

model year).

The retrofit data file can include equipment that is not included in the SCCs being modeled. Any
such retrofit specifications are simply ignored, since there is no equipment in the modeling run to
apply the retrofits to.

Example NONROAD Retrofit Data File

RYst RYen MYst MYen SCC

/RETROFIT/

2008 2009 1996
2008 2008 1991
2006 2007 1996

TechType HPmn HPmx AnnualRetroFracOrN Effect Pollutant RetID
1997 2270002000 ALL 50 300 0.05 0.50 PM 1
1996 2270002069 T1 175 600 0.06 0.15 NOx 1
1997 2270000000 ALL 25 75 0.05 0.80 PM 2
1997 2270000000 ALL 25 75 0.08 0.90 PM 3

2008 2008 1996
/END/
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This example is provided to only to help clarify the retrofit input format. For guidance on actual
program input development, the user should consult the EPA document "Guidance for
Quantifying and Using Emission Reductions from Mobile Source Retrofit Projects in State
Implementation Plans and Transportation and General Conformity."
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Chapter 7 Trouble Shooting

The NONROAD model does extensive validation of input data. Datainitialization includes
checking that each required input packet exists in the input option file and that the specified data
values are within acceptable ranges. If the model detects unreasonable data, an error message is
written and the program terminates. Specified data files must exist and include the necessary
data elements. The messages written by the model are generally sufficient in determining where
aproblem exists.

MESSAGE FILE

The output message file should be reviewed after each model run. An example of an output
message fileis shown in Figure 7-1.

Thisfile includes the NONROAD moddl title and version number, date and time of execution,
and asummary of each packet in the input option file. In addition, warning messages may be
seen informing you of possible problems. Consider the message, “WARNING: Cannot find
/IDETERIORATE FILES packet of the optionsfile. Factorsfor all specieswill be set to 1.0 (no
deterioration).” 'Y ou may determine that thisis acceptable to you for your application.
However, you may also want to review your data to determine if you can provide additional
information.

In general, warning messages allow the model to make generalizations and provide a default
action if adataitem is not found; thisincludes skipping some records. It isimportant to note that
although default action can occur it is meant to be the exception. Therefore, if the model issues
the same warning message more than 50 times it will terminate processing. This ensures that
lengthy runs will not process invalid data.
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15:40:56: 2005

**% Qutput

Exhaust By-Model-Yea:
Evap By-Model-Year f:

Options file
Allocation XREF file:
Activity file
State/Regions file
Seasonality file
Exh Tech fractions
Evap Tech fractions
US Counties FIPS
Retrofit file

options file.

options file.

options file.

BSFC file

THC EXHAUST file
CO EXHAUST file
NOX EXHAUST file
CO2 EXHAUST file
S02 EXHAUST file

EPA~s NONROAD Emissions Model,

Files ***

Output data file :c:\nonroad\outputs\travis.out

OUTPUTS/TEST . BMX
OUTPUTS/TEST . BMV

EIT Anajeibhe IPALILERE] S
:C: \NONROAD\TRAVIS.OPT
data/allocate/allocate.xrf
:data/activity/activity.dat
:data/season/season.dat
:data/season/season.dat
:data/tech/tech-exh.dat
:data/tech/tech-evp.dat
:data/allocate/fips.dat
*** population Files ***
:c:\nonroad\data\pop\tx.pop
(R IRl Il IpRLILEE] ks

Daily Temp/RVP file :DATA/DAILY/DAYTMPRV.DAT

WARNING: Cannot find TANK PERM filename in /EMFAC FILES/ packet of options file.
All factors for this species will be set to missing.

WARNING: Cannot find NON-RM HOSE PERM filename in /EMFAC FILES/ packet of
All factors for this species will be set to missing.

WARNING: Cannot find RM FILL NECK PERM filename in /EMFAC FILES/ packet of
All factors for this species will be set to missing.

WARNING: Cannot find RM SUPPLY/RETURN filename in /EMFAC FILES/ packet of

All factors for this species will be set to missing.

WARNING: Cannot find RM VENT PERM filename in /EMFAC FILES/ packet of options
file.

All factors for this species will be set to missing.
*** Emission Factors Files ***

:data/emsfac/bsfc.emf
:data/emsfac/exhthc.emf
:data/emsfac/exhco.emf
:data/emsfac/exhnox.emf

Not Supplied.
Not Supplied.

Core Model Ver 2005,
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PM EXHAUST file :data/emsfac/exhpm.emf
CRANKCASE file :data/emsfac/crank.emf
DIURNAL file :data/emsfac/evdiu.emf
TANK PERM file : Not Supplied.

NON-RM HOSE PERM fil: Not Supplied.
RM FILL NECK PERM fi: Not Supplied.
RM SUPPLY/RETURN fil: Not Supplied.

RM VENT PERM file : Not Supplied.
HOT SOAKS file : Not Supplied.
DISPLACEMENT file : Not Supplied.
SPILLAGE file :data/emsfac/spillage.emf
RUNINGLOSS file : Not Supplied.

*%* Deterioration Factors Files **%*

THC EXHAUST file :data/detfac/exhthc.det
CO EXHAUST file :data/detfac/exhco.det
NOX EXHAUST file :data/detfac/exhnox.det
CO2 EXHAUST file : Not Supplied.
SO2 EXHAUST file : Not Supplied.
PM EXHAUST file :data/detfac/exhpm.det
CRANKCASE file : Not Supplied.
DIURNAL file :data/detfac/evdiu.det
TANK PERM file : Not Supplied.

NON-RM HOSE PERM fil: Not Supplied.
RM FILL NECK PERM fi: Not Supplied.
RM SUPPLY/RETURN fil: Not Supplied.

RM VENT PERM file : Not Supplied.
HOT SOAKS file : Not Supplied.
DISPLACEMENT file : Not Supplied.
SPILLAGE file : Not Supplied.
RUNINGLOSS file : Not Supplied.

*** Spatial Allocation Files ***

Q0000000000000

:\nonroad\data\allocate\tx airtr.alo
:\nonroad\data\allocate\tx coal.alo
:\nonroad\data\allocate\tx const.alo
:\nonroad\data\allocate\tx farms.alo
:\nonroad\data\allocate\tx golf.alo
:\nonroad\data\allocate\tx holsl.
:\nonroad\data\allocate\tx house.
:\nonroad\data\allocate\tx loggn.
:\nonroad\data\allocate\tx lscap.
:\nonroad\data\allocate\tx mnfg.alo
:\nonroad\data\allocate\tx oil.alo
:\nonroad\data\allocate\tx pop.alo
:\nonroad\data\allocate\tx rvprk.alo
:\nonroad\data\allocate\tx sbc.alo
:\nonroad\data\allocate\tx sbr.alo
:\nonroad\data\allocate\tx snowm.alo
:\nonroad\data\allocate\tx wib.alo
:\nonroad\data\allocate\tx wob.alo
:\nonroad\data\allocate\tx rail.alo

alo
alo
alo
alo
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*%* Growth

Indicator Files ***

:DATA/GROWTH/nation.grw

*%* Scenario Specific Parameters ***

First Title line
Second Title line
Fuel RVP (psi)

Fuel Oxygen weight %:

o

Gasoline Sulfur %

o

Diesel Sulfur %

Marine Diesel Sulfur:

LPG/CNG Sulfur %
Minimum Temperature
Maximum Temperature

Average Ambient Temp:

Altitude of region

o

Stage II Control %
*%* Period

Year of Inventory
Inventory for

Emissions summed for:

Season
Year of Growth Calc
Year of Tech Sel

*** Region

Region level
Counties of Interest

:Lawn and Garden Equipment
:Travis County Summertime
8.00
0.00
0.0340
0.3300
0.3300
0.0030
0.00
84.00
75.00
: LOW

0.00

Parameters ***
:1998

: SEASONAL period
PERIOD TOTAL

: SUMMER

:1998

:1998

of Interest **%*

County-level estimates

:48453 - Travis County, Texas

*** Equipment Types ***

SCC codes Selected

:2260004010
:2260004011
:2260004015
:2260004016
:2260004020
:2260004021
:2260004025
:2260004026
:2260004030
:2260004031
:2260004035
:2260004036
:2260004040
:2260004041
:2260004045
:2260004046
:2260004050
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:2260004051
:2260004055
:2260004056
:2260004060
:2260004061
:2260004065
:2260004066
:2260004071
:2260004075
:2260004076
:2265004010
:2265004011
:2265004015
:2265004016
:2265004020
:2265004021
:2265004025
:2265004026
:2265004030
:2265004031
:2265004035
:2265004036
:2265004040
:2265004041
:2265004045
:2265004046
:2265004050
:2265004051
:2265004055
:2265004056
:2265004060
:2265004061
:2265004065
12265004066
:2265004071
:2265004075
:2265004076
:2267004010
:2267004011
:2267004015
:2267004016
:2267004020
:2267004021
:2267004025
:2267004026
:2267004030
:2267004031
:2267004035
:2267004036
:2267004040
:2267004041
:2267004045
:2267004046
:2267004050
:2267004051
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:2267004055
:2267004056
:2267004060
:2267004061
:2267004065
:2267004066
:2267004071
:2267004075
:2267004076
:2268004010
:2268004011
:2268004015
:2268004016
:2268004020
:2268004021
:2268004025
:2268004026
:2268004030
:2268004031
:2268004035
:2268004036
:2268004040
:2268004041
:2268004045
:2268004046
:2268004050
:2268004051
:2268004055
:2268004056
:2268004060
:2268004061
:2268004065
:2268004066
:2268004071
:2268004075
:2268004076
:2270004010
:2270004011
:2270004015
:2270004016
:2270004020
:2270004021
:2270004025
:2270004026
:2270004030
:2270004031
:2270004035
:2270004036
:2270004040
:2270004041
:2270004045
:2270004046
:2270004050
:2270004051
:2270004055
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:2270004056
:2270004060
:2270004061
:2270004065
:2270004066
:2270004071
:2270004075
:2270004076

**x%% Number of Population Records Found ****

48000 Texas

Figure 7-1: Output message file.

DATA FILE RELATIONSHIPS

One of the difficulties a novice user may have is understanding the rel ationships between
different input files. The following is an example of possible problems as aresult of providing
some new data but not enough.

Allocation Files

The allocation cross reference file defines for each source category the allocation indicator and a
corresponding coefficient to be used to allocate equipment population. If you have local data on
the use of snowmoabilesin your modeling domain, you can specify a new indicator code and then
provide the allocation datafor the new code. For example, adding 2260001020, recreational
snowmobiles, with an indicator code of SNO to the allocation cross reference file means you
must provide an allocation file for the SNO indicator.

In addition, you must remember to update the options file to reference the new files and data
which you have created. The packet /ALLOC FILES/ must include the new allocation filename
for the SNO indicator data. And if you made changes to a copy of the cross reference file you
must be sure to specify the new cross reference file name in the /RUNFILES packet of the
options file (perhaps alloupd.xrf).

Population Data

The equipment population data can contain records of any or mixed region levels and the model
will use the most detailed provided. If you want to estimate county total emissions, then you can
either provide state level equipment populations and state-to-county allocation data or you can
provide county equipment populations. If equipment population is provided at the level for
which emissions are being reported then, no allocation is needed. Only when equipment
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populations are provided at a coarser level of detail than the level you are estimating will
allocation data be required.

In addition to defining equipment populations and corresponding allocation data you must also
include the data file names in the /POP FILES/ and /ALLOC FILES packets of the input option
file.
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APPENDIX A
EXAMPLES OF FIPS CODES

Refer to datafile fips.dat, included with the NONROAD model,
in the data\all ocate directory for a complete list of FIPS codes.
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State Name

Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama

FIPS

00000
01000
01001
01003
01005
01007
01009
01011
01013
01015
01017
01019
01021
01023
01025
01027
01029
01031
01033
01035
01037
01039
01041
01043
01045
01047
01049
01051
01053
01055
01057
01059
01061
01063
01065
01067
01069
01071
01073
01075
01077
01079
01081
01083
01085
01087
01089
01091

COUNTY
United States Total
The State of Alabama
Autauga County
Baldwin County
Barbour County
Bibb County
Blount County
Bullock County
Butler County
Cahoun County
Chambers County
Cherokee County
Chilton County
Choctaw County
Clarke County
Clay County
Cleburne County
Coffee County
Colbert County
Conecuh County
Coosa County
Covington County
Crenshaw County
Cullman County
Dae County
Dallas County

De Kab County
Elmore County
Escambia County
Etowah County
Fayette County
Franklin County
Geneva County
Greene County
Hale County
Henry County
Houston County
Jackson County
Jefferson County
Lamar County
Lauderdale County
Lawrence County
Lee County
Limestone County
Lowndes County
Macon County
Madison County
Marengo County
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Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alabama
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska
Alaska

01093
01095
01097
01099
01101
01103
01105
01107
01109
01111
01113
01115
01117
01119
01121
01123
01125
01127
01129
01131
01133
02000
02013
02016
02020
02050
02060
02068
02070
02090
02100
02110
02122
02130
02150
02164
02170
02180
02185
02188
02201
02220
02232
02240
02261

Marion County

Marshall County

M obile County

Monroe County
Montgomery County
Morgan County

Perry County

Pickens County

Pike County

Randol ph County

Russell County

St Clair County

Shelby County

Sumter County

Talladega County
Tallapoosa County
Tuscaloosa County

Walker County

Washington County

Wilcox County

Winston County

The State of Alaska
Aleutians East Borough
Aleutians West Census Area
Anchorage Borough

Bethel Census Area

Bristol Bay Borough

Denali Borough

Dillingham Census Area
Fairbanks North Star Borough
Haines Borough

Juneau Borough

Kenal Peninsula Borough
Ketchikan Gateway Borough
Kodiak Island Borough
Lake and Peninsula Borough
Matanuska-Susitna Borough
Nome Census Area

North Slope Borough
Northwest Arctic Borough

Prince of Wales-Outer Ketchikan Census Area

Sitka Borough

Skagway-Y akutat-Angoon Census Area
Southeast Fairbanks Census Area

Vadez-Cordova Census Area
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APPENDIX B

SOURCE CLASSIFICATION CODES
(SCC) AND DEFINITIONS
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SOURCE CATEGORY CODE USE AND DEFINITIONS

This appendix provides a description of the Source Category Codes (SCC)
used in the NONROAD model. The NONROAD model uses SCCs to define
the application and engine types. The model uses a hierarchy with the SCC in
that a general SCC may define information for all more detailed SCC values.
For example, input data using SCC code 2265000000 applies to all SCCs
beginning with 2265xxxxxx unless input data are entered for a more detailed
SCC,; e.g., 2265001000 will overwrite the general information for that SCC or
group of SCCs. Likewise, 2265001000 applies to all Recreational equipment
(2265001010, 226501020, 226501030, 226501050, and 226501060) unless
specific data are provided for those SCCs. Use of these hierarchical SCC’s
allows model input data to be simplified if information is the same for similar
equipment types.

The codes used in the NONROAD model are listed in Tables B-1 through B-
20. These table provide additional explanation of each of these codes, and
also the average, minimum, and maximum power levels for each equipment
type. The equipment descriptions are derived from the earlier NEVES (EPA,
1991) report on emissions from nonroad engines, with additional groups
defined in EPA’s NONROAD documentation report NR-006¢ (found at
http://www.epa.gov/otag/nonrdmdl.htm).

SCCs are defines by EPA, and States and other NONROAD users are
discouraged from adding their own equipment types to avoid confusion
between different State uses. To define additional SCCs in the NONROAD
model, the core model must be recompiled with the additional SCCs included
in the code using a Lahey FORTRAN compiler with a “Make” utility and the
“Make” file included in the source code. It is HIGHLY recommended that
States not alter the source code; if additional applications are required, then a
cooperative effort should be pursued with EPA staff to add them to the model.
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Table B-1. Recreational vehicles equipment types and descriptions. (xx refers
to ‘60’ for 2-stroke gasoline, ‘65 for 4-stroke gasoline, ‘70’ for diesel, ‘67’

for LPG, 68 for CNG).

SCC Equipment Type Definition
22xx001020 Snowmobiles Self-explanatory

22xx001030 ATV/Off-road All terrain vehicles (ATV) are four or three wheeled
motorcycles off-road bikes combined with two wheeled off-road
motorcycles

22xx001050 Golf Carts Self-explanatory

22xx001060 Specialty VehiclesAny number of off-road vehicles not otherwise
classified including utility and personnel carriers, ice
maintenance (aka Zamboni), snow groomers, and other
various vehicles

Table B-2. Construction equipment types and descriptions. (xx refers to ‘60’
for 2-stroke gasoline, “65’ for 4-stroke gasoline, ‘70’ for diesel, ‘67’ for LPG,

68 for CNG).

SCC Equipment Type Definition

22xx002003 Pavers Large and small (such as for curbs) primarily self-
propelled pavers

22xx002006 Tampers/ Small “handheld,” walk-behind, or single person sized

Rammers equipment for compaction such as for sidewalk or other
small area compaction

22xx002009 Plate Compactors Similar to tamper/rammers with a larger vibrating plate
instead of a ram

22xx002015 Rollers Rollers include smooth and knobby (such as used in
landfills and called “compactors” not to be confused
with smaller Plate Compacters) self-propelled rollers

22xx002018 Scrapers Special equipment type that is an off-highway tractor
with a mid-frame bucket that lowers to scrape loose
material (dirt) into the bucket to carry to another part of
the job site to dump; sometimes converted to a water-
wagon

22xx002021 Paving EquipmentVarious equipment types used to smooth and
distributing paving material including vibrators and
finishers to support the work of the pavers

22xx002024 Surfacing Other various equipment used to supplement paving
Equipment activity including paving material mixers, surface
profilers (road reclaiming chippers), and seal coating
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SCC Equipment Type Definition
equipment not used to distribute paving material as with
paving equipment
22xx002027 Signal Boards Includes both highway boards and light plants used for
nighttime lighting
22xx002030 Trenchers Large and small trenchers typically using a rotating
front mounted rotating ‘blade’ to pull material from
trench and distribute it to the side.
22xx002033 Bore/Drill Rigs  Self-explanatory drills or boring rigs of all types that
are skid mounted, trailer mounted, or self-propelled; not
to be confused with highway trucks with drill
attachments running off the highway engine, though
truck mounted nonroad engines\equipment exist
22xx002036 Excavators Single purpose wheeled or tracked excavators
(backhoe) distinct of multipurpose
tractor/backhoe/loaders
22xx002039 Concrete/ Handheld and large engine powered saws for stone
Industrial Saws  cutting.
22xx002042 Cement & Mortar Small mixers used for small batch mixing
Mixers
22xx002045 Cranes Self-propelled typically cable hoists; not to be confused
with highway trucks with crane attachments running off
the highway engine, though truck mounted nonroad
engines\equipment exist
22xx002048 Graders Called road or motor graders often used to prepare a
site, especially a road, for paving. A blade is mid-frame
mounted with equipment having a long wheel base
22xx002051 Off-highway Large off-highway dump trucks not certified for
Trucks highway use
22xx002054 Crushing/Proc. Various crushing and screening equipment for bulk
Equipment material
22xx002057 Rough Terrain Rough terrain forklifts (RTF) can be confused with
Forklifts typical forklifts but have larger knobby off-road wheels
and can be confused with rubber tire loaders but are
specifically designed for handling palettes. RTFs
include telescoping lift trucks called telescopic handlers
often used in building construction.
22xx002060 Rubber Tire Bucket loaders or front-end loaders with a front
Loaders mounted bucket for scooping though other attachments

can be used instead of a bucket
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SCC Equipment Type Definition

22xx002066 Tractors/ Common and ubiquitous multipurpose equipment type
Loaders/ that is most often referred to as a “backhoe” but include
Backhoes the combined functions of loading and a backhoe in one

22xx002069 Crawler Tractors/
Dozers

22xx002072 Skid Steer
Loaders

22xx002075 Off-Highway
Tractors

22xx002078 Dumpers/
Tenders

22xx002081 Other
Construction
Equipment

unit. Agricultural tractors with alternative attachments
may used for similar purposes

Tracked (not wheeled) loaders and dozers

Smaller (able to be ‘skid” mounted to transport to job
site) loaders which may have alternative attachments
than a bucket for loading

Large tractors used to primarily drag large buckets or
other equipment around a job or mine site, and
agricultural tractors have been used for the same
purpose

Small loaders and other trucks for confined space and
light loads typically used for small building projects and
are typically walk-behind equipment.

Miscellaneous category for equipment not categorized
above; only example of this type supplied by PSR are
tensioners which are large winches used in construction
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Table B-3. Industrial equipment types and descriptions. (xx refers to ‘60’ for
2-stroke gasoline, ‘65’ for 4-stroke gasoline, ‘70’ for diesel, ‘67’ for LPG, 68

for CNG).
SCC Equipment Type Definition
22xx003010 Aerial Lifts Various (telescoping, articulated, scissors, and other) lift
equipment for personnel also called man lifts not to be
confused with highway trucks with crane attachments
running off the highway engine, though truck mounted
nonroad engines\equipment exist to provide lifts for
buckets
22xx003020 Forklifts Small wheeled forklifts used for warehouses and other
general purposes
22xx003030 Sweepers/ Off-road primarily self-propelled sweeping and
Scrubbers scrubbing vehicles
22xx003040 Other General Miscellaneous category with examples such as
Industrial sandblasters, large vacuum\spraying\other nonroad
Equipment trucks, paint sprayers, general purpose spreaders, and
winches.
22xx003050 Other Material Conveyers and other bulk material handling equipment
Handling
Equipment
22xx003060 Refrigeration Self contained engine compressors for refrigeration such
as used on refrigeration trucks
22xx003070 Terminal Single driver (typically no passenger seat) off-road
Tractors trucks used primarily for moving highway trailers

around paved areas such as at container ports and other
intermodal facilities (rarely used for moving aircraft
around airports); also called yard spotters, hostlers, and
hustlers.

EPA NONROAD Emissions Model User’s Guide

B-6



December 2005

Table B-4. Lawn and garden equipment types and descriptions. (xx refers to
‘60’ for 2-stroke gasoline, ‘65’ for 4-stroke gasoline, *70” for diesel, ‘67" for
LPG, 68 for CNG).

SCC Equipment Type Definition
22xx004010 Lawn mowers Walk behind mowers owned by residences
(Residential)
22xx004011 Lawn mowers Walk behind mowers owned by commercial
(Commercial) landscaping and horticultural services
companies as well as facility\parks\other
maintenance departments.
22xx004015 Rotary Tillers < 6 HP Smaller walk-behind rotary tillers for residential
(Residential) gardens
22xx004016 Rotary Tillers <6 HP Smaller walk-behind rotary tillers for residential
(Commercial) gardens owned by facility\ parks\other
maintenance departments or landscaping
professionals
22xx004020 Chain Saws <6 HP Self explanatory but smaller than those used for
(Residential) forestry
22xx004021 Chain Saws <6 HP Self explanatory but smaller and owned by
(Commercial) facility\parks\other maintenance departments or
landscaping professionals
22xx004025 Trimmers/Edgers/Brush Small handheld or nonhandheld power
Cutters (Residential) equipment for general purpose cutting including
equipment types such as string trimmers (aka
Weedwackers) as well as other engine powered
types
22xx004026 Trimmers/Edgers/Brush Same as above but owned by
Cutters (Commercial) facility\parks\other maintenance departments or
landscaping professionals
22xx004030 Leafblowers/\Vacuums Self explanatory
(Residential)
22xx004031 Leafblowers/\Vacuums Self explanatory owned by facility\parks\other
(Commercial) maintenance departments or landscaping
professionals
22xx004035 Snowblowers Self explanatory
(Residential)
22xx004036 Snowblowers Self explanatory owned by facility\parks\other
(Commercial) maintenance departments or landscaping
professionals
22xx004040 Rear Engine Riding As described and designed for residential lawn

Mowers (Residential)

mowing

EPA NONROAD Emissions Model User’s Guide

B-7



December 2005

SCC Equipment Type Definition
22xx004041 Rear Engine Riding As described and designed for lighter duty
Mowers (Commercial) mowing than front mowers owned by
facility\parks\other maintenance departments or
landscaping professionals
22xx004046 Front Mowers Heavier duty and more versatile mowers than
rear engine mowers with mower attached on the
front of the vehicle
22xx004051 Shredders <6 HP Lighter-duty equipment (than chippers\stump
grinders) with internal blades to reduce small
diameter wood to small pieces
22xx004055 Lawn & Garden Tractors Small tractors used for mowing but able to
(Residential) perform tasks other than mowing and owned by
residences
22xx004056 Lawn & Garden Tractors Small tractors used for mowing but able to
(Commercial) perform tasks other than mowing and owned by
facility\parks\other maintenance departments or
landscaping professionals
22xx004066 Chippers/Stump Grinders Internal or external bladed equipment to grind
and chip various, but primarily woody biomass,
materials. Heavier duty than shredders. May
include road chippers, stone grinders, and other
non-lawn and garden equipment types
22xx004071 Commercial Turf Various turf equipment designed for
Equipment professional use and include applications, such
as aerators, dethatchers, sod cutters, hydro-
seeders, turf utility vehicles, and specific golf
course equipment including greens mowers and
sand trap groomers
22xx004075 Other Lawn & Garden Any other lawn and garden maintenance
Equipment (Residential) equipment not otherwise classified and include
such equipment types as augers, sickle-bar
mowers, and wood splitters owned by
residences
22xx004076 Other Lawn & Garden Any other lawn and garden maintenance

Equipment (Commercial)

equipment not otherwise classified and include
such equipment types as augers, sickle-bar
mowers, and wood splitters owned by
facility\parks\other maintenance departments or
landscaping professionals
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Table B-5. Agricultural equipment types and descriptions. (xx refers to ‘60’
for 2-stroke gasoline, *65 for 4-stroke gasoline, ‘70’ for diesel, ‘67’ for LPG,

68 for CNG).

SCC Equipment Type

Definition

22xx005010 2-Wheel Tractors
22xx005015 Agricultural
Tractors
22xx005020 Combines
22xx005025 Balers
22xx005030 Agricultural

Mowers
22xx005035 Sprayers

22xx005040 Tillers > 6 HP

22xx005045 Swathers

22xx005055 Other Agricultural
Equipment

22xx005060 Irrigation Sets

Walk-behind 2-wheeled tractors for use in edible
produce or other intensive farming

Large and small agricultural tractors, most prevalent
farm equipment type

Self-propelled combined harvesting and cleaning
equipment

Equipment that bales from loose or windrowed hay or
other forage mowed crop

Equipment for mowing not intended for later baling or
harvesting

Small (backpack) and large (self-propelled) powered
equipment designed specifically for spraying

Primarily small tillers similar to those used in lawn
and garden applications intended to be used in edible
produce or other intensive farming

Equipment designed to cut crops for later baling or
harvesting including windrowers

Other various cultivation equipment types and include
harvesters or other special cultivating equipment

Agricultural pumps and pivot wheel irrigation
equipment to distribute water to fields or livestock.
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Table B-6. Commercial equipment types and descriptions. (xx refers to ‘60’

for 2-stroke gasoline, *65’ for 4-stroke gasoline, ‘70’ for diesel, ‘67’ for LPG,

68 for CNG).

SCC Equipment Type Definition

22xx006005 Generator Set Trailer or skid mounted self contained engine\electric
generator designed to supply electrical power at a job
site

22xx006010 Pumps Trailer or skid mounted engine powered liquid pumps

22xx006015 Air Compressors Trailer or skid mounted engine powered engine powered
air compressors to generate high pressure air for
pneumatic tools or other needs for pressurized air

22xx006020 Gas Compressors Engine compressors for commercial gas, most likely to
pressurize CNG from natural gas lines or boost pressure in
those lines. May be similar to area or stationary source
engine compressors.

22xx006025 Welders Engine powered arc welding support equipment not unlike
a generator

22xx006030 Pressure WashersEngine powered pumps specifically for pressure washers

22xx006035 Hydro Power Power engines designed to specifically supply hydraulic
Units power;

Table B-7. Logging equipment types and descriptions. (xx refers to ‘60’ for 2-
stroke gasoline, ‘65’ for 4-stroke gasoline, 70’ for diesel, ‘67’ for LPG, 68

for CNG).

SCC Equipment Type Definition

22xx007005 Chain Saws > 6 hp Larger thinning and harvesting chainsaws for
commercial forestry

22xx007010 Shredders > 6 hp Larger shredders to reduce slash to smaller pieces;
it is distinguished from a chipper by not producing
uniform size pieces.

22xx007015 Fellers/Bunchers/ Various harvesting equipment for forestry. Fellers

Skidders typically appear to be excavators or loaders with
grappling clamps and rotating saw attachments; a
buncher typically loads whole logs for transport; a
skidder is typically a low equipment type not unlike
a loader with a chain winch to pull logs (‘skid”) to a
location for a buncher or log loader.
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Table B-8. GSE/underground mining/oil field equipment types and

descriptions. (xx refers to ‘60’ for 2-stroke gasoline, ‘65" for 4-stroke

gasoline, ‘70’ for diesel, ‘67" for LPG, 68 for CNG).

SCC Equipment Type Definition

22xx008005  Airport Support Equipment All types of airport support equipment; EPA may expand this
to more and varied types of equipment but only one SCC
exists to date

22xx009010  Other Underground Mining Mining equipment similar to other construction and mining
Equipment equipment but specially designed for low profile and
confined space conditions

22xx010010  Other Oil Field Equipment Various oil field equipment including fracturing rigs, large
mechanical drilling engines, seismograph rigs, and trailer or
skid-mounted oil field pumps

Table B-9. Recreational marine equipment types and descriptions. (xx refers to
‘60’ for 2-stroke gasoline, ‘65’ for 4-stroke gasoline, ‘70’ for diesel, ‘67’ for LPG, 68 for CNG).
SCC Equipment Type Definition

2282005010 Gasoline Outboards  Standard outboard engines easily removed and
replaced if needed

2282005015 Personal Watercraft Engines used to provide power to jet-powered small
boats and riding watercraft (aka JetSki)

2282010005 Gasoline Inboards Primarily 4-stroke engines mounted as an integral
part of the vessel

2282020005 Diesel Inboards Diesel engines mounted as an integral part of the
vessel
2282020010 Diesel Outboards Rare, but nonzero diesel powered outboard engines.
2282020025 Diesel Sailboat Not used because auxiliary integrally mounted
Auxiliary propulsion power primarily for larger sailboats or
outboard motors are included as inboards or
outboards
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Table B-10. Railway maintenance equipment types and descriptions. (xx refers to ‘60’ for 2-
stroke gasoline, ‘65’ for 4-stroke gasoline, ‘70’ for diesel, ‘67" for LPG, 68 for CNG).

SCC Equipment Type Definition
2285002015 Diesel Railway Equipment types specifically design for repair,
Maintenance maintenance, and construction of rail lines

including ballast handlers, rail/tie handlers, and
rail straightening equipment

2285003015 2-stroke Railway
Maintenance

2285004015 4-stroke Railway
Maintenance

2285006015 L PG Railway Maintenance

EPA NONROAD Emissions Model User’s Guide B-13



December 2005

APPENDIX C

EXAMPLES OF STANDARD REPORTS

Reports for Travis County, Texas 1998 nonroad emissions are printed in the following order.
Note that only the first two pages are printed for the longer reports.

1. Emission Totals by County

2. Emission Totals by County and Fuel Type

3. Emission Totals by Equipment Type

4. Emission Totals by Horsepower

5. Emission Totals by HP and Source Classification

6. Emission Totals by HP and Equipment Type

7. Emission Totalsby SCC

8. Emission Totals by Source Classification

9. Population and Fuel Consumption by HP and Source Classification

10. Population and Fuel Consumption by SCC
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Emission Totals by County and Pollutant
All Fuels

Lawn and Garden Equipment
Traviz County Summertime (Travis 1988)

Total for Summer Season, 1998
Date of Model Run: Iay 29 16:37. 1% 2005

T onsfSeason

Teoday's Date: 5/29/2005

Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankease Diurnal
FIPS County THC NOx co PM10 502 co2 THC THC
42453 TravieCounty 109613 147.00 17,646 .23 3575 1422 3347846 1874 210
Totak: 109613 147.00 17,646.23 3575 1422 35A478.46 19.74 8.10
Core Madel Fer 20605 May 2005 page Taf 2
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Emission Totals by County and Pollutant
All Fuels

Lawn and Garden Equipment
Travis County Summertime (Travis 1988)

Total for Summer Season, 1995
Diate of Model Run: May 2% 16:37:1%: 2005

T onsfSeason

Teoday's Date: 5/29/2005

Vapor Spillage Hot Soak Running Tank Hose Total
FIFS County Displacement THC THC Loss THC Permeation Permeation THC
THC THC THC
48453 Travis County 15.19 24.40 o.an o.an o.an o.an 1,223 56
Totals: 15.19 84.40 0.00 0.00 000 0.00 1,22356
NONROAD Core Maodel Ver 20005, Mar 2005 page 2aof 2

EPA NONROAD Emissions Model User's Guide



December 2005

All Fuels

Lawn and Garden Equipment
Traviz County Summertime (Travis 1988)

Total for Summer Season, 1998
Date of Model Run: Iay 29 16:37. 1% 2005

Emission Totals by County, Fuel Type, and Pollutant

T onsfSeason

Teoday's Date: 5/29/2005

FIPS County Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankrcase Diurnal
THC NOx co PM10 502 co2 THC THC
Fuel Type
48453 TRAVIS COUNTY
Diesel 334 5224 3008 621 774 3,827.82 o017 0.00
Grasoline 108699 9088 17,600 .44 2852 .48 31,434.06 1831 2.10
LPG 020 388 1572 ooz 0.00 216.58 0.6 0.o0
48453 Travis County Totals: 109613 147.00 17,646.23 3575 1422 35A478.46 19.74 8.10
Grand Tetak: 1096.13 147.00 17,64623 3575 1422 3547846 19.74 8.10
Core Madel Fer 20605 May 2005 page Taf 2
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All Fuels

Lawn and Garden Equiptent

Travis County Summertime (Travis 19598)
Total for Summer Season, 1928

Drate of Model Run: May 29 16:37:1%: 2005

Emission Totals by County, Fuel Type, and Pollutant

Tons/Seasan

Today's Date: 5/29/2005

FIPS County Vapor Spillage Hot Soak Running Tank Hose Total
Fuel T Displacement THC THC Loss THC Permeation Permeation THC
uellype THC THC THC
48453 TRAVIS COUNTY
Diesel 0.00 o.on o.on i} o.on o.on 351
(tasaline 15.19 24.40 o.on i} o.on o.on 1,21398
LPG 0.00 ] ] 000 ] ] 107
48453 Travis County Totals: 15.19 84.40 0.00 0.00 o.00 000 1,22356
Grand Totals: 15.19 84.40 0.00 0.00 o.00 000 1,22356
NONROAD Core Model Ver 2005, Mgy 2005 pag Zof 2
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Emission Totals by Equipment Type and Pollutant
All Fuels Tons/Season Travis County

Lawn and Garden Equipment
Travis County Summertime (Travis 1998)

Total for Summer Season, 1998

Date of Model Run: May 29 16:37:1%: 2005 Today's Date: 5/2%/2005
Source Equip ment Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankrase Diurnal
Chssification Descrip tion TOG NOx co PRI10 502 coz2 TOG TOG

LAWN AND GARDEN EQUIPMENT (COM)

Chain Saws < § HP 13524 131 351.98 79 0.13 637.78 0.00 o001
ChippersfStump Grinders 1109 3457 306.25 206 4.04 2,7790.23 1.16 006
Commercial Tusf Epuipruent 17000 4305 650833 200 282 11,681.57 358 099
Front Mowers 253 1274 1981.90 248 284 1,603.88 0.32 0os
Lawn & Garden Tractors 3030 1406 2,17834 0.9y 1.35 403012 1.26 017
Lawn mowets 2202 507 1,100.16 07y 0.41 2,006.26 113 0.1z
Leafblow eraW acums 17877 1039 1,537.30 699 0.60 2,92492 1.47 014
Other Lawn & Garden Eqp. 1326 0E7 19361 0.0 0.11 38070 0.50 0.47
Fear Engine Riding Mowers 344 07e 161.05 003 0.06 27212 0.02 ooz
Rotary Tillers < & HF 2345 2323 664.63 1.50 0.2 1,260.83 1.98 oo3
Shredders < 6 HP 770 024 7104 011 0.03 13856 0.25 ooz
Snowblowers 0.0o 000 0.oo 0.0o 0.00 0.oo 0.00 0.o0
Trimmers/E dgers/Brush Cutter 16126 066 403.58 632 0.15 71031 0.03 oo7
Lawn and Garden Equipmeni (Com) Tetak: 92006 13289 13 848.16 3211 1279 2854445 13.76 221

LAWN AND GARDEN EQUIPMENT (RES)

Chain Saws< 6 HP 1895 nns 46.12 063 0.0t 7371 0.00 ooz

Lawn & Garden Tractors 3393 oo 2,50672 0.4z 0.91 441930 21.8% 31z

Lawn mowets 62,40 157 740,79 045 0.3z 1,558.07 3.20 123
Core Modsl Fer 2005 May 2005 prag laof &
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Emission Totals by Equipment Type and Pollutant
All Fuels TonsfSeason

Lawn and Garden Equipment
Traviz County Summertime {Travis 1958)

Total for Summer Season, 15958
Date of Model Run: May 25 16:37. 1% 2005

Travis County

Today's Date: 5/2%/2005

Source Equip ment Vapor Spillage Hot Seak Running Tank Hose Total
Classification Descrip Hon Disphcement TOG TOG Loss TOG Permeation Permeation TOG
TOG TOG TOG

LAWN AND GARDEN EQUIPMENT (C OM)
Chain Sawe< 6 HF 0.46 1466 000 0.0o 0.0o 0.o0 15038
ChippersfStump Grinders 0.28 011 o.0o o.oo o.oo 0.00 1271
Commercial Tuf Equipment 523 4.40 o.0o o.oo o.oo 0.00 19520
Frort Mowrers 013 0.2a o.0o o.oo o.oo 0.00 954
Lawn & Garden Tractors 170 285 o.0o o.oo o.oo 0.00 56.29
Lawn mowet s 059 1082 o.0o o.oo o.oo 0.00 10107
Leafbl owers VW acunams 1.51 944 o.0o o.oo o.oo 0.00 19133
Other Lawn & Garden Egp 018 0.z24 o.0o o.aon o.aon 0.00 1465
Rear Engine Riding MWowers 01z 022 o.0o o.aon o.aon 0.00 389
Rotary Tillers < 6 HP 066 oAl o.0o o.aon o.aon 0.00 9573
Shredders < 6 HP 007 099 000 0.0o 0.0o 0.o0 on3
Hnowblowes 0.o0 0.oo 000 0.0o 0.0o 0.o0 0.oo
TrimmersEdger sBrush Cutter 053 1163 000 0.0o 0.0o 0.o0 173533

Lawnand Garden Equipment (Com) Totals: 1188 6525 0.00 0.00 0.00 0.00 1.013.15

LAWN AND GARDEN EQUIPMENT (RES)
Chain Saws< 6 HF 008 297 000 0.0o 0.0o 0.o0 2200
Lawn & Garden Tractors 2.00 336 000 0.0o 0.0o 0.o0 70.30
Lawn mowet s 037 241 o.0o o.oo o.oo 0.00 2202

NONROAD Core Maodel Ver 2005, May 2005 page 2of &
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Source Equip ment Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankrase Diurnal
Chssification Description TOG NOx Co PR10 502 coz2 TOG TOG
Leafblow eraW acums 2375 oos 64.20 07y 0.0z 105537 0.03 0.49
Other Lawn & Garden Eqp. 547 027 7O82 U 0.03 15079 0.20 020
Rear Engine Riding Mowers 413 07é 186.34 003 0.07 327 .44 0.20 0.43
Rotary Tillers < 6 HP Foal 024 7158 o.ng 0oz 151.87 0.31 010
Snowhlower s o.oo ooo ooo o.oo 0.00 ooo 0.00 onoo
T rimmersE dgers/Brush Cutter 3646 o1z 244 1189 003 145 86 0.0z 027
Lawn and Garden Equipment (Res) Totals: 22399 14.11 3,798.07 364 1.43 6,934.01 6.85 589
Grand Totak: 1,144.05 147.00 17 646.23 3575 14.22 35,47BAG 20.61 8.10
Core Madel Fer 2005, Map 2005 pag Fof &
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Source Equip ment Vapor Spillage Hot Seak Running Tank Hose Total
Classification Descrip tion Disphcement TOG TOG Loss TOG Permeation Permeation TOG
TOG TOG TOG
Leafbl owers VW acunams 0.08 048 o.0o o.oo o.oo 0.00 2484
Other Lawn & Garden Egp 0.07 o.1o o.0o o.oo o.oo 0.00 a.04
Rear Engine Riding MWowers 013 0.2a o.0o o.aon o.aon 0.00 517
Rotary Tillers < 6 HF 0.0z 112 i} o.on 0.0o 0.o0 032
Snowblowers n.oo oon i} o.on o.on n.oo 0.oo
Ttimm ersEdger sBirush Cutter 011 245 i} o.on o.on n.oo 331
Lawnand Garden Equipment (Res) Totak: 332 19.15 0.00 0.00 0.00 0.00 25020
Grand Totak: 15.19 84 40 0.00 0.00 0.00 000 127235
NONROAD Core Model Ver 2005, May 2005 page fof &
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Emission Totals by Horsepower and Pollutant
All Fuels Tons/Season Travis County

Lawn and Garden Equipment
Travis County Summertime (Travis 1998)

Total for Summer Season, 1998

Date of Model Bun: May 2% 163715 2005 Today's Date: 5/29/2005
Exhaust Crankrase Diurnal Vapor Spillage
Horsepower NMHC NMHC NRMHC Displacement NMHC
NMHC

0<HP=<=1 9.29 0.01 014 ik 051
1<HP=<=3 340.95 0.17 053 116 2252
3<HP=<=§ 444.27 7.42 196 414 4491
f<HP<=11 36.56 0.1 0.90 1438 555
11 <HP <=1¢ 98.79 3.14 268 403 633
16 < HP <=25 87.48 2.8 139 358 324
25 < HP <=40 7.0 2.0 007 0.47 025
40 < HP <= 50 0.35 0.1 0.00 0.00 o.oo
S0« HP «<=73 311 0sz3 onz ols 041
75 < HP «=100 1.32 ooz ono ono ono
100 <HF <= 175 2.85 079 oot 01a oF7
175 <HF <= 300 0.44 oot onoo ooo ooo
300 < HF <= 600 066 oot onoo ooo ooo
G00 < HF <= 730 0.24 ooo onoo ooo ooo
750 <HF <= 1000 0.08 ooo onoo ooo ooo
1000 < HP <= 1200 0.07 oon 000 o000 o000
Toetaks: 1,034.62 17.79 8.10 1519 8440
Core Model Fer 2005 May 2005 page Taf 2
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Emission Totals by Horsepower and Pollutant

All Fuels T ons/Season Travis County
Lawn and Garden Equipment
Travis County Summertime (Travis 1598)
Total for Summer Season, 1998
Diate of dodel Bun: May 2% 16:37.19: 2005 Teday's Date: 5/29/2005
Hot Soak Running Tank Hose Total
Horsepower NMHC Loss Permeation Permeation NMHC
NKMHC NMHC NMHC
0<HP=<=1 0.00 0.oo 0.00 0.0a aoa7
1<HFP <=3 0.00 ] 0.00 o.oo 36572
3<HP <=4 0.00 0.00 0.00 o.0o 30270
& <HFP <=11 0.00 0.oo 0.00 0.0a 45.40
11 <HP «<=1§ 0.00 0.oo 0.00 0.0a 11486
16 < HP <= 23 0.00 0.oo 0.00 0.0a o705
25 <HFP <= 40 0.00 0.oo 0.00 0.0a ey
40 < HFP <= 50 0.00 0.oo 0.00 0.0a 0.56
S0<HP==73 0.00 0.oo 0.00 0.0a 452
75<HP ==100 0.00 0.oo 0.00 0.0a 134
100 < HF <= 173 0.00 0.oo 0.00 0.0a 458
175 < HF <= 300 0.00 0.oo 0.00 0.0a 045
300 < HF == 4600 0.00 0.oo 0.00 0.0a 0aE
600 < HF == 750 0.00 0.oo 0.00 0.0a 025
750 < HF == 1000 0.00 0.oo 0.00 0.0a 006
1000 < HP == 1200 0.00 0.oo 0.00 0.0a 007
Totals: 0.00 0.00 0.00 0.00 1,160.09
Core Madel Ver 20085, May 2005 page 2f 2
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Emission Totals by Horsepower, Source Classification, and Pollutant

All Fuels Tons/Season Travizs County
Lawn and Garden Equipment
Traviz County Summertime (Trawis 1995)
Total for Summer Season, 1995
Date of Model Run: May 29 16:37.1%: 20035 Today's Date: 5/28/2005
Source Exhaust Crankrase Diurnal Vapor Spillage
Chssification Horsepower NMHC NMHC NMHC Displacement NMHC
NMHC
LAWN AND GARDEN EQUIPMENT (COM)
0=<HP==1 111 o.0a 002 0.00 0.04
1=<=HP==3 71 62 011 022 093 17.02
3<HP <=8 376.71 426 055 3.24 3538
6<HP ==11 3185 0.48 0.37 129 5.24
11 < HP == 14 6326 1.40 0.37 262 3.76
16 < HF <= 25 7157 153 0.58 199 2.37
25 < HF <= 40 799 220 0.07 0.47 0.25
a0 < HF <= 50 055 ono1 0.00 o.0o 0.00
50 < HP <= 75 311 083 0.0z2 01s 0.41
75 <HF ==100 132 o.o3 0.00 o.0o 0.00
100 <HP == 175 285 079 0.01 0.1a 077
175 <HP == 300 0.44 ono1 0.00 o.0o 0.00
300 <HP == @400 0.6a onoi 0.00 o.0o 0.00
600 <HFP == 730 0.z4 o.aon 0.00 o.0o 0.00
750 < HF <= 1000 0.0a o.aon 0.00 o.0o 0.00
1000 < HP <= 1200 0.07 o.0a 0.00 0.00 0.00
Lawn and Garden Equipment (Com) Totals: 83441 11.88 221 11.88 65,25
Core Madel Fer 2065, May 20005 page Taf 4

EPA NONROAD Emissions Model User's Guide

C-12



December 2005

Lawn and Garden Equipment
Travis County Summertite (Travis 1998)

Total for Summer Season, 1998
Date of Model BEun: MMay 29 16:37.19: 2005

Emission Totals by Horsepower, Source Classification, and Pollutant
All Fuels Tons/Season

Travis County

Today's Date: 5/29/2005

Source Hot Soak Running Tank Hose Total

Classification Horsepower NMHC Loss Permeation Permeation NMHC
NMHC NMHC NMHC
LAWN AND GARDEN EQUIPMENT (CORM)

O0<HP=<=1 0.00 0.00 ] ooo 1.1%
l<HP«=3 0.00 0.00 ] ooo 289.00
S<HP <=6 0.00 0.00 o.no o.oo 420 16
6= HP == 11 0.00 0.o0n o.on 0.on 35 .44
11 <HF <=18 0.00 0.o0n o.on 0.on 7141
16 < HP <=25 0.00 0.o0n o.on 0.on 30046
25<HP<=40 0.00 0.o0n o.on 0.on 1057
40 < HP <= 50 0.00 0.o0n o.on 0.on 0.56
50<HP==75 0.00 0.o0n o.on 0.on 4.52
75 < HP ==100 0.00 0.o0n o.on 0.on 1.34
100 < HP <= 175 0.00 0.o0n o.on 0.on 4.58
175 < HP <= 300 0.00 0.o0n o.on 0.on 0.45
300 < HP <= 600 0.00 0.o0n o.on 0.on 0.68
600 < HP == 750 0.00 0.00 ] ooo 0.25
50 < HP <= 1000 0.00 0.00 ] ooo 0.06
1000 < HP <= 1200 0.00 0.00 0.0o 0.oo 0.o7
Lawn and Garden Equipment (Com) Totals: 0.00 0.00 0.00 000 925,62
Core Model Fer 2005, Mgy 2005 page 2of 4
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Source Exhaust Crankrase Diurnal Vapor Spillage
Chssification Horsepower NMHC NMHC NMHC Displacement NMHC
NMHC
LAWN AND GARDEN E QUIPMENT (RES)
0<HP==1 318 0.0o 0.1z ooz 0.47
1<HP <=3 6933 ons 071 0.23 550
3<HF <=4 67 .57 315 142 0gg 953
a<HF <= 11 471 0.4 052 0.1s 0.31
11 <HP == 14 3554 174 231 141 2.46
16 < HP == 25 1489 073 081 059 088
Lawn and Garden Equipment (Res) Totals: 20020 591 589 332 19.15
Grand Totak: 103462 17.79 8.10 1519 84.40
Core Model Fer 2005 May 2005 page Faf 4
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Source Hot Seak Running Tatal

Classification Horsepower NRMHC Loss Permeation Permeation NMHC
NMHC NMHC NMHC
LAWN AND GARDEN EQUIPMENT (RES)

0<HP==1 0.00 0.00 0.o0o 0.00 3.79
l<HF==3 0.00 0.00 0.o0o 0.00 7583
3<HP==46 0.00 0.00 0.o0o 0.00 8454
6 <HP == 11 0.00 0.00 0.o0o 0.00 5.96
11 <HP==16 0.00 0.00 0.o0o 0.00 43 .46
16 < HP <=23 0.00 0.00 0.o0o 0.00 17 .89
Lawnand Garden Equipment (Res) Totaks: 0.00 0.00 0.00 0.00 23447
Grand Tetals: 0.00 0.00 000 0.00 1,160.09
Core Model Ver 2005, Mgy 2005 page dof &
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Emission Totals by Horsepower, Equipment Type, and Pollutant

All Fuels Tons/Season Travizs County
Lawn and Garden Equiptment
Traviz County Summertime (Travis 19%8)
Total for Summer Season, 1995
Date of Model Run: May 29 16:37.1%: 20035 Today's Date: 5/28/2005
Source Exhaust Crankrase Diurnal Vapor Spillage
Chssification Horsepower NMHC NMHC NMHC Disp lacement NMHC
NMHC
LAWN AND GARDEN EQUIPMENT (COM)
Chain Saws= 6 HP
1<HP==3 2431 o.0a 0.00 0.0s 4.09
3<HP=<=# 104.07 o.0a 001 038 10.57
Chippers/Stump Grinders
3<HP=<=# 0.00 o.0a 0.00 0.00 0.00
6<HP<=11 0.1s o.0a 0.00 0.01 0.01
11 < HP == 16 118 o.0a 001 0.04 0.04
16 < HP == 25 2.82 014 003 011 0.05
25 <HP == 40 0.zl 0.7 0.00 0.01 0.00
40 < HP == 50 0.06 o.0a 0.00 0.00 0.00
S0 =HP ==75 168 .50 002 0.08 0.0t
75 <HP ==100 105 0.0z 0.00 0.00 0.00
100 =<HP ==173 108 024 001 0.04 0.00
175 <HP == 300 0.44 .01 0.00 0.00 0.00
300 < HP == a00 0.66 .01 0.00 0.00 0.00
600 < HP == 750 0.24 o.0a 0.00 0.00 0.00
750 < HP == 1000 0.04 o.0a 0.00 0.00 0.00
1000 < HP <= 1200 0.07 o.0a 0.00 0.00 0.00
Commercial Turf Eq uipment
Core Madel Fer 2065, May 20005 page Taof 12
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Emission Totals by Horsepower, Equipment Type, and Pollutant
All Fuels T ons/Season Travis County

Lawn and Garden Equipment
Travis County Summertime (Trawis 1995)

Total for Summer Season, 1998

Date of Model Run: May 2% 16:37.19: 2003 Today's Date: 5/2%/2005

Source Hot Soak Running Tank Hose Tetal

Classification Horsepower NMHC Loss Permeation Permeation NMHC
NMHC NMHC NMHC

LAWN AND GARDEN EQUIPMENT (COM)
Chain Saws < 6 HP

l<HF <=3 0.00 0.a0 o.an 0.oo 848
3<HP==4¢ 0.00 0.a0 o.an 0.oo 115.03
Chipp ers/Stump Grinders
3<HP==4¢ 0.00 0.a0 o.an 0.oo 0.00
6<HP <= 11 0.00 0.a0 o.an 0.oo 0.z0
11 <HP==16 0.00 0.a0 o.an 0.oo 1.28
lé<HP <=33 0.00 0.a0 o.an 0.oo 3.15
25 < HF ==40 0.00 0.a0 o.an 0.oo 0.28
40 < HF <= 30 0.00 0.a0 o.an 0.oo 0.06
S0<HF«<=73 0.00 0.a0 o.an 0.oo .28
73 < HF <= 100 0.00 0.a0 o.an 0.oo 1.07
100 < HP == 175 0.00 0.a0 o.an 0.oo 1.3
175 < HP == 300 0.00 0.a0 o.an 0.oo 0.45
300 < HP <= 600 0.00 0.a0 o.an 0.oo 0.6z
600 < HP <= 750 0.00 0.a0 o.an 0.oo 0.25
TS50 < HP <= 1000 0.00 0.a0 o.an 0.oo 0.06
1000 < HP <= 1200 0.00 0.a0 o.an 0.oo 0.07
Commercial Turf Equip ment
Core Madel Ver 20085, May 2005 page 2qf 12
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Emission Totals by SCC and Pollutant

All Fuels

TonsfSeazon

Lawn and Garden Equipment
Trawvis County Summertime (Travis 1958}

Total for Summer Season, 1998
Drate of Mlodel Fun: May 2% 16:37: 1% 2005

Travis County

Today's Date: Sf25/2005

SCC

Eqguipment Descrip tion

Engine Type

Exhaust PRI10

Exhaust PRM2.5

LAYWN AND GARDENEQUIPMENT (C ORM)

2260004016 *
2260004021 *
2260004026 *
2260004031 *
2260004036
2260004071 *
2265004011 *
2265004016 *
2265004026 *
2265004031 *
2265004038
2265004041 *
2265004046 *
2265004051 *
22650040 56 *
2265004068 *
2265004071 *
2265004078 *
2267004068 *
2270004031
2270004036
2270004046
2270004056
2270004066
2270004071
2270004076

Ratary Tillers < & HP

Chain Saws < & HP

Trimm er &'E dgers/Brush Cutter
L eafhlower s acinam s
Snowhlowers

Comim ercial TwwfE cquipmment
L aarmy tm onarers

Ratary Tillers < & HP

Trimm et 'E dgers/Brush Cutter
L eafblower sV acuuns
Snowblowers

Fear Engine RidinghMowers
Front Mowers

Shredders < 6 HP

Lawn & Garden Tractors
Chipper s/3tump Grinders
Comm ercial TwfE quipment
Other Lawn & Garden Egp.
Chipper s/3tump Grinders

L eaftblowersW acuuams
Snowblowers

Fromt M owers

Lawn & Garden Tractors
Chipper s/fStump Grinders
Coonm et cial Twf E cqudpament
Other Lawn & Garden Eg.

Lawn and Garden Equipment (Com) Totals:

LAWN AND GARDENEQUIPMENT (RE S)

2260004015%*
2260004020 *
2260004025*
2260004030 *

Rotary Tillers < & HFP

Chain Saws < 6 HFP

Trimm er'E dgers/Brush Cutter
L eaftblowersW acuuams

Cors Modzl Fer 2005, May 2005

2 Stroke
2 Stroke
2 Stroke
2 Stroke
2 Stroke
2 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
4 Stroke
LPC
Diiesel
Diiesel
Driesel
Driesel
Driesel
Driesel
Driesel

2 Stoke
2 Stoke
2 Stoke
2 Stoke

n&2 0.57
TIF Fla
632 5821
a3 a.1%9
o.oo o.oo
o.oo o.oo
077 071
087 o.g0
ool o.o1
0.2a 0.24
0.oo o.oo
003 o.03
004 o.03
011 o.10
0.43 0.40
oa7 oo7v
1.86 1.52
017 014
0oz ooz
o.ao o.oo
o.ao o.oo
2.44 237
0.54 0.52
287 2.78
0z4 033
0oz ooz
3211 2085
0.o7 0.0a8
0a3 0.52
1.1g 1.0
07F7 071
page Iaof 2
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BCC Eqguipment Descrip tion Engine Type Exhaust PRI10 Exhaust PR 2.5
2260004035 Snowblowers 2 Stroke o.oo o.oo
2265004010%* L awn mowers 4 Stroke 045 0.41
2265004015%* Rotary Tillers < & HP 4 Stroke o0z o.0o1
22a5004025* Trimm er 'E dgers/Brush Cutter 4 Stroke o.oo o.oo
2265004030 * L eaftblower W acuuams 4 Stroke o.oo o.oo
2265004035 Snowblowers 4 Stroke o.oo o.oo
22a5004040* Fear Engine Ridingldowers 4 Stwoke 0.0z 0.0z
2265004055+ Lawn & Garden Tractors 4 Strcke 0.4z 0.
2265004075 % Other Lawn & G arden Eqp. 4 Strcke o007 o077
Lawn and Garden Eguipment (Res) Totals: 364 33s
Grand Totals: 3575 3321
* ITnder 25 horsepowrer spark-ignition engines are hanped irto either 2- or 4 stroke.

Core Maodel Fer 2005, Moy 2005 page 2qf 2
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Emission Totals by Source Classification and Pollutant
All Fuels . Tons/Season

Lawn and Garden Equipment
Travis County Summertime (Travis 1998)

Total for Summer Season, 1958
Diate of Model Run: May 29 16:37: 1% 2005

Travis County

Today's Date: 5/2%/2005

Source Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankease Diurnal
Chsgification NMOG NOx co PM25 502 Cco2 NMOG NMOG
Lawn and CGarden Equipment (C om) 873.03 13289 13,248.14 1085 1279 28,544 .45 1244 221
Lawn and Garden Equipmert (Fes) 20051 1411 3,792.07 335 1.43 6,93401 6.19 580
Totals: 108254 147.00 17 64623 3321 14.22 35478 46 18.65 8.10
Core Madel Fer 2005, Map 2005 pag laof 2
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Emission Totals by Source Classification and Pollutant
All Fuels TonsfSeason Travis County
Lawn and Garden Equipment
Traviz County Summertime {Travis 1958)
Total for Summer Season, 15958
Date of Model Run: May 25 16:37. 1% 2005 Today's Date: 5/2%/2005
Source Vapor Spillage Hot Soak Running Tank Hose Total
Classification Displacement NMOG NMOG Loss Permeation Permeation NMOG
NMOG NMOG NMOG NMOG
Lawn and Grarden Equipment (C om) 11.88 6525 0.0a 0.00 0.0a 0.00 26482
Lawn and Garden Equipment (Res) 3.32 1915 0.0a 0.00 0.0a 0.00 24406
Totals: 15.19 8440 000 0.00 000 0.00 1,208 88
NONROAD Core Maodel Ver 2005, May 2005 page 2af 2
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Equipment Population and Fuel Consunmption by HP and Source
Classification for Travis County
Lawn and Garden Equipment

Trawvis County Summertime (I'ravis 1998}
Total for Summer Season, 1998

Drate of Model BEun: Iday 2% 16:37: 15 2005 Today's Date: S/25/2005
Fuel Equipmeni Fuel
Type Source Classification Horsepower Fop ulation Consump tion
(zallbons’ Season)
Diesel
Lawn and Garden Equipment (Com)
Z=HF ==46 285 3668
6= HF ==11 0.20 43.05
11 = HF == 14 56.15 385171
16 = HF <= 25 B05.50 TO23E.65
25 = HP <= 40 2EER 58 3B F25.47
40 < HF <= 50 To.o40 1586217
S0 <HF <=75 137.45 31.328.54
T3 =< HF == 100 12248 B, 420 57
100 < HP <= 175 5729 2719402
175 < HF <= 300 30.53 2587741
300 < HF <= 600 26.03 E30.E5405
al0 =< HP <= 750 .90 14 536 54
F50 = HP <= 1000 0.9 3.204.50
1000 < HF == 1200 091 3.511.47
Digsel Lewn and Garden Equapment (Com) Tofals: I G684 07 FLEOISS TG
Diesel Totals: 1.684.93 3240, 35579
Gasoline
Lawnand Garden Equipment (Com)
O0<HF <=1 216.68 Qo6 22
1=HF ==73 14,451 32 215,240 92
Z<HF <=6 20,323.07 TE1.321.15
6<HFP =<=11 367512 301,308 52
11 < HF <= 16 3,086.33 611,985 03
16 = HF <= 25 2,212.10 B8 446 57
25 = HP <= 40 20E.AT 109,251 73
S0 =< HP<=75 5318 3446224
100 =< HP == 175 3292 37059356
Gasoline Lavwn and Sarden Egquipmeant (Com ) Totals LE LD 50 2T SF2TI
Cors Modzl Fer 2005, May 2005 page Iqof 2
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Cors Modzl Fer 2005, May 2005

Fuel Equipment Fuel
Type Seurce Classification Horsepow er Fop ulation Consump tion
(zgallons' Season)
Lawn and Garden Equipment (Res)
0= HP ==1 11,814 5713
1 <HF ==3 58,738 54,288
Z<HP <=6 95,234 204,761
6= HF ==11 5,270 45,874
11 <« HF == 1é& 25,117 Z2E.058
lé < HP == 25 7,522 137,020
Gasoline Lawm and Sarden Equipmeant (Res) Tofals: 200, 595 FFRTIR
Gasoline Totals: 246,044 3544 502
LPG
Lawnand Garden Equipmeni (Com)
25 < HF == 40 5 2,71a
S0 < HF==75 23 20,319
100 < HP <= 175 5 9,402
LPG Lown and Sarden Eguipment (Com ) Tofals B4 B2 437
LPG Toials: 34 32 A3T
Grand Total: 247,763

page 2qf 2
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Equipment Population and Fuel Consumption by SCC for Travis County

Lawn and Garden Equipment
Trawvis County Summertime (Travis 1998}

Total for Summer Season, 1998
Drate of Model Bun: Iday 2% 16:37: 159 2005

Today's Date: S/25/2005

Fuel Engine Equip meni Fuel
Type SCC Equipmeni Descrip Hon Type Population Consump tion
(gallons’ Seasomn)

Diesel
Lawn and Garden Equipment (Com)
2270004031 Leafblower W acuans Diesel 234 3391
2270004036 Snowblowers Diesel ooo o0.00
2270004046 Front Mowers Diesel 1042 64 122,205 54
2270004058 Lavn & Garden Tractors Diiesel Z2a3 78 25.231.79
2270004066 ChippersBtamp Grinders Diesel 32208 171 4a6 .02
2270004071 Comm ercial Tirf E oquipiment Diesel 46 96 20,017 .62
2270004076 Other Lawn & G arden Egp. Diesel Tz 1.200.47
Dhesel Lown and Garden Bgquuipment (Com) Tofals: I a5493 FLO IS TR

Diezel Toilals: 168493 3035579

Gasoline
Lawmn and Garden Equipment (Com)
2260004016+  Rotary Tillers< & HF 2 Btroke 430 68 1322259
2260004021 * Chain Saws < & HP 2 Stroke S3ETE 39 106,797 81
2260004026 *  Trimm er sEdgers/Brush Cutter 2 Stroke QEE AR 118 486 20
2260004031 *  Leafblower s W acuium s 2 Stroke 3,769 76 113,787 8%
2260004036 Snowhblowrers 2 Stroke o.oo o.oo
2260004071 * Comm ercial Twrf E oquipmment 2 Stroke 064 5312
2265004011 % Lawn mowers 4 Stroke 2078 04 230,940 64
2265004016%*  Rotary Tillers< & HP 4 Stroke 267942 140,620 44
2265004026*  Trimm er 'Edgers/Brush Cutter 4 Stroke 126 32 5GEE3.53
2265004031 *  Leafblower s/ acuums 4 Stroke 1,247 41 23E.B02.12
2265004036 Snowhblowrers 4 Stroke o.oo o.oo
2265004041 * Fear Engine Ridinghowers 4 Stroke 259 20 2B F19.38
2265004046*  Front IMowers 4 Stroke B05.42 33,983.37
2265004051 % Shredders <& HP 4 Stroke 1.631.00 16,449 44
2265004056* Lawn & CGarden Tractors 4 Stroke 1,775.40 E06,269 .23
2265004066* ChippersfStump Grinders 4 Stroke 15102 a6,211.24
226500407 1% Commercial TwlE quipment 4 Stroke 5,179.81 1,218,978.57
2265004076* Other Lawn & Garden Egp. 4 Stroke 3,284 56 4126708
Gasoline Lawrn and Garden Equipment (om) Tofals: A, 34029 277087271

Core Idode] Fer 20005, Iday 2005

page Taof 2
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Fuel Engine Equip ment Fuel
Type SCC Egquipmeni Descrip Hon Type Population Consump tion
(gallons’ Season)

Lawn and Garden Equipment (Res)
2260004015%*  Fotary Tillers< & HP 2 Btroke 1,282 1,421
2260004020% Chain Jaws < & HP 2 Btroke 13,505 13,373
2260004025%* Trimm er Edgers/Brush Cutter 2 Btroke 56458 25,169
ZZa00040Z30* Leafblower sV acuams 2 Btroke 12,091 16,224
2260004035 Snowblowers 2 Btroke ul ul
2265004010% Lawn mowers 4 Stroke 24688 179,454
2265004015%*  Fotary Tillers< & HP 4 Stroke 7.EQ0 16,445
2265004025+ Trimm er /’E dgers/Brush Cutter 4 Stroke 583 o972
2285004030* Leafblower=Wacuuams 4 Btroke 240 1,277
2265004035 Snowblowers 4 Btroke ul ul
2265004040+ Fear Engine RidinghMMowers 4 Stroke 4782 34,542
2265004055% Lawn & Garden Tractors 4 Btroke 32,680 46T, 255
226500407 5%+ Other Lawn & Garden Egp. 4 Btroke 1610 17,003
Gascoline Lawn and Garden Equaipment (Res) Torals: 201, 695 FFRTIR

Gasoline Totals: 246,044 3.544,502

LPG
Lawn and Garden Equipment (Com)
2267004066+ ChipperaStump Grinders LFPG Z4 52,437
LFG Lewn and Garden Eguapment (Dom) Totals: 2L R 4E7

LPG Totals: 4 32,437

Grand Teotal: 24T 763

* Under 25 horsepower spark-ignition engines are lumped irto either 2- or 4 stroke.

Core Idode] Fer 20005, Iday 2005

page 2aqf 2
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APPENDIX D

EXAMPLES OF MODEL
COMPARISON REPORTS

Comparison reports for Travis County, Texas 1998 and 2010 nonroad emissions are printed in
the following order. Note that only the first two pages are printed for the longer reports.

1. Compare Two Model Runs by HP and Source Classification
2. Compare Two Model Runs by Pop and Fuel

3. Compare Two Model Runs by SCC

4. Compare Two Model Runs by Source Classification

5. Compare Two Model Runs by County

6. Compare Two Model Runs by Horsepower

7. Compare Two Model Runs by Equipment Type

8. Compare Two Model Runs by HP and SCC
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Comparison of Exhaust CO Emissions in Tons/Season by Horsepower and Source Classification

Maodel Run 1: Travis 1998
Total for Summer Season, 1958

Lawn and Garden Equipment
Traviz County Summertime

Date of Model Run 1; May 29 16:37:1% 2005

Maodel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equipment
Traviz County Summertime

Date of Madel Run 2; May 29 17:59:48: 2005

Today's Date: 5222005

Horsepower Range Model Run 1 Model Run 2 Run2- Run 1 %9 Difference
LAWN AND GARDEN EQUIPMENT (CORM)

O0<HFP<=1 384 2.45 -1.39 S36.22

1<HP<=3 68547 47875 -206.72 -E0.16

Z<HF<=9§ 3,53329 4,218.28 A24.00 1939

6<HP<=11 1,601.43 2,271.11 S0 6% 3427

11 <HP <=1§ 3.467.00 4,634.63 1,167 62 3368

16 < HP <=25 403178 538483 1,353.10 3356

25 <HP <=40 24234 1) -209 34 -34.29

40 < HP <= 50 167 1.14 053 -31.45

S0 <HP<=73 36.92 52.63 -3415 -39.40

Ti<HP <=100 5.44 663 123 2163

100 <HF <= 173 B 44 56.91 -29.55 5416

175 <HF <= 300 191 1.52 039 -20.64
300 <HF <= 600 209 266 033 -10.94
G00 < HF <= 730 1.10 1.10 0.0l 0.47

750 < HF <= 1000 036 0.23 RNk -11.01

Mode! Reer I Core Model Fer 2005, Mgy 2005

Model Ruer 2 Core Model Fer 2005, Mgy 2005 page laof 2
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Horsepower Range Model Run 1 Model Run 2 Run2-Runl %o Difference
1000 < HP == 1200 029 0.12 017 -38.19

Lawn and Garden Equipment (Com) Totalks: 13848.16 17,152.19 3,304.03 2386
LAWN AND GARDEN EQUIPMENT (RES)

O0<HFP<=1 21.03 720 -1324 -63.77

1<HP<=3 190.54 11594 -74.50 S3015

3<HF<=§ 85515 1,017.72 16257 1901

6<HP=<=11 23521 298.47 6326 26 89

11 <HP <=1§ 1,761.00 2,247.82 436 81 27 64
16 < HP <=23 73512 932.11 M0299 2741

Lawn and Garden Equipment (Res) Totals: 3,798.07 462527 82720 21.78
Grand Totalk: 17,646.23 21,777.46 4,131.23 14l

Mode! Reer I Core Model Fer 2005, Mgy 2005

Model Ruer 2 Core Model Fer 2005, Mgy 2005 page 2aof 2
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Maodel Run 1: Travis 1998
Total for Summer Season, 1958

Lawn and Garden Equipment
Traviz County Summertime

Date of Model Run 1; May 29 16:37:1% 2005

Comparison of Equipment Population and Fuel Consumption by SCC

Maodel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equipment
Traviz County Summertime

Date of Madel Run 2; May 29 17:59:48: 2005
Today's Date: 5222005

Fuel Engine Equip ment Equip ment Fuel Fuel
Type SCC Equipment Description Type Pop ulation Pop ulation Consumption Consump tion
Run 1 Run 2 (gallons/ (gallons/ Season)
Season) Run 1 Run 2
Diesel
Lawn and Garden Equipment (Com)
2270004071 Commercial Tuef Equipment Diesel 46 D6 8130 20,017.69 3465830
2270004066 ChippersfStump Grinders Diesel 32208 55108 171,466.00 202,804 24
2270004046 Fromt Mowers Disgel 1,042 64 120331 1322,305.84 211.301.27
2270004056 Lawn & Garden Tractors Dissgel 6378 456 6% 2523179 43 AT 3
2270004031 Leafblowers/V acimms Diesel 134 390 3391 5771
2270004076  Other Lawn & Garden Eqp. Diesel 71z 1224 1.300.47 122577
2170004036 Snowhlowers Diesel i} 0.oo 0.00 o.on
Dhesel Lewn and Garden Equipment (Com) Tofals: 34035579 SadAI012
Diesel Totals: 035579 584 810.12
Gagoline
Lawn and Garden Equipment (Com)
2260004021 % Chain Saws< § HP 2 Btroke 387639 492088 106,797.81 9491020
2260004071 % Commercial Tuef Equipm ent 2 Btroke 064 127 5312 T1m
2263004071% Commercial Tusf Equipment 4 Stroke 517981 6,587 .52 1,218,972.57 1,335.210.50
Iodel Fam I Cove Model Ver 3000 May 2005 pag Igf 5§
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Fuel Engine Equip ment Equip ment Fuel Fuel
Type SCC Equipment Descripiion Type Pop ulation Pop ulation Consumption Consump tion
Run 1 Run 2 (zallons/ (gallons/ Season)
Season) Run 1 Run 2

2263004066 * ChippersfStump Grinders 4 Btroke 15102 193.10 66,211.24 T1.176.58
2263004046 * Front Mowers 4 Stroke 89542 113877 3398337 3611905
2260004031 * LeafbloweraV acuums 1 Stroke 3769 76 479427 11378789 0% 299 25
22635004031 * LeaftloweraV acuums 4 Btroke 1,847 41 3,349 49 238,802.18 156 665,01
2265004056 * Lawn & Garden Tractors 4 Btroke 1,775.40 2,25790 396,869 23 424125195
2265004011 % Lawn mowers 4 Btroke 8,078 .08 10,273.44 230,940 64 241,535.84
2265004076 * Other Lawn & Garden Eqp. 4 Btroke 389454 485430 41, 267.09 4199111
2260004016 * Rotary Tillers< & HP 2 Btroke 430 68 54772 13,222.59 11,005.31
2265004016 % Rotary Tillers< & HP 4 Btroke 267042 3,407 81 140,620.44 13676012
2265004041 % Rear Engine Riding Mow ers 4 Btroke 25980 33100 2871038 3108442
2260004036 Snowhlowers 2 Btroke i} 0.on 0.00 i}
4263004051 % Shredders< 6 HP 4 Btroke 1,631.00 207426 16,440 46 1520021
2163004036 Snowhlowers 4 Stroke o.0n 0.on 0.00 o.oo
2260004026 % TrimmersEdgersBrosh Cutter 2 Stroke 0693 A% 12,328.13 118,426.20 10264439
2263004026 * TrimmersEdgersBrosh Cutter 4 Stroke 18632 236095 5,683.53 526410
Gesoling Lawn avd Garden Equipment (Com ) Tofals: AFTOET2TI 2,901,079 64
Lawn and Garden Equipment (Res)
2260004020* Chain Saws< 6 HFP 1 Btroke 13,504 65 17.174.31 1337295 1113419
2260004030* LeafblowrersV acuums 1 Btroke 1509115 300779 1622563 13,500 58
2265004055* Lawn & Garden Tractors 4 Btroke 3267981 41.561.21 4467,234.77 487.190.28
2265004030* LeafblowersV acums 4 Btroke 940 44 119603 1.877.01 173255
2265004010% Lawn mowers 4 Btroke 84687 57 10770315 179,453.80 16664311
2265004075% Other Lawn & Garden Eqp. 4 Btroke 1,609 68 204715 1700312 17.233.19
2260004015 Rotary Tillers< & HP 2 Btroke 1,268 .22 141280 1.421.28 1,190 87
2265004040% Rear Engine Riding Mow ers 4 Btroke 478217 6,081 .82 3454184 3631353
2263004015 Rotary Tillers< & HP 4 Btroke TE00.13 10,034.43 16,448 88 1490139

Iodel Fam I Cove Model Ver 3000 May 2005 pag g 5
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Fuel Engine Equip ment Equip ment Fuel Fuel
Type SCC Equipment Descripiion Type Pop ulation Pop ulation Consumption Consump tion
Run 1 Run 2 (zallons/ (gallons/ Season)
Season) Run 1 Run 2
2260004035 Snowhlowers 1 Btroke i} 0.oo 0.00 o.on
2263004035 Snowhlowers 4 Stroke o.0n 0.00 0.00 o.aa
2260004025* TrimmersEdgersBrush Cutter 2 Stroke 35635792 45,348 68 2516934 20,963 .54
22635004025 % TrimmersBEdgersBrush Cutter 4 Stroke 38296 741.40 972.29 906 37
Gesoline Lawn and Garden Equipment (Res) Tofals FR7I8 0 FALF08 61
Gasoline Totals: 3,544.591.72 347278825
LPG
Lawn and Garden Equipment (Com)
2267004066 * ChippersfStump Grinders LFG 3371 42 96 3243736 34 A9 TR
LFG Lawn and Garden Equipment (Com ) Tofals: 32,437 36 34,8948 78
LPG Totals: 3243736 69878
Totak: 3,917 384.87 4,292 297.15
* Under 25 howepower spark-ignition engines ave limped irto either 2- or 4-stoke.
Iodel Fam I Cove Model Ver 3000 May 2005 rag S 5
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Comparison of Exhanst CO2 Emissions in Tons/Season by SCC
Mndel Run 1 : Travis 1998
Total for Summer Season, 1998

Lawn and Garden Equiptnent
Travis County Summertime

Date of Model Run 10 May 29 16:37:1% 2005

Mhadel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equiptnent
Travis County Summertime

Date of Meodel Run 2: May 29 175948 2005

Today's Date: 5/25/2005

8CC Eq uipment Description Engine Type Model Run 1 Model Run 2 Run2-Runl % Difference
LAWN AND GARDEN EQUIPMENT (COM)

2260004016 Rotary Tillers< 6 HP 2 Stroke T163 0520 2264 3116
2260004021 % Chain Saws < 6 HP 2 Stroke 63778 T42.80 10502 16 47
2260004026* TrimmersEdgers’Brush Cutter 2 Stroke 67775 881.15 203.40 3001
2260004031 Leafblowers/V acuums 2 Stroke 66302 822.50 15988 24.11
2260004038 Snowblowers 2 Stroke 0.00 0.00 0.o0o M&
2260004071 Commercial Twf Equipment 2 Btroke 0.30 0.62 032 10537
2265004011 % Lawn mowets 4 Stroke 2,006.26 2,267.69 26142 1303
2265004016 Rotary Tillers< 6 HP 4 Btroke 1,188.18 1,257.30 6032 383
2265004026%* TrimmersE dgersB rush Cutter 4 Btroke 51.58 5559 403 782
2265004031 % Leaftlowers/V acmums 4 Btroke 2,261.53 2,460.32 207 80 919
2263004038 Bnowblowers 4 Stroke 0.00 0.00 0.o0o MA
2265004041 % Rear Engine Riding Mowers 4 Stroke 27232 29269 26.47 072
2265004046 Front Mowets 4 Stroke 32029 346.31 2543 792
2265004051 Shredders< 6 HP 4 Stroke 13358 145.57 700 505
22650040356 * Lawn & Garden Tractots 4 Stroke 375608 4,047 85 20177 TIT
22650040686 * ChippersSump Grinders 4 Stroke 631.04 68210 3T 06 904
2265004071+ Comercial Tusf Euipm et 4 Stroke 11,456 16 12,798.99 1,342 83 1172
2265004076 Cther Lawn & GardenEqp. 4 Stroke 366.08 39241 2633 T19
Model Rum [ Core Model Ver 2005 Mgy 2005

Model Fam I Cove Model Ver 2005 Mep 2005 page 1af 3
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sCC Equipment Description Engine Type Model Run 1 Model Run 2 Run2-Runl %4 Difference
22670040686 * ChippersSump Grinders LPG 21638 23314 16 36 TES
2270004031 Ledftl owers/V acinins Diesel 03s n.a3 027 7114
2270004038 Snowblowers Diesel 0.00 0.00 0.o0o Ma&
2270004048 Front Mowerts Diesel 1,372.99 2,384.78 101177 7369
22700040358 Lawn & Garden Tractors Diesel 28310 452,89 20979 7410
2270004068 ChippersiStump Crinders Diesel 1,931.61 3,307.68 1,376.07 7124
2270004071 Commercial Tusf Equipment Diesel 22511 39174 166 63 7402
2270004078 Cther Lawn & GardenEqp. Diesel 1463 25.14 1051 186
Lawn and Garden Equipment (Com) Totalks: B54445 34,146.76 560231 1963
LAWN AND GARDEN EQUIPMENT (RES)

2260004015% Rotary Tillers< 6 HP 2 Stroke T.36 10.10 234 3015
2260004020 Chain Jaws < 6 HP 2 Stroke 7371 06.44 2273 3034
2260004025% Tritmer E dgeraB msh Cutter 2 Stroke 13732 181.73 44 41 3234
2260004030 * Leaftl owers/V armims 2 Stroke £9.13 117.00 2T AT 3127
2260004035 Bnowhl owers 2 Stroke 0.00 0.00 ono M
2265004010 Lawn mowets 4 Stroke 1,358.97 1,519.63 =3935 -2.52
2265004015* Rotary Tillers< 6 HF 4 Stroke 144.11 135.58 -8.53 -582
2265004025%* TrimmersEdgers’Brush Cutter 4 Stroke 8.54 832 021 -2.48
2265004030 Leaftlowers/V acwmums 4 Stroke 16.44 1590 054 -3.27
2263004035 Bnowblowers 4 Stroke 0.00 0.00 0.o0o M
2265004040 Rear Engine Riding Mowers 4 Stroke 32744 348.99 2154 658
2265004035 Lawn & Garden Tractors 4 Stroke 441980 4,682.29 26248 594
2265004075% Cther Lawn & GardenEqp. 4 Stroke 15079 161.00 1022 677
Lawn and Garden Equipment (Res) Totals: 693401 7276.98 34296 495
Model Rum [ Core Model Ver 2005 Mgy 2005

Model Fam I Cove Model Ver 2005 Mep 2005 page 34 3
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sCC Equipment Description Engine Type Model Run 1 Model Run 2 Run2-Runl %4 Difference
Grand Totaks: 35478.46 4142374 594527 16.76
* Under 25 howepower spark-ignition engines ave limped irto either 2- ar 4-stoke.

Model Run I Cove Model Fer 2003 ey 2005

Model Fam I Cove Model Ver 2005 Mep 2005 page Taf 3
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Maodel Run 1: Travis 1998
Total for Summer Season, 1958

Lawn and Garden Equipment
Traviz County Summertime

Date of Model Run 1; May 29 16:37:1% 2005

Comparison of Exhaust THC Emissions in Tons/Season by Source Classification

Maodel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equipment
Traviz County Summertime

Date of Madel Run 2; May 29 17:59:48: 2005
Today's Date: 5222005

Model Ruer 2 Core Model Fer 2005, Mgy 2005

Source Classification Model Run 1 Model Run 2 Run2-Runl %o Difference
Lawn and Garden Equipsm ext (T oz BEL.45 307.63 -85 82 -54.89
Lawn and Garden Equipmert (Res) 21463 100.41 -11427 -5343
Grand Totak: 1.096.13 498.04 -598.09 -84.56
Mode! Reer I Core Model Fer 2005, Mgy 2005

page laof 1
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Comp arison of Exhanst NOx Emissions in Tons/Season by County

Mndel Run 1: Travis 1998 Mndel Run 2 : Travis 2010
Total for Summer Season, 1998 Total for Summer Season, 2010
Lawn and Garden Equipment Lawn and Garden Equipment
Travizs County Sutnmertitne Travis County Summertime
Date of Model Run 1: May 29 16:37:1%: 2005 Date of Model Run 2: May 29 17:59:48: 2005

Today's Date: 5/29/2005
County Model Run 1 Model Run 2 Run2-Runl 9% Difference
Travis County 14700 14237 -4.63 S35
Grand Totak: 147.00 14237 -4.63 315

Model R | Cove Model Ver 2005 Map 2005
Model Ram I Cove Model Ver 2005 Map 2005 page Tof 1
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Comp arison of Exhanst PM10 Emissions in Tons/Season by Horsepower
Mndel Run 1: Travis 1998 Mndel Run 2 : Travis 2010
Total for Summer Season, 1998 Total for Summer Season, 2010
Lawn and Garden Equipment Lawn and Garden Equipment
Travizs County Sutnmertitne Travis County Summertime
Date of Model Run 1: May 29 16:37:1%: 2005 Date of Model Run 2: May 29 17:59:48: 2005

Today's Date: 5/29/2005
Horsepower Model Run 1 Model Run 2 Run2-Runl 9% Difference
0<HP=<=1 0.30 0.38 00g 2816
1<HP=<=3 1307 1382 053 418
3<HP=<=8a 1377 15.06 1.30 043
G<HP<=11 038 0.39 001 347
11 <HF <=14 105 1.12 007 6.45
16 < HP <=15 240 213 018 ST 36
25 <HP ==40 023 0.7 -0.04 -6.06
40 < HF == 350 030 027 -0.04 -12.34
50<HP=<=75 043 0.7 003 1242
T5<HP=<=100 124 1.42 013 14.14
100 <HP <= 175 045 0.45 0.00 04
175 <HP == 300 041 0.37 -0.04 -10.82
300 < HF == 600 0.59 0.5% -0.06 -10.65
600 <HF <= 730 02z 0.20 -0.032 332
T30 <HP <= 1000 ons 0.05 0.00 -7.28
1000 < HP <= 1200 o0a 0.0z -0.03 -46.80
Model Ram ] Cove Model Ver 2005 Mo 2005
Model Ram I Ceve Model Ver 2005 Map 2005 page 132
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Horsepower Model Run 1 Model Run 2 Run2-Runl %% Difference

Grand Totak: 3575 3759 1.83 513

Model R | Cove Model Ver 2005 Map 2005
Model Ram I Cove Model Ver 2005 Map 2005 page 2of 2
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Mnudel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equipment
Travis County Summertime

Comparison of Exhanst SO2 Fmissions in Tons/Season by Equipment Type
Mndel Run 1: Travis 1998
Total for Summer Season, 1998

Lawn and Garden Equipment
Travizs County Sutnmertitne

Date of Model Run 1: May 29 16:37:1%: 2005

Date of Model Run 2: May 29 17:59:48: 2005

Today's Date: 5/29/2005

Source Equipment

Chssification Descrip tion Model Run 1 Model Run 2 Run2-Runl 9% Difference

LAWN AND GARDEN EQUIPMENT (COM)
Lawnmowers 041 0.31 -0.10 -24.13
Rotary Tillers < § HP 024 0.28 0.0z 71
Other Lawn & Garden Egp. 011 0.1z 003 2555
Bhredders < 6 HP 00z 0.0z 0.00 534
LeafbloweraV amiums 0.a0 068 0.0s 13208
Trimmers/E dgersBrush Cutter 015 0.04 -011 -73.49
Trimmers/E dger sBrush Cutter 015 0.19 0os 3082
Chain 3aws< 6§ HP 013 0.0z 011 -24.63
Lawn& G arden Tractors 135 0.97 -038 -2B.24
Rear Engine Riding Mo ers 006 0.06 001 QI7
Lawfitn owrer s 041 0.47 0.06 1333
Snowblowers 0.00 0.00 0.00 MNa
Leafblowers'V acuums 040 0.03 -0.57 -95.45
Lawn& CGarden Tractors 135 1.83 0.49 3598
Other Lawn & Garden Egp. 011 0.03 -0.07 -68.35
Froot Mowers 234 489 2035 7218
Fear Engine Riding Mowers 00s 0.07 0.0z 2826

Model Ram ] Cove Model Ver 2005 Mo 2005

Iiode] Ram 7 Cove Model Vev T00 Map 2005 poge Iafd
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Source Equipment

Chssification Descrip tion Model Run 1 Model Run 2 Run2-Runl %% Difference
Rotary Tillers < 6 HP 026 0.03 -0323 -88.41
Commercial Tuf Equipm et 282 344 062 2124
Chippersftump Grinders 404 6.84 280 6912
Snowhlow ers i} 0.00 0.00 A
Chain 3aws< 6 HP 013 015 0.0z 1790

LAWN AND GARDEN EQUIPMENT (RES)
Lawn& G arden Tractors 091 1.83 09z 10024
LeafbloweraV amims 0.0z 0.68 0.66 308621
Other Lawn & Garden Egp. 00z 0.13 0.10 32431
Lawsm owers 03z 0.47 0.1s 45284
Rear Engine Riding Mo ers ooy 0.06 -001 -BT74
Rotary Tillers < 6 HP 003 038 033 79306
Chain 3aws< 6 HP ont 015 014 92451
TrimmersEdger sBrush Cutter 0os 0.1% 0.1é 55493
Chain 3aws< 6 HF ont 0.0z 0.00 3353
Lawn& CGarden Tractors 091 097 nns 599
Lawnmowers 032 0.31 -0.01 -2.34
LeafblowersV acuums 00z 0.03 0ot 2811
Other Lawn & Garden Egp. 00z 0.0z 0.00 606
Rear Engine Riding Mowers ooz 0.07 0.00 663
Rotary Tillers < 6 HP 00z 0.0z 0.00 =387
Snowblow ers ooo 0.00 o0.oo NA
Trimmers/E dger sBrush Cutter 003 0.04 001 3291
Snowblow ers 000 0.00 0.00 NA

Grand Totak: 18.71 2580 T.09 3789

Model Ram ] Cove Model Ver 2005 Mo 2005

Iodel Run 2 Cove Model Ver 2005 Map 2005 page Tof 2
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Mnrdel Run 1: Travis 1998
Total for Summer Season, 1998

Lawn and Garden Equipment
Travizs County Sutnmertitne

Date of Model Run 1: May 29 16:37:1%: 2005

Comparison of Crankcase TOG Emissions in Tons/Season by HP and 8CC
Mndel Run 2 : Travis 2010
Total for Summer Season, 2010

Lawn and Garden Equipment
Travis County Summertime

Date of Model Run 2: May 29 17:59:48: 2005

Today's Date: 5/29/2005

Source Classification Horsepower Model Run 1 Model Run 2 Run2-Runl 9% Difference
LAWN AND GARDEN EQUIPMENT (CORM)
Chain Saws< 6 HP
1<HP=<=3 0.00000 0.00000 0.00000 -95.23010
3<HP<=6 0.00000 0.00000 0.00000 -95.23010
Chippers/Stump Grinders
3<HF<=8 0.00000 0.00000 0.00000 -93.23010
f<HFP=<=11 0.0004% 0.00000 -0.00049 -95.23010
11 <HP=<=16 000319 0.00000 -0.00319 -95.23010
16 <HP <= 25 016393 0.00003 -0.163590 -95.23010
25 < HP <= 40 007865 0.00105 -0.07760 -95.23010
40 < HF <= 50 000133 0.000&0 -0.00074 -95.23010
S0 < HP<=75 058145 0.17307 -0.40839 -05.23010
75 <HF<=100 002280 0.02320 0.00049 -05.23010
100 <HP <= 175 027559 0.02606 -0.18053 -95.23010
175 <HP <= 300 0.00963 0.00254 -0.00108 -95.23010
300 <HP == 600 001446 0.01187 -000259 -95.23010
600 <HP =750 000524 0.00421 -0.00102 -95.23010
730 < HF == 1000 00031 0.00133 -0.00008 -85.23010
IModel Rem ] Cove Mods] Ver 2005 Map 2005
Iodel Run 2 Cove Model Ver 2005 Map 2005 page Tof 7
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Source Classification Horsepower Model Run 1 Model Run 2 Run2-Runl %% Difference
1000 < HP <= 1200 000143 0.00082 -0 00061 -95.23010
Commercial Turf Eq uipment
1<HP==3 0.00000 0.00000 0.00000 -95.23010
3<HP<=6 128057 0.00000 -1.28057 -95.23010
G <HP<=11 016771 0.00000 -0.16771 -95.23010
11<HP<=1é 059746 0.00012 -0.59733 -95.23010
16 < HP <= 25 107611 0.00025 -1 07587 -95.23010
25 < HP <= 40 240910 0.01486 -2.30435 -95.23010
40 < HP <= 50 0.00205 0.00030 -0.001735 -05.23010
S0« HP <=73 004485 0.01133 -0.03362 -05.23010
T5<HP <= 100 0 00208 0.00149 -0.00059 -95.23010
100 <HP <= 173 000157 0.00133 -0.00035 -935.23010
Froni Mowers
3<HP<=6 0.00002 0.00001 0.00000 -95.23010
G <HP<=11 0.02261 0.00002 -0.02259 -95.23010
11 <HP<=1é 013167 0.00111 -0.13056 -05.23010
16 <HP <= 23 011623 0.03285 -0.08338 -05.23010
25 < HP <= 40 0.03001 0.01490 -0.01502 -95.23010
40 < HP <= 50 000214 0.00350 -0.00464 -95.23010
S0 < HP <=75 000952 0.00912 -0.00040 -95.23010
75 <HF<=100 0.00305 0.00308 0.00002 -95.23010
Lawn & Garden Tractors
3<HP<=6 0.00000 0.00000 0.00000 -95.23010
G <HP<=11 005317 0.00002 -0.05315 -95.23010
11 <HP<=16 082599 0.00023 -0.83576 -95.23010
16 <HP <= 23 037981 0.00793 -0.37188 -05.23010
25 < HP <= 40 000038 0.00013 -0.00025 -05.23010
Model Fam ] Cove Model Ver 2005 Moy 2005
Iodel Run 2 Cove Model Ver 2005 Map 2005 page Tof 7
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APPENDIX E

EXAMPLES OF EMISSION
FACTOR REPORTS

Reports for Travis County, Texas 1998 emission factors are printed in the following order. Note
that only the first two pages are printed for the longer reports.

1.

2.

3.

Grams per Operating Hour by SCC

Grams per Operating Hour by HP and SCC
Grams per Day by SCC

Grams per Day by HP and SCC

Grams per HP-Hour by SCC

Grams per HP-Hour by HP and SCC

EPA NONROAD Emissions Model User's Guide
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Emission Factors by SCC and Pollutant

All Fuels Grams/Operating Hour Travis County .
Lawn and Garden Equipment .
Travis County Summertine (Travis 1998)
Total for Summer Season, 1998
Date of Model Run: May 29 16:37:1%: 2005 Today's Date: 5/25/2005 |
Fuel Engine Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase Diurnal
Type SCC Equip ment Descrip tion Type THC NOx co PMI10 502 co2 THC THC
Diesel
Lawn and Garden Equip ment (Com)
2270004031 L eafbl owver oW acunam e Diegel 107 4752 3213 57 731 361688 1] om
2270004036 Snowhblowers Diesel HA N4 Ha Ha N4 Ha Ha Hia
2270004046 Front Mowers Diesel 202 9.5 6511 1504 1483 733121 0.40 0.m
2270004036 Lawn & Garden Traciors Diesel 1540 8.3 4884 1001 10.68 527423 03l 0.m
2270004066  ClippersiStump Grinders Diesel 5702 43118 24038 511% es] 3447230 1.14 0.00
2270004071  Commercial Twef Equipment  Diesel 2641 1553 2964 1815 .2 11,9592.84 0.53 0.00
2270004076  Other Lawn & Garden Eqp. Diesel 2744 1.z 99289 2080 2565 1268589 0.55 0.00
Gasoline
Lawn and Garden Equip ment (Com)
2260004016* RotaryTillers< 6 HP 2 Btroke 3= 0.8 B235 221 019 95544 0m 0.06
2160004021% Chain Saws < & HP 2 Stroke 400722 405 108742 2405 0.0 159042 om 0.0s
2260004026% TrimmersEdgersBrush Cutter 2 Stroke 30815 106 15289 127 028 136433 o0m 0.14
2260004031%  Leafhlower oV acuiims 2 Stroke 36012 2m SBET 1652 03 166734 000 024
2260004036  Snowhblowers 2 Stroke HA N4 Ha Ha N4 Ha Ha Hia
2260004071*% Commercial Tuf Equipment 2 Stroke 42445 10 100123 1658 037 152027 000 0.3
2265004011* Lawnmowers 4 Stroke [0 4.14 97014 083 0.3 1,63537 088 0.10
2265004016* RotaryTillers< 6 HP 4 Stroke 1310 4.6l L3011 185 0.2 251168 401 0.08
Core Model Fer 2005, May 2005 pag lof §
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Emission Factors by SCC and Pollutant

All Fuels Grams/Qperating Hour Travis County

Lawn and Garden Equipment

Travis Ceunty Summertime (Travis 1995)

Total for Summer Season, 1998

Date of Model Run: Way 29 16:37:1%: 2005 Today's Date: 5/25/2005

Fuel Engine Vapor Spillage Hot Soak Running Tank Hose Total
Type SCC Equip ment Description Type Displacement THC THC Loss Permeation Permeation THC
THC THC THC THC

Diesel
Lawn and Garden Eq uipment (Com)
2270004031 Leafblowers WV acunins Diegel 000 0.00 om ooo om ono 1101
2270004036 Snowhlowers Diesel Ha N4 Ha Ha Ha Ha Hi
2470004046 Frort Mowers Diesel nog 0.m 0o ooo 0.0 ooa 2063
2470004056  Lawnd& Garden Tractors Diesel nog 0.m 0o ooo 0.00 ooa 1571
23270004066  ChippersiStump Crinders Diesel 0.00 0.00 000 000 0.00 ono 58.17
2270004071 Commercial Tuf Equipment  Diesel 0.00 0.00 000 000 0.o0 ono 26.94
2270004078 Other Lawn & Garden Egp. Diesel 0.00 0.00 000 000 0.o0 ono 2799

Gasoline
Lawn and Garden Equipment (Com)
2260004016* Rotary Tillers < 6 HP 2 Btroke 0735 1028 om ooo om ono 248.63
2260004021* Chain Saws< 6 HP 2 Btroke 141 4530 om ooo oo ono 44598
2260004026 * TrimmersEdger sBrush Cutter 2 Stroke 102 235 om [afula] 0.oo ono 3167
2260004031%*  LeafhlowersV acunim s 2 Btroke 123 .66 om oo 0.00 ono 363.25
2260004036 Snowhlowers 2 Btroke Ha N4 Ha Ha Ha Ha Hi
2260004071*  Commercial Tuf Equipment 2 Stroke 133 243 om oo 0.00 ono 428,62
2265004011* Lawnmowers 4 Btroke nsl .82 000 000 0.0 ooa 795
2265004016* Rotary Tillers < 6 HP 4 Stroke 127 18.57 000 000 0.0 ooo 15491

Core Model Ver 2005, May 2005 page 2af &
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Emission Factors by Horsepower, SCC, and Pollutant

All Fuels Grams/Operating Hour Travis County .
Lawn and Garden Equipment .
Travis County Summertime (Travis 1998) '
Total for Summer Season, 1998 '
Drate of Model Run: Iay 29 16:37:1%: 2005 Today's Date: 5/25/2005
Fuel Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase Diurnal ’
Type SCC Equip ment Descrip tion Engine Type  THC NOx Co PRILO 802 co2 THC THC
Horsepower
Diesel
Lawn and Garden Equip ment (Com)
2270004021  Leafblower sV acuuims Diesel
3<HP=<=¢ JER 2449 1288 283 289 142583 oo? 0.m
25 <HP=<=40 2158 .30 8254 1052 1425 T03B25 044 0.m
40 < HP <= 50 HA Hi Ha i Ha Ha Hi Ha
S0<HP«<=75 Ha N4 Hi 4 Ha Ha Ha Ha
75 < HP <= 100 Ha N4 Ha Ha N4 Ha Ha Ha
100 < HP <= 175 Ha N4 Ha Ha J2F Ha Ha Ha
2270004036 Bnowblowers Diesel
100 < HP <= 175 Ha N4 Hi 4 Ha Ha Ha Ha
175 < HP <= 300 Ha N4 Ha Ha N4 Ha Ha Ha
300 < HF <= a00 Ha N4 Ha Ha J2F Ha Ha Ha
2270004046 Front Mowers Diegel
Z<HP<=§ 330 2.7 1717 287 2.55 125877 ooz 0.0
a<HP<=11 Ha N4 Ha Ha N4 Ha Ha Ha
Core Model Fer 2005, May 2005 page lof 14
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Emission Factors by Horsepower, SCC, and Pollutant

All Fuels Grams/Qperating Hour Travis County
Lawn and Garden Equipment

Travis County Summertime (Travis 1958)

Total for Summer Season, 1998

Date of Model Run: Way 29 16:37:1%: 2005 Today's Date: 5/25/2005

Fuel Vapor Spillage Hot Soak Running Tank Hose Total
Type SCC Equip ment Description Engine Type Displacement THC THC Loss Permeation Permeation THC
THC THC THC THC
Horsepower
Diesel
Lawn and Garden Eq uipment (Com)
2270004031 LeafblowersV acunins Diesel
3<HFP=<=8 000 0.om 000 000 0.0 ooo am
25 < HFP <= 40 uius] 0. 000 000 0.0 ooo 223
40 < HFP <= 50 Ha Ha i Ha Ha Ha Ha
S0<HP«=75 Hi Ha 4 Hi N4 Ha Hi
75<HP «<=100 Ha N4 Ha Ha N4 Ha Hi
100 <HP <= 175 Ha J2F Ha Ha N4 Ha Hi
2470004036 Bnowhlowers Diesel
100 <HP <= 175 Hi Ha 4 Hi N4 Ha Hi
175 <HP <= 300 Ha N4 Ha Ha N4 Ha Hi
300 <HP <= a00 Ha J2F Ha Ha N4 Ha Hi
2270004046 Fromt Mowers Diegel
Z<HFP<=4§ o.oo 0.0 om ono om aoo 337
a<HP<=11 Ha N4 Ha Ha N4 Ha Hi
Core Model Ver 2005, May 2005 page 2of 18
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Emission Factors by SCC and Pollutant

All Fuels Grams/Day Travis County
Lawn and Garden Equipment
Travis County Summertine (Travis 1998)
Total for Summer Season, 1998
Date of Model Run: May 29 16:37:1%: 2005 Today's Date: 5/25/2005
Fuel Engine Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase Diurnal
Type SCC Equip ment Descrip tion Type THC NOx co PMI10 502 co2 THC THC
Diesel
Lawn and Garden Equip ment (Com)
2270004031 L eafbl owver oW acunam e Diegel 4778 21.m 1422 253 324 1,60089 010 om
2270004036 Snowhblowers Diesel HA N4 Ha Ha N4 Ha Ha Hi
2270004046  Fromt Mowers Diesel 3584 17087 11527 2530 w8 1298498 072 0.m
2270004036 Lawn & Garden Traciors Diesel 3050 15326 800 2008 21.40 1058289 0.2 0.m
2270004066  ClippersiStump Grinders Diesel 781 farage-d 41228 e 118.3 513679 1.96 0.00
2270004071  Commercial Twef Equipment  Diesel 10404 611.85 35312 7151 955 47,2081 208 0.00
2270004076  Other Lawn & Garden Eqp. Diesel 4383 s 15253 xdes] 4097 2026073 0.8 0.00
Gasoline
Lawn and Garden Equip ment (Com)
2260004016* RotaryTillers< 6 HP 2 Btroke 41253 112 104274 148 0.3 1EE339 om 0.1l
2160004021% Chain Saws < & HP 2 Stroke 32953 333 89535 1281 033 162238 om 0.4
2260004026% TrimmersEdgersBrush Cutter 2 Stroke 15572 053 38045 642 014 BEZ A5 o0m 0.07
2260004031%  Leafhlower oV acuiims 2 Stroke 314.57 210 6408 1760 035 173428 000 025
2260004036  Snowhblowers 2 Stroke HA N4 Ha Ha N4 Ha Ha Hi
2260004071*% Commercial Tuf Equipment 2 Stroke 105771 273 231878 4171 0% 460411 000 051
2265004011% Lawnmowers 4 3troke 10300 5.19 1452580 04 0.5 244200 13 0.15
2265004016* RotaryTillers< 6 HP 4 Stroke Ze 20 227038 321 050 4372682 658 0.11
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December 2005

Emission Factors by SCC and Pollutant

All Fuels Grams/Day Travis County

Lawn and Garden Equipment

Travis Ceunty Summertime (Travis 1995)

Total for Summer Season, 1998

Date of IModel Run: May 29 16:37:1%: 2005 Today's Date: 5/25/2005

Fuel Engine Vapor Spillage Hot Soak Running Tank Hose Total
Type SCC Equip ment Description Type Displacement THC THC Loss Permeation Permeation THC
THC THC THC THC

Diesel
Lawn and Garden Eq uipment (Com)
2270004031 Leafblowers WV acunins Diegel 000 0.00 om ooo oo ono 487
2270004036 Snowhlowers Diesel Ha N4 Ha Ha Ha Ha Hi
2470004046 Frort Mowers Diesel nog 0.m 0o 000 0.0 ooa 36.53
2470004056  Lawnd& Garden Tractors Diesel nog 0.m 0o 000 0.0 ooa 3152
23270004066  ChippersiStump Crinders Diesel 0.00 0.00 000 000 0.o0 ono 99.76
2270004071 Commercial Tuf Equipment  Diesel 0.00 0.00 000 000 0.00 ono 106.12
2270004078 Other Lawn & Garden Egp. Diesel 0.00 0.00 000 000 0.00 ono 4471

Gasoline
Lawn and Garden Equipment (Com)
2260004016* Rotary Tillers < 6 HP 2 Btroke 130 1221 om ooo om ono 43285
2260004021* Chain Saws< 6 HP 2 Btroke 118 3130 om ooo om ono 368113
2260004026 * TrimmersEdger sBrush Cutter 2 Stroke 052 .= om [afula] om ono 167.60
2260004031%*  LeafhlowersV acunim s 2 Stroke 128 797 om oo 0.00 ono 8407
2260004036 Snowhlowers 2 Stroke Ha N4 Ha Ha Ha Ha Hi
2260004071*  Commercial Tuf Equipment 2 Stroke 5439 &.10 om oo om ono 107321
2265004011* Lawnmowers 4 Btroke 121 13.21 000 000 0.0 ooa 11889
2265004016* Rotary Tillers < 6 HP 4 Btroke 222 ek <] 0o Jukul] 0. 000 2210
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December 2005

All Fuels

Emission Factors by Horsepower, SCC, and Pollutant

Grams/Day Travis County
Lawn and Garden Equipment
Travis County Summertime (Travis 1998)
Total for Summer Season, 1998
Drate of Model Run: Iay 29 16:37:1%: 2005 Today's Date: 5/25/2005
Fuel Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase Diurnal
Type SCC Equip ment Descrip tion Engine Type  THC NOx Co PRILO 802 co2 THC THC
Horsepower
Diesel
Lawn and Garden Equip ment (Com)
2270004021  Leafblower sV acuuims Diesel
3<HP=<=¢ 183 10.84 580 11% 1.2 831 54 003 0.m
25 <HP=<=40 FER 3556 788 488 .30 311525 1% 0.m
40 < HP <= 50 HA Hi Ha i Ha Ha Hi Ha
S0<HP«<=75 Ha N4 Hi 4 Ha Ha Ha Ha
75 < HP <= 100 Ha N4 Ha Ha N4 Ha Ha Ha
100 < HP <= 175 Ha N4 Ha Ha J2F Ha Ha Ha
2270004036 Bnowblowers Diesel
100 < HP <= 175 Ha N4 Hi 4 Ha Ha Ha Ha
175 < HP <= 300 Ha N4 Ha Ha N4 Ha Ha Ha
300 < HF <= a00 Ha N4 Ha Ha J2F Ha Ha Ha
2270004046 Front Mowers Diegel
Z<HP<=§ 585 3|53 273 475 4.51 22261 o1z 0.0
a<HP<=11 Ha N4 Ha Ha N4 Ha Ha Ha
Core Model Fer 2005, May 2005 page lof 14
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December 2005

Emission Factors by Horsepower, SCC, and Pollutant

All Fuels Grams/Day Travis County
Lawn and Garden Equipment

Travis County Summertime (Travis 1958)

Total for Summer Season, 1998

Date of Model Run: Way 29 16:37:1%: 2005 Today's Date: 5/25/2005

Fuel Vapor Spillage Hot Soak Running Tank Hose Total
Type SCC Equip ment Description Engine Type Displacement THC THC Loss Permeation Permeation THC
THC THC THC THC
Horsepower
Diesel
Lawn and Garden Eq uipment (Com)
2270004031 LeafblowersV acunins Diesel
3<HFP=<=8 000 0.om 000 000 0.0 ooo 187
25 < HFP <= 40 uius] 0. 000 000 0.0 ooo 288
40 < HFP <= 50 Ha Ha i Ha Ha Ha Ha
S0<HP«=75 Hi Ha 4 Hi N4 Ha Hi
75<HP «<=100 Ha N4 Ha Ha N4 Ha Hi
100 <HP <= 175 Ha J2F Ha Ha N4 Ha Hi
2470004036 Bnowhlowers Diesel
100 <HP <= 175 Hi Ha 4 Hi N4 Ha Hi
175 <HP <= 300 Ha N4 Ha Ha N4 Ha Hi
300 <HP <= a00 Ha J2F Ha Ha N4 Ha Hi
2270004046 Fromt Mowers Diegel
Z<HFP<=4§ o.oo 0.0 om ono om aoo 55
a<HP<=11 Ha N4 Ha Ha N4 Ha Hi
Core Model Ver 2005, May 2005 page 2of 18
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December 2005

Emission Factors by SCC and Pollutant
All Fuels

Lawn and Garden Equipment

Travis County Summertime (Travis 1998)
Total for Summer Season, 1998

Drate of Model Run: Iay 29 16:37:1%: 2005

Grams/HP-Hour

Travis County

Today's Date: 5/25/2005

Fuel Engine Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase
Type SCC Equip ment Descrip tion Type THC NOx co PMI0 802 co2 THC
Diesel
Lawn and Garden Equip ment (Com)
2270004021 Leafblower sV acuuims Diegel 175 TBE 519 053 118 58480 0.0
2270004036 Snowhblowers Diesel Ha Ha Ha Ha Ha Ha Hi
2270004046 Front Mowers Diesel 162 770 520 104 118 58522 0.m
2270004036 Lawn & Garden Traciors Diesel 171 847 542 11 118 53482 0.m
2270004066  ClippersiStump Grinders Diesel 081 ) 382 03l 111 54857 0.0z
2270004071  Commercial Twef Equipment  Diesel 125 737 4.25 08 115 56943 0.03
2270004076  Other Lawn & Garden Eqp. Diesel 123 76l 4.47 053 115 56728 0.02
Gasoline
Lawn and Garden Equip ment (Com)
2260004016* RotaryTillers< 6 HP 2 Stroke 25523 073 54854 .84 nz1 1022911 0m
2260004021 % Chain Saws < & HP 1 Stroke 16260 164 4179 77 nls 80052 0m
2260004026% TrimmersEdgersBrush Cutter 2 Stroke 22191 076 217 916 020 98250 0.00
2260004031%  Leafhlower oV acuiims 2 Stroke 15580 110 i ] 21 018 20703 0.00
2260004036  Snowhblowers 2 Stroke Ha Ha Ha Ha Ha Ha Hi
2260004071*% Commercial Tuf Equipment 2 Stroke 23580 0D i) 21 0zl 101682 0.00
2265004011* Lawnmowers 4 Stroke 5121 308 il 047 025 121757 0.65
2265004016* RotaryTillers< 6 HP 4 Stroke &R0 245 2= X 052 027 133258 213
Core Model Fer 2005, May 2005 pag lof 3
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December 2005

Fuel Engine Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase

Type SCC Equip ment Descrip tion Type THC NOx co PMI10 802 co2 THC
2265004026* TrimmerEdgersBrush Cutter 4 Stroke jecir) 338 7258 0zl 028 125759 0.71
2265004031 #*  Leafblower sV acuums 4 Stroke 1408 431 55568 013 023 113521 0.71
2265004036 Bnowblowers 4 Stroke Ha HA Ha Hi Ha Hi Hi
2265004041 * Reat Engine RidingMowers 4 Stroke 1473 352 ne.z2 014 025 121585 0.3
2265004046* Front Mowers 4 Stroke 1898 2685 N0 015 028 126780 09
22635004051% Shredders <6 HP 4 Stroke 28 237 91,55 104 02s 134880 230
2265004056% Lawn & Garden Tractors 4 Stroke 1556 357 4.7 014 025 123384 03
22635004086% ChippersiStump Grinders 4 Stroke 1041 a09 45133 01z 021 102804 1.25
2263004071% Commercial Tuf Equipment 4 Stroke 1715 403 851,50 017 024 1,148 83 0.5
2263004076% Other Lawn & Garden Eqp 4 Stroke 4567 241 E56.54 082 027 131837 172
Lawn and Garden Equip ment (Res)
2260004015* RotaryTillers< 6 HP 1 Btroke 26083 077 67522 273 0zl 103607 0.0
2260004020% Chain 3aws < 6 HP 2 Stroke 253597 072 5.3 888 021 103158 0.m
2260004025* TrimmersEdgersBrush Cutter 2 Stroke 25350 076 654.59 .80 021 101954 0.00
2260004030%*  Leafblower 'V acuums 2 Stroke 25502 073 7.5 .05 021 102211 0.0
2260004035 Bnowblowers 2 Stroke Ha HA Ha Hi Ha Hi Hi
2265004010% Lawnmowers 4 Stroke ELES 241 ] 0.42 030 148551 288
2265004015*% RotaryTillers< 6 HP 4 Stroke 50 248 388 0l& 031 15591 3.19
2265004025%  TrimmerEdgersBrush Cutter 4 Stroke 5545 282 E.82 0ls 030 144847 2.61
2265004030%  Leafblower &V acnams 4 Stroke 5133 283 Te.4l 019 030 148192 27
2265004035 Bnowblowers 4 Stroke w4 Ha Ha Ha Hi Hi N
22635004040*% Rea Engine RidngMowers 4 Stroke 1517 292 74.53 01z 028 125559 0.74
22635004055% Lawn & Garden Tractors 4 Stroke 1816 288 718,796 0l1z 026 126377 0.7
2263004075%  Other Lawn & Garden Eqp 4 Stroke 4352 238 ooy i) 027 152141 172

LPG
Lawn and Garden Equip ment (Com)
2267004086% ClippersiStump Grinders LPG 252 1220 42 .44 00 0ol 58138 0.83
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December 2005

Fuel Engine Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase
Type SCC Equip ment Descrip tion Type THC NOx co PMI10 802 co2 THC

* Under 25 horsepower spatk-ignition engines are lumped into either 2. or 4-stroke.
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December 2005

All Fuels

Lawn and Garden Equipment
Travis County Summertime (Travis 1998)
Total for Summer Season, 1998

Drate of Model Run: Iay 29 16:37:1%: 2005

Emission Factors by Horsepower, SCC, and Pollutant
Grams/HP-Hour

Travis County

Today's Date: 5/25/2005

Fuel Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankcase
Type SCC Equip ment Descrip tion Engine Type THC NOx co PMI0 802 co2 THC
Horsepower
Diesel
Lawn and Garden Equip ment (Com)
2270004021  Leafblower sV acuuims Diesel
3<HP=<=¢ 151 10,05 518 110 118 585.53 003
25 <HP=<=40 182 893 518 0.8 118 53457 0
40 < HP <= 50 Ha Ha Ha Ha Hi Hi Ha
S0<HP«<=75 Ha Hi Hi H4 N4 N4 H4
75 < HP «<=100 Ha Ha Hi N4 N4 N4 N4
100 < HP <= 175 Ha Ha Hi N4 N4 N4 H4
2270004036 Bnowblowers Diesel
100 < HP <= 175 Ha Hi Hi H4 N4 N4 H4
175 < HP <= 300 Ha Ha Hi N4 N4 N4 N4
300 < HF <= a00 Ha Ha Hi N4 N4 N4 H4
2270004046 Front Mowers Diegel
Z<HP<=§ 154 1012 547 124 118 3547 005
a<HP<=11 Ha Ha Hi N4 N4 N4 N4
Core Model Fer 2005, May 2005 pag lof 9
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December 2005

Fuel Exhaust Exhaust Exhaust Exhaust Exhaust Exhaust Crankease

Type SCC Equip meni Descrip tion Engine Type THC NOx co PMID 502 co2 THC

Horsepower
11 <HFP=<=1d 174 2.80 547 112 118 53482 003
16 < HP <= 325 174 .80 547 112 118 58482 003
215<HP<=40 134 .98 547 0.4 118 534 .49 0
40 < HP <= 50 134 &6.598 547 0.4 118 534 4% 0
S0<HP«<=75 105 7.8 4.30 0.4 118 700 0oz
75 < HF <= 100 105 T3 430 058 11% 37.00 0.0z
2270004056  Lawn & Garden Tractors Diesel
f<HP<=11 154 10,13 548 125 118 58546 003
11 «HP <= 16 174 .61 548 112 118 53481 003
16 < HP<=35 174 .46l 548 112 118 554 51 005
15<HP<=40 134 659 548 1m 118 554 48 0.04
40 < HP <= 50 124 6.99 548 1.m 11z 58449 00
75 < HF <= 100 104 7.2 4.8 ik=r) 119 =704 0oz
2270004066  ClippersiStump Grinders Diesel

la<HP<=135 174 B0 547 112 118 584 82 0.0
15 <HP<=40 124 6.98 547 0s9 11z 58449 00
40 < HF <= 50 134 598 547 0% 112 53449 0
50<HP==T75 108 7.8 431 0% 119 .00 0oz
75 < HF <= 100 108 7.8 431 0% 119 .00 0oz
100 < HP == 175 024 784 361 0.7% 107 528.35 0oz
175 < HP <= 300 oaz2 7.5 348 0.74 107 52844 0oz
300 < HP <= 600 0a0 782 3.8 0.0 107 528.50 0oz
600 < HP <= 750 072 7.8 3.5 0.0 107 S528.50 0oz
750 < HP <=1000 0g2 8.8 381 0.74 107 5819 0oz
1000 < HP <= 1200 0s% 8.8 381 0.74 107 5819 0oz
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